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Preface 

The TekTMS Product TekTMS (of which the lnteractive Procedure Generator is a part) is a family of 

Family applications for Windows 3.1. The separate modules of TekTMS (such as the 
lnteractive Procedure Generator) are useful tools on their own, but when 
combined, they further enhance your total productivity. 

About this Manual This manual provides information on the installation and use of the Tektronix 
lnteractive Procedure Generator (IPG), Version 2.5. It contains the following 
sections and appendices: 

8 Section 1, General Information - explains what IPG is, what the IPG 
package includes, what additional hardware and software are necessary 
to run IPG, and the skills needed for its use. 

8 Section 2, Getting Started - explains the initialization of IPG, and pro- 
vides an overview of the Windows displays. 

8 Section 3, Creating and Editing Test Procedures - provides step-by-step 
instructions for creating and editing test procedures. 

8 Section 4, Menus - contains a complete listing and description of all 
menus, dialog boxes, edit control boxes, controls, etc.. 

8 Section 5, Advanced Applications - provides additional information and 
application tutorials about features of IPG. 

8 Appendix A, Editing Menu Items - provides a reference list of all Edit 
menu items, and a description of their actions. 

8 Appendix B, DEMOTESTPRG Program - lists the IPG test procedure 
contained on the program disks. 

8 Appendix C, Software Performance Report - provides a form for submit- 
ting problems encountered when using IPG. 
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Typographic 
Conventions 

The following paragraphs describe the typographic conventions used in this 
manual: 

CAPITAL LETTERS - Capital letters denote names of files (e.g., 
TEKTMS.EXE), environmental variables (e.g., SET), programs (e.g., LINK), 
macros (e.g., MAX)), and names of keyboard keys and key sequences 
(such as RETURN and CTRL+C). As programs are case insensitive, these 
names do not need to be capitalized when used in programs or as worksta- 
tion entries. 

CTRL+C denotes a key sequence where you hold down the first key 
(CTRL), then press the second key (C), then release both keys. 

CTRL, C denotes a sequence where you press and release the first key 
(CTRL), then press and release the second key (C). 

Bold Typeface - denotes on-screen items including keywords and menu 
commands. 

Italic Typeface - denotes place holders in syntax descriptions. You will 
need to replace these place holders with specific terms or values by the 
user. For example, in the statement 

GoTo name, 

name must be replaced with a specific user supplied label name. Occasion- 
ally, an italic typeface emphasizes a word or phrase. 

Monospace Typeface - denotes text in program listings, such as in the 
following listing: 

For i=start To end Steps p Log 

Entering Data from the Keyboard 

When using the DOS operating system, examples of communication be- 
tween the user and the computer appear in this manner: 

C : \ > >  testprog 
Enter text file name: a:\directory\test.txt 

In this example, normal text denotes text displayed by the operating system 
or application program; italic text denotes text entered by the user. It is 
assumed that the ENTER keyboard key is to be pressed at the end of each 
line entered by the user. 
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In a Windows environment, the ENTER keyboard key does not 
always terminate a text string. It often initiates a series of actions 
based on a group of selections made in a dialog box. Therefore, its 
use may have unexpected results. 

IPG Terms 

Names of IPG menu items are shown in bold type (such as: Variable:, Save, 
etc.). If one character of a menu item is shown underlined (such as Actions, 
Operator, etc.), you can select that item by pressing the keyboard key - 
corresponding to that character (as well as by using the mouse). (There is 
one exception to this procedure: If you are selecting an item from a menu 
bar, you must press and hold the ALT key while you press the key corre- 
sponding to the underlined character.) 

Documentation References 

References to other documentation or to other portions or sections of the 
manual are given in italic type (such as: Instrument Front Panel Developer 
Manual; Section 5, Menus; etc.). 

If the manual or portion reference occurs in the middle of an italicized note, 
the reference will be in normal type (as in the following example). 

If ... proceed to the System Requirements description following. 
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IpG Documentation The documentation provided with IPG is as follows: 

Interactive Procedure Generator User Manual (this manual) 

Instrument Front Panel Developer Manual 

Customer Service For direct customer service concerning the IPG package: 

Report Software bugs on the postpaid Software Performance Report 
included in Appendix C, Software Performance Repoff, of this manual. 

For other assistance, contact your local Tektronix Field Office or your 
Sales Representative. 
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General Information 





General Information 

What is the 
lnteractive Proce 
Generator? 

The Tektronix lnteractive Procedure Generator (IPG), Version 2.5, is a Micro- 
soft@ Windows application program for creating programmable instrumenta- 
tion automated test procedures. IPG operates as a component of the 
TekTMS suite of software. IPG features the following: 

Compiled Code - A translator for converting the test procedures 
created using IPG into the C programming language. 

H Outline View of the Test Procedure - As each test step is created and 
edited, IPG displays the test procedure as an outline and generates the 
appropriate programming code for the instruments. 

H Context Sensitive Help - IPG provides help menu topics for more 
detailed help with menu dialog boxes and instrument front panels. 

H lnteractive lnstrument Front Panels - IPG uses representative or 
functional instrument front panels in separate, movable and sizable 
windows. These front panels allow you to create and edit test steps or 
control instruments interactively. 

H lnstrument Front Panel Libraries - Front panel libraries for VXI and 
GPlB instruments are available for use with IPG. For more information, 
contact your Tektronix Sales Representative. 

H Windows Application - IPG uses the widely accepted MicrosoftB 
Windows (hereafter referred to as Windows) user interface (Version 3.1 
or later). Text and graphics can be imported into the procedures using 
the Windows clipboard application. 

lnstrument Script Language - Users can develop new instrument 
front panel drivers or modify existing ones with the lnstrument Script 
Language and Help Editor (explained in the lnstrument Front Panel 
Developers Manual). 

Procedure Flow Control - IPG provides standard programming capa- 
bilities. 

H Variables - IPG provides storage of procedure results for later process- 
ing or comparison. It also provides string and math functions for pro- 
cessing the results. 

H lnteractive Adjustment Display - Adjustment steps allow visual ad- 
justment of a measurement in real-time. 

H Waveform Transfer, Processing, and Display - IPG can transfer 
waveforms from Tektronix digitizers, store them as variables, and pro- 
cess them with built-in signal analysis functions. 
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H Imported Displays - Bit-mapped images created by other Windows 
applications (MS Paint, etc.) can be imported into IPG with the windows 
clipboard and displayed during test runtime. 

H Procedure Nesting - Multiple procedures can be developed for a test 
program, and be called or controlled from a main procedure. 

The IPG Package 
The Standard Package 

The standard IPG package contains the following items: 

S3FT100 lnteractive Procedure Generator software on both 5.25" high 
density (1.2 MB) and 3.5" high density (1.44 MB) diskettes 

H lnteractive Procedure Generator User Manual 

Instrument Front Panel Developer User Manual (includes a Help Editor) 

NOTE 

For a listing and brief description of the files included on the IPG 
program disks, read or print out the PACKI NG.LST file on those 
disks. 

General Information 



System 
Requirements Required Hardware 

A Tektronix VXI System Controller (includes mainframe, keyboard, 
display, and VXI, GPIB, RS232, and printer interfaces) 

An IBM PC-AT compatible with the following: 

a National lnstruments GPIB interface card 

at least 4 Mbyte RAM 

w one 1.2 Mbyte or 1.44 Mbyte flexible disk drive 

at least 40 Mbyte hard disk 

a Hercules, EGA, or VGA graphics adapter, or equivalent, and a 
compatible display 

A Microsoft Mouse, or equivalent MS Windows compatible mouse 

The appropriate instrumentation systems 

The VXI controllers are shipped with the necessary drivers. 

If you are using a non-VXI controller with GPIB instruments, you must run 
Windows in Standard or Enhanced mode, with the National lnstruments 
GPIB.DLL available. If GPIB.DLL is not available, you will not be able to 
control GPIB instruments. 

If you are using a 386 or 486 based controller, you should run Windows in 
Enhanced mode, using GPIB.DLL. 

NOTE 

When running the version of IPG that controls GPlB instruments 
using the National Instrument GPIB. DLL Windows interface, you 
should not attempt to run translated tests from the Windows DOS 
shell. Instead, you should exit Windows and run the translated test 
from DOS using GPIB.COM. You can have GPIB.COM loaded while 
running GPIB.DLL in the Windows environment, but GPIB.COM 
should not be used while Windows is active. 

'The VXI System Controllers require an appropriately sized VXI Mainframe. 
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Optional Hardware 

Any printer compatible with the Windows environment will enhance IPG by 
providing output listings of test procedures and instrument driver (script) 
files. 

Required Software 

8 MS-DOS Version 3.0 or later 

8 Microsofl Windows Version 3.1 or later 

User Requirements TO use IPG, the user needs the following skills: 

8 A minimum level of knowledge about MS-DOS and its utilities 

w A familiarity with the Windows environment 

8 A familiarity with the required test instruments and their interfaces 

8 An understanding of the test procedures to be created, the resources 
needed to accomplish the test, and the ability to describe the test proce- 
dure in logical steps. 

Enhanced Mode IpG TWO versions of TEKTMS.EXE are on the diskette you received. One version 
is for MS Windows running in standard mode and one for MS Windows in 
enhanced mode. The enhanced mode version is faster and should be run if 
your version of Windows is running in enhanced mode. 

The copy of TEKTMS.EXE for standard mode can also be used in enhanced 
mode but it will run slower then the enhanced mode version. To determine if 
Windows is running in enhanced mode select the 'About program manager" 
menu item under the Help menu of the program manager. The dialog dis- 
played will let you know if you are running in enhanced mode or standard 
mode. The About dialog will also show how much memory is available. 

The enhanced mode version of TEKTMS.EXE uses a memory manager that 
keeps objects such as steps, variables and strings in a table or heap. To find 
the objects in the heap, IPG maintains an index table. Initially 2 Mbytes are 
allocated for the heap and 50,000 entries for the index table. These values 
are kept in the WIN.INI file. If these values are too small for your programs 
an error message is displayed by TEKTMS.EXE. If this occurs, change the 
entries in the WIN.INI file as described below. 
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Use 
File 

of the WIN.INI TEKTMS.EXE keeps information particular to your system in the WIN.INI file. 
The information is kept in the "TekTMSIIPG" section of the WIN.INI file. The 
section begins the following line. 

The TEKTMS.EXE section of the WIN.INI can have one or more entries as 
described below. These entries can be changed with any ASCII editor such 
as NOTEPAD or SYSEDIT in MS Windows. 

Heapsize 

The heap size is the number of bytes to be used by the TEKTMS.EXE 
memory manager in enhanced mode. The recommended minimum is 
2 Mbytes (2,000,000.) The maximum value is 16 million minus the amount 
required by MS Windows. The following line specifies 3 million bytes. 

Heapsize =3000000 

l ndexsize 

The index size is the size of the index table that keeps track of where things 
are in the heap. It is initially set to 50 thousand entries. The recommended 
minimum is 10 thousand entries. The following line specifies 20 thousand 
entries. 

TEKTMS error messages are kept in the file TEKTMS.ERR. This entry, if 
present, is the path to the file. When using TEKTMS.EXE, a message saying 
the error file was not found, is displayed if the file is not in the current direc- 
tory or with TEKTMS.EXE. The path you enter at this point is placed in this 
WIN.INI file entry. 

As an example the following line says the TEKTMS.ERR file is located on 
drive D: in directory \TEKTMS\EXE. 
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Getting Started 

Installing 
TekTMSIIPG 

TekTMSIIPG is quite easy to install with the supplied INSTALL Windows 
application. As you select from options during the INSTALL program, Help 
information will appear that describes the option. When prompted, any C 
include files should be installed into your existing C library, which is the 
default for INSTALL. When prompted, you should elect to overwrite exiting 
files, except for ISD files. Install the new ISD files in a new directory. You may 
need the old ISD files to run your existing test scripts. 

NOTE 

For information about installed files and additional product require- 
ments, refer to the READ. 100 files on the product disk(s). Before 
installing TekTMSIRTG review, the system requirements on page 
1-3. For information about file extensions used by TekTMSIIPG see 
File Names in this section. 

To install the software from within the Windows Program Manager, perform 
the following: 

1. Insert product disk number 1 into an appropriate disk drive. 

2. In the File menu, select Run. 

3. In the dialog box, enter the drive designator, a colon (:), and the com- 
mand INSTALL. If the product disk is in drive A you would enter 

A : INSTALL 

4. The install program will prompt you for the installation location and give 
you status as the installation proceeds. 

To install the software from the DOS prompt, perform the following: 

1. Insert product disk number 1 into an appropriate disk drive. 

2. At the DOS prompt, enter the drive designator, a colon (:), and the 
command INSTALL. If the product disk is in drive A you would enter 

A : INSTALL 

The INSTALL program will launch Windows and then proceed with the 
installation. 

3. The INSTALL program will prompt you for the installation location and 
give you status as the installation proceeds. 
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File Names When assigning file names to Test Procedures or Instrument Front Panel 
drivers within IPG, the user must follow the same naming conventions 
allowed in MS-DOS. 

Filenames can be from a minimum of one to a maximum of eight charac- 
ters long, and have an extension from one to three characters (i.e., 
DEMOTESTPRG). Additional information about file name extensions is 
provided in the File Name Extensions description, following. 

File names should begin with a letter from the alphabet (A-Z or a-z) 
and only letters and numbers (0-9). 

Because IPG is often used with other softwarelfirmware, users must ensure 
that filenames do not conflict. 

To avoid problems when translating IPG files into the C program- 
ming language, do not use the same name for test procedures and 
instrument driver files (such as DS02400.PRG and DS02400.ISD). 

GPlB lnterface Card File Name Conflicts 

When using a GPlB lnterface Card and its firmware in a personal computer 
or workstation, certain file names cannot be used for Test Procedures, or for 
lnstrument Front Panel drivers. Should a file name conflict occur between 
the GPlB lnterface Card software and IPG, a requested Test Procedure file or 
lnstrument Front Panel driver file may not be generated, or IPG may "lock 
up" or "hang" the system. 

GPlB lnterface Card software uses file names such as DM5010, PS5010, 
etc., for GPlB devices. To display the file names used, run Wibconf. Wibconf 
is part of the National Instruments GPlB driver system for Windows. 

File Name Extensions 

File name extensions consist of a period followed by one, two, or three 
characters. Those used within IPG are shown in the following table. 

Table 2-1 : File Name Extensions 

Extension Use 

. DAT Instrument data files 

.EXE Compiled executable only files 

.HLP Instrument Front Panel help files 
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Table 2-1 : File Name Extensions (Cont.) 

Extension Use 

.ERR The IPG error message file 
-- - - 

.ISB Instrument Software Definition files in binary format 

.ISD Instrument Software Definition files 

100  Read only information files about TekTMSIIPG 

. PRG IPG generated test procedure files 

.TMP Temporary files created by IPG 

.BMP Bit-mapped picture files 

.TMP Files - IPG, like most Windows applications, creates temporary files 
during operation. These files have a tilde character (") in the prefix and a 
.TMP suffix. Do not delete these files while IPG is running or fatal errors and 
unpredictable results can occur. These files are automatically deleted when 
IPG and Windows are closed normally (exited or closed through normal 
menu, icon, Control Menu, or File command selections). However, if IPG 
closes abnormally, these files are not deleted upon closing or during a 
reboot. Users need to periodically find the files left after an abnormal closing 
and delete them to save disk space. 

.TMP files are stored in a location defined by the pathname assigned to the 
TEMP environmental variable. If it is undefined, they are stored in the root 
directory of the boot drive. The DOS command format to set the TEMP 
environmental variable to a specific pathname is: 

SET TEMP=<PATHNAME> 

For example: 

SET TEMP=C:\ TMP 

To automatically set the TEMP environmental variable at reboot, put the 
command in your DOS AUTOEXEC.BAT file. 

The READ.lOO File 

The READ.lOO file (included on the IPG program disks) contains installation 
and other information about IPG. The user should read this file before install- 
ing the program disk files. One way to read the READ.lOO file a page at a 
time is to put the IPG program disk in drive A: and enter: 

MORE < A:READ.100 

This DOS command displays the file one page at a time. To turn the page, 
press any keyboard key. 
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Glossary of Terms The following definitions cover terms used by Tektronix that may have a 
different definition than a similar term used by a different application: 

Available lnstrument Drivers - A list of instrument drivers available for 
test procedure use. 

Bus -The communications channel used to control programmable 
instrumentation (VXlbus, GPIB, MXI, RS232, etc.). 

Focus/Focused - A  concept of identifying where the current action will 
occur; typically identified by a dotted rectangular box or a blinking 
cursor. For example, if an instrument front panel Checkbox has the 
focus, it is surrounded by a dotted rectangular box. 

Item - A generic term describing the various controls that may be used 
in a dialog box or menu. 

SCPl - Standard Commands for Programmable Instruments. For 
further information, refer to the Standard Commands for Programmable 
Instruments Manual. 

Selected lnstrument Drivers - A list of instrument drivers selected 
from the Available lnstrument Drivers for a specific test procedure. 

Test Procedure - A single file having a collection of test steps to per- 
form a complete test function. 

Test Program - A collection of test procedures. 

Test Step - A single step in a test procedure file. 

View -An instrument front panel display consisting of a graphical 
representation of controls, such as pushbuttons, check boxes, displays, 
etc. 
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Definition of 
Programming 
Elements 

This defines the data elements used in creating a program. Many of the 
programming constructs are built from these fundamental elements. Opera- 
tors are the instructions for combining elements to construct totals or larger 
elements. You can write subprograms to provide any operator that is not 
included in IPG. 

Expressions 

An expression is created from one or more of the elements that have a value 
combined to represent a new combined value. Another way of explaining an 
expression is to describe it as one side of an algebraic formula. Some 
examples of the components that make up an expression and some expres- 
sions follow: 

constants: 3 5.0 "start" 
variables: dmmReading$ CalFactor count& 
functions: val0 TAN0 UCASE$() fmtflt$() timer() 
operators: + A - ( 1  AND 

expressions: count*sqr(val(dmmReading$)-CalFactor)) 
faill AND fail2 AND fail3 
"Answer is"+str$(TAN(val(dmmReading$)*l.3)) 

+"Radiansn 

12 

Several things to note about expressions are: 

Expressions can be very simple (one element) or extremely complicated. 

8 Usually, all values are separated from each other by an operator. 

Using meaningful names makes the expression much easier to under- 
stand. 

8 Values can be of different types, and the proper combination of these 
types is necessary for correct results. 

Data suffixes are used to make the data type of a value more obvious. 

Constants 

Constants (sometimes referred to as scalar values) do not vary in value once 
assigned. 

Numeric Constants - Numeric constants are numbers. IPG recognizes 
two types, Integer and Float. 

Integers are 32-bit whole numbers in the range 2,147,483,648 to 
-2,147,483,647 (inclusive). 
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Floats are numbers containing fractional parts. They are 64-bit numbers in 
one of the following forms: 

sd ... d implied decimal; unscaled 

sd ... drd ... d explicit decimal; unscaled 

sd ... drd ... dEsd ... d explicit decimal; scaled 

d...dEsd...d implied decimal; scaled 

where s = sign (+ or -), d = digit (0-9), ... = repeated digits, r = decimal 
point (ASCII 46), E or e = explicit E or e 

String Constants - String constants (sometimes referred to as string 
literals, literals, or just strings) are a sequence of ASCII characters enclosed 
in double quotation marks (" "), such as: 

"this is a string constant." 

Variables 

Variables are names chosen to represent values used in an IPG test proce- 
dure. The value of the variable may be assigned specifically, or result from 
the execution of the test procedure. 

The first character of a variable name must be alphabetic. All characters 
after the first one can be alphanumeric or a period (ASCII 46). 

The length of a variable name is limited only by the amount of memory 
available; however, variable names must be unique within the first 32 charac- 
ters. 

Variables may represent Integers, Floats, Strings, or Waveforms as deter- 
mined by the data-type suffix symbol (see the Data Type Suffix description) 
appended to its name. If a data type suffix is not appended to a variable, the 
default data type is Float. 

There are two types of variables, local variables and global variables. Global 
variables must be defined by adding them to the Global Variables window. 
Local variables are defined only with in a single PRG file. If the variable "i&" 
is assigned the value 322 in test "A.PRG" and "AA.PRGn calls test "B.PRGW, 
the first reference to "i&" in "B.PRGn results in the error message 'Attempt to 
use uninitialized variable." Where as, if you define "i&" as global variable the 
first reference in "B.PRGn would return the desired value, 322. 

The TekTMS system defines a global variable named "PassFail." Its use is 
reserved for future release of the TekTMS system. You should avoid using 
"PassFail" as a variable name since it may cause conflicts with future re- 
leases. 

2-6 Getting Started 



Arrays 

An array is a group of variables of the same type that can be used with an 
index to shorten a program procedure. Before using an array name, you 
must define its size. This definition is done using the Dimension ... menu 
item from the Actions Menu. An example of the use of an array follows: 

DIMENSION results[lOI 

FOR count = 1 TO 10 STEPS 10 LINEAR 
REMARK A measurement step to put a value in one of the 

array elements. 
results [count 1 = dmm v o l t a g e  r e a d i n g  
NEXT 

For the programmer's convenience, the storage is reserved for the re- 
quested number of elements plus 1. This convention allows the programmer 
in the above example to address either the elements 0-9 or (as chosen in 
the example) 1-10, whichever is more natural to the application program. 

m Only one-dimensional arrays are allowed. 

Arrays can be floating, integer, or string types. 

m An array element can be used wherever a single variable can be used. 

A complete array, (that is, the array name without a specification of a 
single element) can not be used in expressions or as a parameter of a 
subroutine. 

Functions 

Functions are built in procedures that create a value. They may optionally 
use values that are supplied as inputs. Functions that return values that are 
strings must be marked with the $ data suffix. 

Common Functions - The functions in the following list are supported by 
IPG. All trigonometric functions use radians as the unit of measure. 

ABS(n) - Returns the absolute value of n. 

ASC(s$) - Returns the ASCII numeric value for the characters$. 

ATN(n) - Returns the arc tangent of n. 

CHR$(n) - Returns the ASCll character represented by n. 

CINT(n) - Converts n to an integer (rounds). 

COS(n) - Returns the cosine of n. 

DATE$() - Returns the current system date. 

EOF(n) - True if the last read of file n was at the end of the file. 

m EXP(n) - Returns a value of en. 
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FIX(n) - Converts n to an integer (truncates any fractional part; e.g., 
1.4 or 1.6 truncate to 1, while - 1.4 or -1.6 truncate to -1). 

HEX$(n) - Converts n to a hexadecimal value. 

INT(n) - Converts n to an integer (selects the largest integer that is I 
n; e.g., 1.4 or 1.6 convert to 1, while - 1.4 or - 1.6 convert to -2). 

LCASE$(s$) - Converts all characters in s$ to lowercase 

LEFT$(s$,n) - Extracts the left n characters from s$. 

LEN(s$) - Returns the length of s$. 

LOG(n) - Returns the natural logarithm (power of e) of n. 

LTRIM$(s$) - Removes any leading spaces (from the left side) in s$. 

MID$(s$,n,m) - Extracts a substring of m characters from s$, starting 
at the nth character. 

MOD(n,m) - Return the modulo value (remainder) of n divided by m. 

OCT$(n) - Converts n to an octal value. 

RIGHT$(s$,n) - Extracts the rightmost n characters from s$. 

RND(n) - Generates a random number between 0 and 1. When n = 0, 
the generator returns the next random number from a sequence gener- 
ated from a single seed and 0 is returned; when n >0, the generator is 
seeded with a random seed; when n <0, the generator is seeded with a 
fixed seed resulting in a repeatable sequence of random numbers and 0 
is returned. 

RTRIM$(s$) - Removes any trailing spaces (from the right side) in s$. 

SGN(n) - Returns a value defining the sign of n (1 indicates positive, 0 
indicates 0, and -1 indicates negative). 

SIN(n) - Returns the sine of n. 

SPACE$(n) - Creates a string of n spaces. 

SQR(n) - Returns the square root of n. 

STR$(n) - Returns the string representation of n. 

STRING$(m,n) - Creates a string of length m by repeating the charac- 
tern, where n is the ASCII character code of the desired character. 

TAN(n) - Returns the tangent of n. 

TIME$() - Returns the current system time. 

TIMER0 - Returns the number of seconds since system startup. 

UCASE$(s$) - Coverts all characters in s$ to uppercase. 

VAL(s$) - Returns the numeric value of s$. 
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IPG Special Functions - IPG provides a number of string functions that 
help you produce test reports. These functions format floating point and 
string data into fixed width fields that can be combined and output to a 
report file, a printer, or an operator display. 

The first parameter in each function establishes the field width in characters 
that the converted value cannot exceed. If the input value is too large for the 
specified width, the field is filled with asterisks (*) to indicate that the value 
overflowed the field. A field width of zero (0) causes an error message to be 
generated and the test execution to stop whenever the test is run. 

Floating Point Functions - The following functions convert floating point 
expressions into fixed width strings. When the width parameter is a positive 
value, the converted value is right justified in the field; when the width pa- 
rameter is a negative value, the converted value is left justified. 

fmtfix$(width, precision, value) - This function converts floating point 
values to strings with an embedded decimal point. The precision param- 
eter specifies the number of characters displayed to the right of a deci- 
mal point. A negative precision value will generate an error message. If 
precision is zero, no decimal point is displayed. If the value cannot be 
converted to a fixed-point string within the given width, an exponential 
form is tried. If this also fails, the field is filled with asterisks (*). 

The following examples show the results of using the function. 

String Expression Displayed Result 

m fmtexp$(width, precision, value) - This function converts floating 
point values into exponential strings. If the string does not fit within the 
width specified, the field is filled with asterisks (*). The precision param- 
eter specifies the maximum number of digits displayed to the right of the 
decimal point excluding the exponential suffix (e.g., ~+123) .  A negative 
precision value will generate an error message. When precision is zero, 
no decimal point is displayed. The displayed value is rounded to the 
specified precision. 
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The following examples show the results of using the function. 

String Expression Displayed Result 

fmtflt$(width, precision, value) - This function converts floating point 
values into strings. The resulting string is in either the fmtexp$() or 
fmfflt$() format, whichever is shortest. When width is negative, the result 
is left justified; when width is positive, the result is right justified. Preci- 
sion specifies the number of significant digits (excluding leading 0's to 
the left of the decimal point and trailing 0's to the right of the decimal 
point). If the converted value is too large for the specified width, the field 
is filled with asterisks (*) .  See fmtexp$() and fmfflt$() for examples of the 
resulting strings. 

The following examples show the results of using the function. 

String Expression Displayed Result 

fmtint$(width, minwidth, value) -This function converts a numeric 
value into an integer value. If the numeric value is a floating point value, 
it is rounded to an integer before conversion. If the value is too large to 
be represented as an integer, the field is filled with asterisks (*). The 
parameter minwidth specifies the minimum number of digits displayed. 
When the value has fewer digits then minwidth, leading zeros are add- 
ed. When width is negative, the result is left justified; when width is 
positive, the result is right justified. The output is always at least one 
digit. Negative minwidth values are ignored. 
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The following examples show the results of using the function. 

String Expression Displayed Result 

NOTE 

Justification for string functions is just the opposite of that for the 
floating point functions. When the width parameter is a positive 
value, the converted value is left justified in the field; when the width 
parameter is a negative value, the converted value is right justified. 

String Functions - 

8 fmtstr$(width, string) - This function places a string in a fixed-width 
field. If the string is too large for the field, only the left most width num- 
ber of characters is used. A width of zero (0) will generate an error 
message. The following examples show the results of using the function. 

String Expression Displayed Result 

" : "+fmtstr$ (5, "ABCDEFGHIJKL") + "  : " : ABCDE : 

" : "+fmtstr$ (5, "ABC") +":" :ABC : 

" :  "+fmtstr$ (-5, "ABC")+":" : ABC: 

Operators 

IPG supports several classes of operators. 

Arithmetic Operators - Arithmetic operators perform the commonly 
understood arithmetic operations. These operators are: 

+ addition 

- subtraction 

* multiplication 

/ division 

A exponentiation 
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Logical Operators - Logical operators provide the capability to combine 
values according to the commonly accepted definitions for logic operators. 
The operators are: AND, OR, and NOT. Following are the truth tables for 
these operators: 

Relational Operators - 

Relational operators compare two values and create a value of one (1) or 
zero (0) to represent TRUE (1) or FALSE (0). These operators are: 

NOT Truth Table 

x NOT x 

1 0 

0 1 

AND Truth Table 

x y x ANDY 

1 1 1 

1 0 0 

0 1 0 

0 0 0 

= equal 

OR Truth Table 

x Y x OR y 

1 1 1 

1 0 1 

0 1 1 

0 0 0 

< less than 

> greater than 

<> not equal 

<= less than or equal 

>= greater than or equal 

String Operators - String operators act on two strings. The only operator 
supported by IPG is concatenation, which creates a string consisting that 
consists of the first string followed by the second string. Functions are 
provided to perform other operations on strings. The symbol for the concate- 
nation operator is the + symbol. IPG determines from the context whether 
the + stands for arithmetic plus or concatenation. If the context is not clear, 
you have created an invalid expression and IPG will notify you with an error 
message. 
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Data Type Suffixes IPG supports the following data type suffixes for variables (default when no 
suffix is used is Float): 

# Float 

& lnteger 

$ String 

- Waveform 

Float 

Float data is a 64-bit numeric value as defined in ANSl X3.42-1975 for an 
NR2 or NR3 numeric representation. The range is 
- .7976931348623158E +308 to 1.7976931 3486231 58E +308. See the 
previously explained Numeric Constant topic for its form. 

lnteger 

lnteger data is a 32-bit numeric value as defined in ANSl X3.42-1975 for an 
NR1 numeric representation. See the previously explained Numeric Constant 
topic for its range. 

String 

String data is sequential ASCII characters enclosed in double quotation 
marks (" "). See the previously described String Constant topic for its form. 
The maximum length is limited to the amount of free memory (RAM). 

Waveform 

Waveform data is Tektronix defined data packages that include a description 
of the data along with the data itself. IPG includes the routine(s) required to 
convert waveform data from Tektronix devices for IPG use. The maximum 
size of a waveform for display is limited to the amount of free disk space. 
The maximum size of a waveform that can be analyzed with Pulse Parameter 
functions is 16K (16288). When transferred to a file, the waveform data is 
written in Analog Data Information Format (ADIF) 1.0 (also called SCPl 
1992.0). 
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Numeric Terms Numeric terms must adhere to the following definition: 

NUMERIC TERM : : =  NUMERIC CONSTANT I NUMERIC VARIABLE 1 
NUMERIC EXPRESSION 

NUMERIC CONSTANT : : = See the previously explained Numeric Con- 
stant topic 

NUMERIC VARIABLE : : = an integer or float variable 

NUMERIC EXPRESSION : : = an expression that evaluates to a Numeric 
Constant 

Data File Format The format of data files associated with file transfers by IPG follow rules 
similar to BASIC language READS and WRITES. 

When IPG writes to a file (Transfers to a File), the following rules apply: 

H Strings are terminated with a CRLF (Carriage Return, Line Feed) 

H Each numeric value is converted to its ASCll value, written to the file, 
and terminated with a CRLF. This essentially places each numeric value 
on a separate line. 

You must also follow these rules for files created to be read by IPG. 

The exception to the described data transfers takes place during instrument 
inputloutput. During data transfer to and from an instrument, the entire file is 
read from or written to the instrument (from the beginning) at one time, with 
the file being opened and closed at each transfer. The format of the file is 
dependent upon the instrument that you are communicating with. 

ASCII Log File ASCII log files are intended to be read by users. Every time a logfile is 

Format opened a header is written to it. The header includes the filename, a blank 
line, the date, and a column header with the names of the items written out 
to the log file. These items are: 

H sequence number - a number that identifies this log entry. The value 
is incremented with each log entry and not reset for each test. 

H time of day - in hours, minutes, and seconds, surrounded by double 
quotes. 

H low value - the lowest measured value that will yield a PASS. 

nominal value - the expected or target value. 

high value - the highest measured value that will result in a PASS. 

H actual value - usually the actual measured value. 
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8 PASS/LOW/HIGH indicator - "PASS" if the actual value is between the 
low value and the high value. "HIGH" if the actual value is greater than 
the high value and "LOW" if the actual value is less than the low value. 

8 comment - a string surrounded by double quotes, used to annotate 
the log entry. 

As an example the following log file has three entries the first passed the 
second was low and the third was high. 

LOW NOMINAL HIGH ACTUAL PASS/FAIL 

4873 16:52:26 4000 5000 6000 5010 PASS no comment 

4875 16:52:27 4000 5000 6000 3700 LOW no comment 

4877 16:52:28 4000 5000 6000 7890 HIGH no comment 

SV Log File Format CSV or Comma Separated Value files are intended for use with other pro- 
grams, such as spread sheets or data base programs. CSV Log files can be 
read with the INPUT step as a sequential file. 

A CSV log file contains one line for each PRINT CSV LOG step that was 
executed. A line in a CSV log file contains seven fields that are separated by 
commas. The fields are: 

8 sequence number - a number that identifies this log entry. The value 
is incremented with each log entry and not reset for each test. 

8 time of day - in hours minutes and seconds, surrounded by double 
quotes. 

8 low value -the lowest measured value that will yield a PASS. 

8 nominal value -the expected or target value. 

8 high value - the highest measured value that will result in a PASS. 

8 actual value - usually the actual measured value. 

PASS/LOW/HIGH indicator - "PASS" if the actual value is between the 
low value and the high value. "HIGH" if the actual value is greater than 
the high value and "LOW" if the actual value is less than the low value. 

8 comment - a string surrounded by double quotes, used to annotate 
the log entry. 

As an example the following file has two entries the first for a measurement 
that passed and the second for one that failed. 

"17:19:41",1,500,1000,501.34,"PASS","Its well within range" 

"17 :19 :4lU, 1,500,1000, -1, "LOW", "woo! its negative" 
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The two times are the same because booth entries were made within a 
second of each other. 

We recommend that name of CSV log files have a type field of CSV. The 
about log file might be named EXAMPLE.CSV. 

Sequential File Sequential files are created by PRINT steps and can be read by INPUT 

Format steps. Each record of a sequential file is a string of characters terminated by 
a carriage-return-line-feed sequence. The characters in the record can be 
any byte value from zero (0) to and 255 inclusive. 

Sequential files can be used for a wide variety of purpose including reports, 
data logging, printing labels, and just about anything that uses strings of 
characters. Both the ASCII and CSV log files are variants of sequential files 
and can be read as sequential files. 

Initializing IPG The following assumes that Windows and a mouse are installed and fully 
operational. 

To initialize IPG, perform the following: 

1. At the DOS prompt, enter the Windows environment. 

2. When the Program Manager appears: point to the drive icon where IPG 
is located and click the mouse, then select Restore from the menu that 
will appear (or you can double-click the mouse on the icon to bypass 
using Restore); select from the File Menu and enter the path for IPG in 
the edit control box, then select the pushbutton; or open the 
TEKTMS.EXE file through the Windows File Manager. 

The IPG Main Menu window (shown in the following illustration) will then 
appear. You are now ready to create a test procedure. However, before 
beginning, you may want to maximize the IPG window (as shown in the 
illustration). At this point, you can review the following section on IPG Dis- 
play Familiarization or continue to Section 3, Creating and Editing a Test 
Procedure. 
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IPG Display 
Familiarization 

Since IPG displays can be described in standard Windows terms, the follow- 
ing example IPG displays are shown with a description of some common 
items. 

IPG Main Menu with Sample Menu 

The following illustration shows the IPG Main Menu with its Actions Menu 
selected (captions have been added to refer you to the definitions following 
the illustration - these captions are not part of the normal display). It is a 
typical Windows display showing a submenu (Actions) selected. To obtain 
this display, select the Actions menu item from the Main Menu by pointing 
to it and clicking with the mouse, or by pressing and holding the ALT key- 
board key while pressing the "A" keyboard key. To display a different menu, 
repeat the sequence for the menu you want to see. (Each menu has an 
underlined character in its name. This character designates the keyboard 
key to press if you wish to call the menu with the keyboard keys, rather than 
the mouse.) To remove a menu, point to the white space in the work area 
and click the mouse. 
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MENU BAR 

MENU ,/ 
ITEMS 

{ 1 ~ ~ $ ~ ~ ~ ~ ~ ~ t e r s ' ' '  1 ~ ~ t ~ ~ I U e  xt... 11 
Call procedure 

On Event ... Exit Procedure ... 
On Abort ... - Stop Test ... 
Delay ... - Gosub ... 
Remark ... 

MENU 
ITEM 

ARROW 

MENU ITEM 
ELLIPSIS 

w MENU BAR - a horizontal bar that contains the names of other menus 
you can access. 

MENU ITEM - a word or phrase that you select to carry out an action. 

MENU ITEM ARROW - designates that you will see another menu 
when you select the menu item preceding it. 

MENU ITEM ELLIPSIS -designates that you will see a dialog box 
when you select the menu item preceding it. 

IPG Dialog Box 

The following illustration shows an IPG dialog box selected through the 
Instruments Menu. To display it, select Actions from the Main Menu. When 
the lnstruments Menu appears, select On Event .... To implement the actions 
associated with entries in a dialog box, select the OK pushbutton. To exit the 
dialog box without implementing any action, select the CANCEL pushbut- 
ton, or press the ESC keyboard key. 
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TekTMSIIPG - [untitled] 
le Edit Actions Operator Links instruments Run! Debug Oetions 

Edit Label Comment - 

Test Procedure: Event: 
EDIT j-1 SRQ CONTROL 
BOX c:\cheshire\exes Timeout 

1000.prg 
LIST 950.prg VXI Event 

BOX s2.prg 
sample.prg 
sub.prg 
tmP.Prg 
1.d 
Parameters: 

RADIO BUlTONS 

EDlT CONTROL BOX - a box for entering or editing information. It may 
be empty when the dialog box appears, or it may contain a default entry. 
Edit control boxes typically have names followed by a colon (:). 

LISTBOX - an item in a dialog box containing a list of available 
choices, such as disk drives, directories, test instrument data, etc. You 
can select items in a list box, but you can not edit them, unless they 
were placed in the ListBox through an Edit Control Box. In this case, you 
can edit the Edit Control Box entry, which will change that entry in the 
ListBox. 

Brackets ( [ I ) delimit disk drives and directories, and hyphens (-) 
further delimit disk drives from directories. For example, [-a- ] denotes 
a disk drive and [ library I denotes a directory. A [ . . I denotes the 
next higher directory from the current directory. A list box may initially be 
empty until you make an entry in an Edit Control Box, or perform some 
other action. 

rn CHECKBOXES - options in a dialog box that can be individually turned 
on or off. One or more of these options can be turned on or off simulta- 
neously. 

PUSHBUTTONS - command buttons in a dialog box labeled to indi- 
cate what they do when you select them. 

rn RADIOBUTTONS - mutually exclusive options in a dialog box, of 
which only one can be turned on at any one time. Selection of one 
radiobutton cancels the selection of a previous radiobutton. 
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IPG Global 
Window 

Variables The following illustration shows the IPG global variable window. Use this 
window to manipulate the list of global variables. Variables can be added or 
deleted to the list through this window. The window has two main compo- 
nents, the list of variables and a menu. The list of variables always contains 
at least one entry, PassFail. 

1 1  Add ... I>c:lefr: Clt:rrr Alt C $ r ~ ~ ~ ~ ~ ~ t : , , ,  11 

Add ... - Select Add ... to add a variable to the list of global variables. The 
following dialog will then appear. 

Name - is an edit box. Enter the name of the global variable in this edit 
box. If the variable is an array, include the number of entries just as you 
would in a dimension step. 

m Ok - a pushbutton. Press Ok to add to the list of global variables. 

Cancel - a pushbutton. Press Cancel to close the dialog box without 
adding anything to the list of global variables. 

Delete - Select Delete to delete the selected ListBox item from the list. - 

Clear All -The Clear All list item removes all the global variable names - 
from the list box, except for "PassFail." 
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Change - Select Change to display a dialog that allows you to change the - 
currently selected global variable. The dialog looks and performs the same 
as the Add dialog. Changing a global variable in this manner only changes it 
in the global variable list box. It does not change where the variable is used 
within a test. 
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Test Procedures 





Creating and Editing Test Procedures 

This section contains a step-by-step tutorials for creating and editing simple 
test procedures. The instrument drivers and picture files needed to create 
the procedures are provided on the IPG program disks. lnstrument drivers 
for the various test instruments must be selected from the Tektronix Instru- 
ment Front Panel Libraries, or written (refer to the lnstrument Front Panel 
Developers Manual for further information). The IPG program disks contain a 
program file (DEMOTEST.PRG) of a sample test procedure. That procedure 
is more complex than the procedures covered in the section. You may want 
to work with that procedure after you have become accustomed to simpler 
procedures presented here. Refer to Section 6, Advanced Applications, for a 
tutorial on the DEMOTESTPRG procedure. 

NOTE 

The creation of the test procedures also gives instruction on how to 
run them. If you wish to try running the procedures in the Single 
Step mode, refer to the Debug Menu description (Section 4, Me- 
nus) for further information. 

Test Procedure 
Overview Assumptions 

For those users who intend to perform the steps in these tutorials, the follow- 
ing assumptions have been made: 

8 All IPG and Windows files are loaded onto the appropriate disk drives 
and directories. 

8 IPG is running in a Windows environment. 

8 A Tektronix 2400 Series Digital Sampling Oscilloscope (with the neces- 
sary GPIB cabling to your controller) is available for use in two of the 
following tutorials. (If this oscilloscope is not available, you may still 
continue with the tutorials: information is provided on emulating the 
nonexistent instrument for the fourth tutorial, and, although you will not 
be able to run the fifth tutorial, you can still create it.) 
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Software 

The following instrument driver and bit-mapped picture files are used only in 
the creation of the tutorial test procedures. They are included on the IPG 
program disks, and should already be resident in the directory where the 
test procedure is to be stored. 

NOTE 

IPG does not keep track of the directory pathnames for files used in 
the test procedure (files with extensions such as .ISD, .BMe etc.); 
therefore, those files must be resident in the directory where the 
test procedure file is stored. 

Creating Test 
Procedures 

Screen displays are shown at key places in the following tutorials. However, 
not all displays that occur are shown. If your displays do not match the 
illustrations, either do minor editing as explained below, or select the Cancel 
pushbutton on your display and start the tutorial step over. 

Since editing a procedure is not explained until the latter part of this section, 
and because there are many editing options, the following instructions on 
how to do minor editing should suffice to get you through creation of the 
sample test procedures: 

If you select the wrong item from a menu, simply move the cursor onto 
the white space in the display and click the mouse to return to the Main 
Menu. 

If your selection of a wrong item causes a dialog box to appear, select 
the Cancel pushbutton from that dialog box to return to the Main Menu, 
then begin the step again. 

If you are in a dialog box and make an error in selecting a radiobutton or 
a list box, simply select the correct radiobutton or list box choice. 

m If you make an error in a check box, continually select the check box 
until the " X  appears or disappears depending on the condition re- 
quired. 

If you enter the wrong text in an edit box, use the BACKSPACE, DEL, or 
directional arrow keys to correct it. 

If you select an OK pushbutton and created a wrong or unwanted step, 
note the error and continue creating the procedure. When you have 
finished the procedure, use the tutorial information in Editing a Test 
Procedure, in the second half of this section, to delete the unwanted 
step. 
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NOTE 

In the following tutorials, when you are told to select an item, you 
can select that item by pointing and clicking the mouse on it. Some 
of the items have an underlined character in their names. You can 
select these items from a menu list not only with the mouse, but 
also by pressing the keyboard key corresponding to the underlined 
character. To select these items from a menu bar, press and hold 
the ALT key while pressing the key corresponding to the underlined 
charactel: 

Test Procedure Number 1 

In this tutorial we will learn how IPG communicates with the operator, and 
give an example of the use of math and string functions. The following test 
procedure will prompt the operator for a number, then perform a math 
function on that number and display the result. 

Perform the following to create this procedure: 

1. Initialize IPG and display the Main Menu. Select Eile, causing the File 
Menu (shown in the following illustration) to appear. 

2. Select New. This will cause IPG to open a blank file and return to the 
main menu. 
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3. Select Qperator, causing the Operator Menu (shown in the following 
illustration) to appear. 

Prompt 

4. Select prompt, causing the Prompt Menu (shown in the following illus- 
tration) to appear. 
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Adjustment ... 
Display X/Ploi ... 
Display Waveforms ... 

F l  =Help 



5. Select Text ..., causing the Text Prompt dialog box (shown in the follow- 
ing illustration) to appear. 

l Edit Label Comment 

Message: 

Enter any number to be raised to the 5th power ... 

/ Variable: 1 mynumbers( 

6. Use the keyboard keys to enter the following message in the Message: 
edit control box: Enter any number to be raised to the 5th power. Click 
the mouse on the Variable: edit control box and enter: mynumber$. The 
results should match the above illustration. This will assign the string 
variable named mynumber to whatever number you enter when you run 
the procedure. 

7. Select the OK pushbutton. This will return you to the Main Menu. Verify 
that your display matches the following illustration. 
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8. Select Actions, causing the Actions Menu (shown in the following 
illustration) to appear. 

Call procedure 
Exit Procedure ... 
Stop Test ... 

Delay ... Gosub ... 
Remark ... Return ... 
include 

9. Select Calculate ..., causing the Calculate dialog box (shown in the 
following illustration) to appear. 

10. Enter the following in the Variable: edit box: mynumber. Click the mouse 
on the Expression: edit control box and enter: (VAL(mynumber$)) A 5. 
The results should match the above illustration. This will cause IPG to 
raise whatever number is in the variable mynumber to the fifth power. 

Edit Label Comment - 

Variable: Expression: 

3-6 Creating and Editing Test Procedures 

[VAL[mynumberS]]*5 mynumber 
, . . . . . . . . < 

~. . . . . . . . . , 

= 



11. Select the OK pushbutton to return to the Main Menu. Verify that your 
display matches the following illustration. 

Translate F1 =Help 
PROCEDURE [untitled] ] 
PROMPT Enter any number to be raised to the 5th power... 

12. Select Qperator, causing the Operator Menu to appear (as in Step 3). 
Select Display Data, causing the Display Data Menu (shown in the 
following illustration) to appear. 
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13. Select Wait ..., causing the Display Data Wait dialog box (shown in the 
following illustration) to appear. 

Expression: 

mynumber 

14. Ignore the Caption: edit box, but enter the following in the Expression: 
edit box: mynumber. The results should match the above illustration. 
Select the OK pushbutton to return to the Main Menu. Verify that your 
display matches the following illustration. This step tells IPG to display 
the results of raising the number you entered to the fifth power. 

File Edit Actions Operator Links instruments Bun! Debug Ogtions - 
Translate F1 =Help 

PROCEDURE (untitled) [ ] 
PROMPT Enter anv number to be  raised to the 5th Dower... 
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15. We are now ready to name the test procedure. Select Eile, causing the 
File Menu to appear (as in Step 1). Select Save as ..., causing the Save 
File As dialog box (shown in the following illustration) to appear. 

TekTMS/IPG - [untitled] 
File Edit Actions Operator Links instruments Bun! Debug Options - 

16. Enter the following in the Save File as: edit control box: testl. Ignore the 
Edit Password: and Run Password: edit control boxes. The results 
should match the above illustration. (Notice the disk drive and pathname 
in the upper right corner of the dialog box. This is the location that IPG 
will save your procedure.) Select Save to name the file and return to the 
Main Menu. Verify that your display matches the following illustration. 
Notice that the Title Bar of the window, which had previously been 
labeled TekTMS (untitled), now is labelled TekTMS-TEST1. PRG. 

Translate F1 =Help 
PROCEDURE IPG [ ] 

PROMPT Enter any number to be raised to the 5th power ... 

. Iranslate F1 =Help 

PROCEDURE [untitled) [ 1 
PROMPT Enter any number to be raised to the 5th power ... 
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DISPLA Save file as: c:\ ... \docs\manchang 

test l  I 
Edit Password: 

1 7 1  
Run Password: 

I 



17. We can now run the procedure. Select Bun!. The Text Prompt window 
shown in the following illustration will appear. 

I I Enter any number to be raised to the 5th power... I l  I 

1 yr response: I 

18. Enter a number in the Enter Response: edit box. (In the above illustra- 
tion, the number entered was 5.) Select OK. IPG will respond with the 
Display Data message box shown in the following illustration. The num- 
ber you entered (raised to the fifth power) will be shown. Select OK to 
end the procedure and return to the Main Menu. 

3-10 Creating and Editing Test Procedures 



Test Procedure Number 2 

In this procedure we will show how IPG transparently handles waveforms 
and displays them in an interactive graphic window. 

1. Select File from the Main Menu bar. Select New from the File Menu. 
Select Actions from the Main Menu, then select Transfer Data from the 
Actions Menu. The Transfer Data menu (shown in the following illustra- 
tion) will appear. 

Variable to Instrument ... 
On Abort ... Instrument to Variable ... 
Delay ... Instrument to File ... 
Remark ... File to Instrument ... 
Include 

2. Select Eile to Variable ..., causing the File to Variable dialog box (shown 
in the following illustration) to appear. 
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3. Enter tekwave.wfd (a waveform display file included on the IPG disk for 
tutorial purposes) in the File Name: edit box. Notice the disk drive and 
pathname directly under the File Name: edit control box. This pathnarne 
must be the correct location for the tekwave.wfd file. If it is not, select the 
correct disk drive, then the pathname, from the list box under the disk 
drive and pathnarne currently given. Enter wfmN in the Variable: edit 
box. This assigns the waveform display in tekwave.wfd to the variable 
name wfmN. The results should match the above illustration. Select OK 
to return to the Main Menu, and verify that your display matches the 
following illustration. 

11 Eile Edit Actions Operator Links Instruments Bun! Debug Options 11 
l ranslate F1 =Help 

PROCEDURE runtitledl 1 

4. Select Operator, then select Display Data from the Operator Menu. 
Select Wait ... from the Display Data Menu. The Display Data Wait dialog 
box (shown in the following illustration) will appear. 

Edit Label Comment - 

Caption: 

Expression: 

1 wfml 
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5. Enter wfm" in the Expression: edit box. This tells IPG to display the 
waveform. Your display should now match the preceding illustration. 
Select OK to return to the Main Menu. Verify that your display matches 
the following illustration. 

11 Eile Edit Adions Operator Links instruments Run! Debug Ogtions 11 
Translate F1 =Help 

PROCEDURE [untitled] [ ] 
TRANSFER tekwave.wfd -> wfm" 

6. Select File, then Save as... . Enter test2 in the Save File as: edit box, 
then select Save to save the file and return to the Main Menu. Verify that 
your display matches the following illustration. 

7. Select Run!. The following waveform display will appear. 
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Select OK to exit the waveform display and return to the Main Menu. We will 
use this test procedure again in Section 5, Advanced Applications, to dem- 
onstrate the interaction you can perform with a waveform display. 

Test Procedure Number 3 

In this procedure, you will learn how to display a picture of a circuit board 
layout to assist the operator in locating and adjusting a control. 

1. Select File from the Main Menu, then select New from the File Menu. 
Select Operator from the main Menu, then select Prompt from the 
Operator Menu. This will cause the Prompt Menu (shown in the following 
illustration) to appear. 

F1 =Help 
Display X/Plol  ... 
Display Wayeforms ... 

I Disolav Data b I 
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2. Select Pjcture ..., causing the Picture Prompt dialog box (shown in the 
following illustration) to appear. 

3. Select file, causing the Picture Prompt File Menu (shown in the follow- 
ing illustration) to appear. 
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4. Select Load ..., causing the Load File dialog box (shown in the following 
illustration) to appear. 

Picture Name: 

c:ue ktm s 

PICTURE PROMPT 
File Edit Label Comment - 

5. Enter tekpic.brnp in the Picture Name: edit box. (Notice the disk drive 
and pathname below the Picture Name: edit box. The disk drive and 
path should match the location of the TEKPIC.BMP file. If they do not, 
point and click the mouse to select the correct disk drive and path from 
the list box below the existing disk drive and path.) The results should 
match the above illustration. Select Load to load the file and return to 
the Picture Prompt dialog box. The circuit board picture in the TEK- 
PIC.BMP file will appear as shown in the following illustration. This 
picture will be shown to the operator when the file is run to help in 
locating the control to be adjusted on the circuit under test. 

R 1 9  1-1 
R 4  a 

COM - 1 5 U  
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6. Select Eile, causing the Picture Prompt File Menu to appear. Select 
Save and Exit ..., saving the picture file to your procedure and returning 
you to the Main Menu. Verify that your display matches the following 
illustration. 

7. Select Operator, causing the Operator Menu to appear. Select Adjust- 
ment ..., causing the Adjustment dialog box (shown in the following 
illustration) to appear. 
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Edit Label Comment - 

Lower Limit: Nominal Value: Upper Limit: 

3 5 1 18 

Variable: ADJ 

Pass/Fail: 
Message: 
- 

Adjust R3 to nominal value. 

V! 



8. Enter 3 in the Lower Limit: edit box, 5 in the >Nominal Value: edit box, 
8 in the Upper Limit: edit control box, ADJ in the Variable: edit box, and 
the following in the Message: edit box: Adjust R3 to nominal value. The 
results should match the above illustration. These entries set the limits 
that you want on the adjustment of R3 (in this case, the output of an 
amplifier), and display a message to the operator to tell him what opera- 
tion to perform. Select OK to return to the Main Menu. Verify that your 
display matches the following illustration. 

Lranslate F1 =Help 
PROCEDURE (untitled) ( ] 

PROMPT PICTURE tekpic.bmp 
ADJUSTMENT ADJ LOW 3 NOMINAL 5 HIGH 8 

NOTE 

Since we do not have an instrument or test circuit connected, we 
will insert steps, using the IPG random number generator to create 
simulated output readings from the amplifier under test, and to add 
a delay so that we can more easily observe the results. We will 
place these steps inside the ADJUSTMENT loop. In an actual test 
procedure, these steps would not be necessav. 

9. Point and click the mouse on the END-ADJUSTMENT step in your proce- 
dure to highlight it (This will allow us to enter the next two steps before 
the END-ADJUSTMENT). Select Actions, causing the Actions Menu to 
appear. Select Calculate ..., causing the Calculate dialog box (shown in 
the following illustration) to appear. 
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Edit Label Comment - 

Variable: Expression: 

ADJ ] = JRND~O~* IO~ 

10. Enter ADJ in the Variable: edit box and RND(O)*IO in the Expression: 
edit box. The results should match the above illustration. Select OK to 
return to the Main Menu. Verify that your display matches the following 
illustration. 

Translate F1 =Help 
PROCEDURE [untitled] [ ] 

PROMPT PICTURE tekpic.bmp 
ADJUSTMENT ADJ LOW 3 NOMINAL 5 HIGH 8 

11. Select Actions, then select Delay ..., causing the Delay dialog box 
(shown in the following illustration) to appear. 

Edit Label Comment - 

rl Milliseconds 

i 

12. Enter 1000 in the edit box. The results should match the above illustra- 
tion. This will insert a one second delay in the random number genera- 
tion sequence to provide a more realistic simulation of test 
measurements. Select OK to return to the main Menu. Verify that your 
display matches the following illustration. 
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Translate F1 =Help 
PROCEDURE [untitled] j 

PROMPT PICTURE tekpic.bmp 
ADJUSTMENT ADJ LOW 3 NOMINAL 5 HlGH 8 

CALCULATE ADJ = RNDIOI*l 0 

13. Select Eile, then select Save as... . Enter test3 in the Save File as: edit 
box. Select OK to return to the Main Menu. Verify that your display 
matches the following illustration. 

INAL 5 HlGH 8 

14. Select Run!. As in the following illustration, IPG will display the circuit 
board picture showing the adjustment location. 
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Rn -ara- - 
OUT 

* 
R 4  con -15u I 

15. Select QK. As shown in the following illustration, IPG will now display a 
message box showing the limits set for the adjustment, the nominal 
value, and a message telling the operator what is expected. The point 
between the right and left arrows indicates the level to which the opera- 
tor must adjust the output (shown by the moving diamond pointer) to 
achieve the specified nominal value. The random number generation 
step we included in the procedure will simulate output readings taken 
on the circuit under test while the operator adjusts R3. 

Notice the words In Range in the lower right portion of the message 
box. This indicates that the current reading is in the range specified by 
the lower and upper limits. if the reading is not within the limits, the In 
Range message will disappear. 

Low Nominal: 15. I High 

3. Actual: 14.456923124 ] 8. 

In Range 

+ b 4  

16. Select OK to end the procedure and return to the Main Menu. 

Adjust R3 to nominal value. 

+I I I* 
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Test Procedure Number 4 

In this procedure, we will learn how to select, configure, and use an instru- 
ment front panel driver to develop a test procedure step in which we set up 
all controls for the specified instrument. If you do not have the oscilloscope 
specified in the Hardware description (earlier in this section) connected, you 
will still be able to complete this procedure and emulate the actual running. 

1. Select Eile, then select New. Select Instruments, causing the Instru- 
ments Menu (shown in the following illustration) to appear. 

. . . . . . . , , , , . , , . , . . . . . . . . . . . . . . . . , . . . . . , . . . , . , . , , , , . 

Emulate ... - 
I VXI Controller 11 

2. Select Select ..., causing the Select dialog box (shown in the following 
illustration) to appear. 

TMS Name Driver Address 

I I 

Drivers: TMS Name: 

3. Point and double click the mouse on 2400dso.isd in the list box in the 
lower left corner. This will select that instrument driver and cause entries 
to appear in the Drivers: and Port: edit boxes. Enter the primary GPlB 
address of the instrument in the Address: Primary: edit control box. (If 
you do not have an instrument connected, enter 0.) Enter DSO in the 
TMS Name: edit box. 
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4. Select Add. This will cause the information in the edit boxes to appear in 
the large list box at the top of the dialog box, as shown in the following 
illustration. 

5. Select OK to return to the Main Menu (no change will be visible on the 
Main Menu display, since selecting an instrument does not create a 
procedure step). To display the instruments front panel, select Instru- 
ments, then View, and finally DSO. The following illustration shows this 
selection. 
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6. Click the mouse on the driver name (2400dso.isd) to highlight it, then 
select OK. The instrument panel view shown in the following illustration 
will appear. 

Volts/Div POSITION 

TRIG POSITION [Range 1 - 301 

50 Ohm TERM 

7. You can now set the controls to the desired settings by pointing and 
clicking the mouse on one of the multiple selections for a control (such 
as Volts/div), or by pointing and clicking the mouse on the entry box, 
then entering the desired setting, for controls that do not have all possi- 
ble entries given (such as Trigger Level). After you have set the con- 
trols, select Step causing the Step Menu (shown in the following 
illustration) to appear. 

TRIG POSITION [Range 1 - 301 

50  Ohm TERM 
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8. Select Save All Settings. This will save the control settings. Click on 
Step Close to exit the view. Select File, then select Save as.. .. When 
the Save As dialog box appears, enter test4 in the Save File as: edit 
control box and select Save. Verify that your display matches the follow- 
ing illustration. 

Iranslate F1 =Help 
PROCEDURE luntitledl l 1 

9. Resize the IPG Main Menu window to resemble the window shown in 
the following illustration. 

Translate 
luntitledl l 1 

10. Select Debug, then select Trace Bus, causing the Trace Bus message 
box (shown in the following illustration) to appear. 

Translate 
PROCEDURE luntitledl l 1 
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11. If you have the specified oscilloscope connected by a GPlB bus, skip 
this step and go to Step 13. If not, select Instruments, then select 

.... Emulate causing the Emulate Options dialog box (shown in the - 
following illustration) to appear. 

11-1 TekTMSIIPG - luntitledl I w 1 4  
File Edit Actions Operator Links Instruments Run! Debug Oetions 11 - Translate F1 =Help 

TRACE BUS 1 

I I Read from file I I 

12. Click the mouse on Emulation On until an "x" appears in the check box, 
then select OK to return to the Main Menu. 

13. Select Run!. Bus communications data will appear in the Trace mes- 
sage box, as shown in the following illustration. (Notice the scroll bar 
that has appeared on the right side of the Trace box, allowing you to 
scroll the data.) If you have an oscilloscope connected, the control 
settings on the scope will change to what you specified in the setting 
step. 

11 Translate F1 =Help 11 
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14. If you want to make further changes to the settings, point and 
double-click the mouse on the SETTING step in your procedure. This 
will cause the instrument front panel view to return, allowing you to 
change settings. When you save the settings, the Trace box will show 
the bus communications that transpired, and the scope controls (if a 
scope is connected) will change to the new settings. 

To exit this procedure and return to a normal Main Menu window, first select 
Debug, then select Trace Bus. This will turn the Trace box off. Select Instru- - 
ments, then select Emulate .... Click the mouse on Emulation On until the 
"x" disappears from the check box. Select OK to return top the Main Menu. 
Resize the IPG Main Menu window to normal. 

Test Procedure Number 5 

In this test procedure, we will use an instrument front panel driver to make 
measurements and acquire waveforms. You will need the oscilloscope listed 
in Assumptions, at the beginning of this section, to run this procedure. 
However, you do not need the oscilloscope to create the test procedure 

1. Select New from the Main Menu bar, then select Instruments. Choose 
Select from the Instrument Menu, causing the instrument Select dialog - 
box to appear. Double-click the mouse on 2 4 0 Odso . isd in the list box. 
This will cause the driver file name and the type of port to appear in the 
Drivers: and Port: edit boxes. Enter the primary address (in the range of 
0-29) in the Address: edit box (enter 0 if you do not have the oscillo- 
scope connected), then enter DSO in the TMS Name: edit box. Select 
Add to add the driver to the list box at the top of the dialog box. Select 
OK to complete the operation and return to the Main Menu. 

2. Select Instruments, then View and then DSO. When the instrument 
front panel view appears, select Views, causing the menu list shown in 
the following illustration to appear. 

Step Edit interaction Update! Variables Help 

[ StatusiErrors 
Volts/Div POSITION SecfDiv Trigger Level 

E l  E r I l  
COUPLING 500 

200 m TRIG POSITION [Range 1 - 30) 

1 v 
50m + El 

( 1  C] SO Ohm TERM I I 
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Blinking - 
Cursor 

3. Select AcquireIMeasure, causing the AcquireIMeasure window (shown 
in the following illustration to appear). 

Frequency Peak to Peak 

m i  
Period RMS 

+Width Maximum 

m i  D E I I  
Duty Cycle Minimum 

4. Move the mouse pointer to the Frequency text box and click the mouse. 
This will cause Frequency to become the selected (focused) control, 
and will place a blinking cursor (shown in the following illustration) in the 
Frequency text box. 

Step Edit jnteraction Update! Variables Help Views Misc - 

Frequency Peak to Peak 

Period RMS 

+Width Maximum 

Duty Cycle Minimum 
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5. Select Yariables, causing the menu list shown in the following illustra- 
tion to appear. 

Peak to Peak 

p-Jm1EIl 

m E I 7  n i  
Duty Cycle Minimum 

6. Select current Control ..., causing the dialog box shown in the following 
illustration to appear. 

Edit - 
Control Id: FREQ 

Variable: 1 myfreql 1 
Fl 

- 
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7. Notice that the Control Id: edit control box already contains FREQ. This 
is because we selected Frequency in Step 4, causing it to become the 
current control. Enter myfreq in the Variable: edit box (as shown in the 
above illustration). Select the OK pushbutton to return to the instrument 
front panel view. Select Step, then select Save Selected Measure- 
ments ... causing the dialog box shown in the following illustration to 
appear. 

FREQ 

8. Point and click the mouse on FREQ, then select the Add pushbutton to 
add FREQ to the Selected Control list (as shown in the above illustra- 
tion). Select the OK pushbutton to return to the instrument front panel 
view. 

9. Minimize the instrument front panel view window by clicking the mouse 
on the down arrow in the upper right corner of the window. This will 
create a dso icon at the bottom of the display and return you to the 
Main Menu. Verify that your display matches the following illustration. 

lranslate F1 =Help 

PROCEDURE luntitledl l 1 
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10. Select Operator, select Display Data, then select Wait .... Enter myffeq 
in the Expression: edit box, then select the OK pushbutton to return 
you to the Main Menu. Verify that your display matches the following 
illustration. 

Iranslate F1 =Help 
PROCEDURE [untitled] ( ] 

MEASUREMENT DSO FREQ:mvfres 

11. Double-click the mouse on the dso icon at the bottom of the display to 
return to the instrument front panel view. Select Variables, then select 
Current View ..., to display the dialog box shown in the following illustra- 
tion. 

12. Point and click the mouse on CHI-WFM in the Controlld list box, then 
enter wfm" in the Variable: edit box. Select the Change pushbutton to 
assign the variable wfm- to the CHI-WFM control, as shown in the follow- 
ing illustration. 

13. Select the OK pushbutton to return to the instrument front panel view. 
Select Step, then Save Selected Measurements .... Click the mouse on 
CHI-WFM and select Add to add the CHI-WFM control to the Selected 
Control list. Select OK to return to the instrument front panel display. 
Minimize the instrument front panel window and verify that your Main 
Menu display matches the following illustration. 

Edit - 
Controlld Variable 
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IIEile Edit Actions Operator Links lnstrurnents Bun! Debug Oetions 1) 
Translate F1 =Help 

PROCEDURE TEST5 [ ] 
MEASUREMENT DSO FREQ:myfreq 
DISPLAY myfreq 
MEASUREMENT DSO CHI WFM:wfm- 

14. Select Operator, then Display Wayeforms .... Enter wfm" in the 
Waveform Variable: edit box, then press Add to add the variable to the 
Selected Waveforms list, finally select the OK pushbutton to return to 
the Main Menu. Verify that your display matches the following illustration. 

Translate F1 =Help 
PROCEDURE [untitled] ( ] 
MEASUREMENT DSO FREQ:myfreq 
DISPLAY myfreq 
MEASUREMENT DSO CH1WFM:wfm" 
DISPLAY WAVEFORMS wfm" 

15. Select File, then Save as... . Enter test5 in the Save File As: edit box. 
Select Save to save the program and return to the Main Menu. Verify 
that your display matches the following illustration. 
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16. Select Debug, then Trace Bus. The Trace box will appear. Click the 
mouse on the title bar and drag the Trace box to the lower portion of the 
display area. Select Instruments, then Emulate .... Click the mouse on 
Emulation On until the "x" in the check box disappears (emulation 
turned off). Select OK to return to the Main Menu. To run the procedure, 
select Run!. When the test procedure is running, you will be able to 
display the waveform currently being measured on Channel 1 of the 
oscilloscope, as well as monitoring the GPlB bus communications in the 
Trace box. Refer to the Waveform tutorial in Section 6 for more informa- 
tion on the waveform display and Waveform Menu. 

Editing a Test This section contains tutorials to demonstrate the editing features of IPG. 

Procedure Since the DEMOTEST.PRG procedure already exists on the IPG program 
disks, we will use a copy of it as the base procedure for editing. Before 
beginning the tutorials, create a copy of DEMOTESTPRG named EDIT- 
TESTPRG. Then start IPG, and open the EDITTESTPRG file. 

Editing Overview 

Appendix A, Editing Commands, contains a reference list of all editing com- 
mands, with a definition of each command and its action. The commands 
and their descriptions are also given in the following editing examples. 

To demonstrate editing, we will first add two slightly modified duplicates of 
existing steps to the base procedure. By adding steps that are nearly dupli- 
cates, we can reinforce how to create the steps as well as provide a method 
of differentiating between the original steps and the added ones. We will 
then edit the added steps using the Edit Menu (selected from the Main 
Menu bar). (The Edit Menu, when selected from the Main Menu bar, acts 
only on an entire step.) Next we will edit individual items within a step using 
the Edit Menu selected through the dialog boxes and the keyboard keys. 
(When the Edit Menu is selected in this manner, it allows us to edit individual 
items in the steps.) Finally, we will delete all the steps added during the 
tutorial. 

Multiple Statement Editing 

When some steps are created in a procedure, they create multiple state- 
ment lines (e.g., an ADJUSTMENT Step creates ADJUSTMENT and END-AD- 
JUSTMENT statements, while a FOR-NEXT Step Creates FOR and NEXT 
statements). Once these boundary statements are created, additional sepa- 
rate steps can be created between them. Editing functions in IPG allow 
users to simultaneously execute editing functions on boundary statements 
by highlighting either boundary statement, then selecting the editing com- 
mand. However, separately created statements that are placed between the 
boundary statements are untouched by the editing actions on the boundary 
statements unless Multiple Step Highlighting is used. 
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Multiple Step Highlighting - Multiple step highlighting occurs when you 
highlight one or more procedure steps using the SHIFT or CTRL keys and 
the mouse. 

To highlight a contiguous group of procedure steps, point and click on the 
top step in the group. Then, while holding the SHIFT key down, click the 
mouse on the last step in the group you want to highlight. You can also click 
the mouse on the first step, and, while holding the mouse button, drag the 
mouse to the last step you want to highlight. 

To highlight noncontiguous steps, hold the CTRL key down while you click 
the mouse on each step you want to highlight. 

Adding Steps to a Test Procedure 

When you add a step to an existing test procedure, IPG inserts the step 
immediately above the currently highlighted step. (To highlight a step, point 
and click the mouse on it.) 

We will add a step to the EDITTEST.PRG procedure as follows: 

1. Point and click the mouse on the procedure statement PROMPT S e t  ~3 

G a i n  A d j  t o  m i d r a n g e ,  as shown in the f0 l l0~ ing illustration. 

F1 =Help 

PROCEDURE EDllTEST [ ] 
REMARK Locate R 3  Gain Adi and preset it. el 

 REMARK Initialize instruments for tests to follow. I 11 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R 3  Gain Adj to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 

2. Select Qperator from the Main Menu bar. When the Operator Menu 
appears, select Prompt ..., then select Text .... When the Text Prompt 
dialog box appears, enter Set the Gain Adj control R3 to midrange. in the 
Message: edit box. Leave the Variable: edit box blank. Select the OK 
pushbutton to return to the main menu. The procedure will now have a 
slightly modified duplicate Prompt line above the original Prompt line, as 
shown in the following illustration. 
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SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SETTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HlGH 4 
MEASUREMENT dmm acvreading:gaincal 

END-ADJUSTMENT 
REMARK Initialize test procedure variables. 

We will now add a second step to the procedure: 

1. Point and click the mouse on the procedure statement ADJUSTMENT 
gaincal LOW 3 NOMINAL 3.6 HIGH 4. 

Select Operator from the Main Menu bar. When the Operator Menu 
appears, select Adjustment .... After the Adjustment dialog box appears, 
enter 5 in the Lower Limit: edit box, 5.5 in the Nominal Value: edit box, 
and 6 in the Upper Limit: edit box. Enter calval in the Variable: edit box; 
leave the PassIFail: and Message: edit boxes blank. Select the OK 
pushbutton to return to the Main Menu. The procedure will now have 
new ADJUSTMENT and END-ADJUSTMENT statement lines above the 
original ADJUSTMENT statement line, as shown in the following illustra- 
tion. 

END ADJUSTMENT 

MEASUREMENT dmm acvreading:gaincal 

File Edit Actions Operator Links Instruments Run! Debug Oetions - 
lransiate F l  =Help 
PROMPT Set the Gain Adj control R3 to midrange. 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 
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END-ADJUSTMENT 
REMARK lnitialize test procedure variables. 

CALCULATE index& = 0 - + 



We will now add a MEASUREMENT step between the new ADJUSTMENT and 
END-ADJUSTMENT statements: 

1. Point and click the mouse on the procedure statement MEASUREMENT 
drrun acvreading : gaincal in the original procedure. 

2. Select Edit from the Main Menu bar. When the Edit Menu appears, 
select Copy. After the procedure display returns, point and click on the 
END-ADJUSTMENT statement following the ADJUSTMENT calval LOW 
5 NOMINAL 5.5 HIGH 6 statement. 

3. Select Edit. When the Edit Menu appears, select Paste. After the proce- 
dure display returns, the MEASUREMENT step will be displayed between 
the ADJUSTMENT and END-ADJUSTMENT statements of the added 
Adjustment step, as shown in the following illustration. 

I[ ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 I 11 

Iranslate F1 =Help 

11 MEASUREMENT dmm acvreading:gaincal 
END ADJUSTMENT 

PROMPT Set the Gain Adj control R3 to midrange. 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

IREMARK Initialize test procedure variables. 

- i 
- 
- 

We will now change the variable gaincal to calval, to match the new 
ADJUSTMENT step. TO change the variable: 

1. Point and double-click the mouse on the added MEASUREMENT Step. 
After the Instrument Front Panel view appears, point and click the 
mouse on the Measurement edit box, causing a blinking cursor to 
appear in the box. 

Select Variables. When the Variables Menu appears, select Current 
View. After the dialog box, click on gaincal to select it. Then replace 
gaincal with calval in the Variable edit box and press the Change button 
to change the list entry. Select the OK pushbutton. When the Instrument 
Front Panel view returns, select Step. After the Step Menu appears, 
select Save Selecjed Measurements .... When the Selected Measure- 
ments dialog box appears, acvreading should appear in the Selected 
Control list box. (If it does not appear in the list box, point and click on it 
in the Control List list box and select the Add pushbutton.) Select the 
OK pushbutton to change the variable in the step and return to the Main 
Menu. The added MEASUREMENT Statement will now read MEASUREMENT 
dmm acvreading : calval, as shown in the following illustration. 
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REMARK Adjust R3 Gain Adj to its nominal value. 

al LOW 3 NOMINAL 3.6 HIGH 4 

-- 

Translate F1 =Help 
PROMPT Set the Gain Adj control R3 to midrange. 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvranae 

Editing Steps with the Edit Menu Commands 

- + 
- 
- 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 

When you select Edit from the Main Menu bar, the Edit Menu items act only 
on an entire highlighted step. When a procedure is displayed on-screen, at 
least one procedure line is always highlighted. 

- + 

If no previous editing action has taken place when you select Edit from the 
Main Menu bar, the Edit Menu appears with all items active, except Paste. 
(When a menu item is not active, it will be displayed in gray.) Paste is active 
only after a Cub or Copy has been used to place test steps on the clipboard. 

Editing a Single Statement Procedure Step - The first added 
PROMPT procedure step involved adding a single statement step. To edit that 
step from the Main Menu, do the following: 

1. Point and click the mouse on the procedure statement PROMPT Set 
the Gain Adj control R3 to midrange. 

2. Select Edit from the Main Menu bar. When the Edit Menu appears, 
select Cuf. After the procedure display returns, the PROMPT step will 
have been deleted. 

3. Select Edit again. When the Edit Menu appears, select Undo. After the 
procedure display returns, the deleted PROMPT step will have been 
returned to its original position in the procedure. 
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4. Select Edit again. When the Edit Menu appears, select Copy. After the 
procedure display returns, select Edit. When the Edit Menu appears, 
notice that the Paste menu item is no longer displayed in gray (it is now 
active). Select Paste. When the procedure display returns, a duplicate 
step will have been copied into the procedure, as shown in the following 
illustration. 

REMARK Initialize instruments for tests to follow. 

Translate - F1 =Help 
PROCEDURE EDllTEST [ ] 
REMARK Locate R3 Gain Adj and preset it. 

PROMPT PICTURE TEKPIC.BMP 

5. Point and click the mouse on the original PROMPT statement: PROMPT 
Set R3 Gain Adj to midrange. 

- 4 
- 

SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SETTING drnm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT drnrn acvreading:calval 
END-ADJUSTMENT 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

L A C A w C L d r h l T  -.--I 

6. Select Edit from the Main Menu bar. When the Edit Menu appears, 
select Cut. After the procedure display returns, the original PROMPT 
statement will have been deleted. 

- + 

7. Point and click the mouse on one of the added PROMPT Set the 
Gain Adj control R3 to midrange statements. 

8. Select Edit. When the Edit Menu appears, select Clear. After the proce- 
dure display appears, one copy of the added PROMPT Statements will 
have been deleted. (Clear deletes a step, but does not change the 
contents of the CutIPastelCopy clipboard.) 

9. Point and click the mouse on the procedure statement PROMPT PIC- 
TURE TEKPIC.BMP. 
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10. Select Edit. When the Edit Menu appears, select Paste. After the proce- 
dure display returns, notice that the PROMPT line deleted in Step 6 has 
returned, as shown in the following illustration. This verifies that Clear 
deletes a step, without changing what was on the clipboard before 
Clear was selected. 

File Edit Adions Operator Links instruments Run! Debug Ogtions - 
Translate F1 =Help 

PROCEDURE EDllTEST I ] 
REMARK Locate R3 Gain Adi and Dreset it. 

PROMPT Set the Gain Adj control R3 to midrange. 
REMARK Initialize instruments for tests to follow. 

SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT dmm acvreading:calval 
END-ADJUSTMENT 
ADJUSTMENT ~ a i n c a l  LOW 3 NOMINAL 3.6 HlGH 4 
MEASUREMENT dmm acvreading:gaincal 

Editing a Multiple Statement Procedure Step - We have already 
added a second ADJUSTMENT procedure Step containing ADJUSTMENT and 
END-ADJUSTMENT statements. Editing this step is similar to editing a single 
statement step, with the following exceptions: 

rn When you select any one of the statements in a multiple statement step, 
and then select an edit action (Undo, Cut, Copy, Paste, or Clear), that 
action occurs for all the statements in the step, but not for separate 
steps between the boundary statements. 

rn The separate steps created between the boundary statements of a 
multiple statement step can be edited in one of two ways: 

a. They can be edited separately like any other single or multiple 
statement step. 

b. They can be edited at the same time as the multiple statement step 
by using multiple step highlighting. 
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TO edit the ADJUSTMENT step, perform the following: 

1. Point and click the mouse on the added ADJUSTMENT statement. 

2. Select Edit. When the Edit Menu appears, select Cut. After the proce- 
dure display returns, YOU will notice that the ADJUSTMENT and END-AD- 
JUSTMENT Statements have been deleted, but the MEASUREMENT 
statement remains, as shown in the following illustration. 

Iranslate F1 =Help 
PROCEDURE EDllTEST I 1 
REMARK Locate R3 ~ a i n - d d j  and preset it. 

PROMPT Set R3 Gain Adj to midrange. 
PROMPT PICTURE TEKPIC.BMP 
PROMPT Set the Gain Adj control R3 to midrange. 

REMARK lnitialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

ADJUSTMENT naincal LOW 3 NOMINAL 3.6 HlGH 4 I 
MEASUREMENT dmrn acvreading:gaincal 

END-ADJUSTMENT 
REMARK lnitialize test orocedure variables. 

3. Select Edit. When the Edit Menu appears, select Undo. After the proce- 
dure display returns, the ADJUSTMENT and END-ADJUSTMENT State- 
ments will have returned to the procedure, as shown in the following 
illustration. 

END-ADJUSTMENT 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HlGH 4 

MEASUREMENT dmm acvreading:gaincal 
END ADJUSTMENT 

Iranslate F1 =Help 

~ R E M A ~ K  Initialize test procedure variables. + 

PROMPT Set R3 Gain Adj to midrange. 
PROMPT PICTURE TEKPIC.BMP 
PROMPT Set the Gain Adj control R3 to midrange. 

REMARK lnitialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvranae 

4. Point and click the mouse on the added ADJUSTMENT statement to 
highlight it. Move the mouse cursor to the MEASUREMENT statement. 
While holding the SHIFT key down, click and drag the mouse to high- 
light the MEASUREMENT and END-ADJUSTMENT statements. 

- t 
- 
- 
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5. Select Edit. When the Edit Menu appears, select Copy. After the proce- 
dure display returns, select Edit again. When the Edit Menu appears, 
select paste. When the procedure display returns, the ADJUSTMENT, the 
END-ADJUSTMENT, and the MEASUREMENT statements will have been 
copied into the procedure, as shown in the following illustration. 

Iranslate 
PROMPT PICTURE TEKPIC.BMP 
PROMPT Set the Gain Adj control R3 to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT dmm acvreadina:calval 
END ADJUSTMENT 

MEASUREMENT dmm acvreading:calval 

Editing Items in a Dialog Box 

, 

When you use the Edit Menu items from a dialog box, you have the means 
to edit the individual items that make up a step. While you are in a dialog 
box, the items can also be edited by using the BACKSPACE, DEL, and 
alphanumeric/symbol keys. 

Dialog Box Editing Using Edit Menu Commands - To edit the added 
PROMPT statement with the dialog box Edit Menu, perform the following: 

END-ADJUSTMENT 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HlGH 4 

MEASUREMENT dmm acvreading:gaincal 

1. Double-click the mouse on the procedure statement PROMPT Set the 
Gain Adj control R3 to midrange. The Text Prompt dialog box 
will appear. 

- + 

2. Point the mouse to the beginning of the text line in the Message: edit 
control box. Then click and drag the mouse to the right end of the 
message (including the period) and release the mouse button. This will 
highlight the message. 

3. Select Edit from the dialog box menu bar. After the Edit Menu appears, 
select Cul. When the dialog box returns, the message will be deleted. 

4. Select Edit from the dialog box menu bar. After the Edit Menu appears, 
select Undo. When the dialog box returns, the message will have re- 
turned to its original position. 

5. Point the mouse to the beginning of the text Gain Adj control, then 
click and drag the mouse to the beginning of the word R3 (include the 
space after the word control) and release the mouse button. This will 
highlight the selected part of the message. 

TekTMS Interactive Procedure Generator User Manual  3-4 1 



6. Select Edit. When the Edit Menu appears, select Copy. After the dialog 
box returns, point and click the mouse to the beginning of the word to, 
locating a blinking cursor at that point. 

7. Select Edit. After the Edit Menu appears, select Paste. When the dialog 
box returns, the copied text will appear both before and after the word 
~ 3 ,  as shown in the following illustration. 

8. Point the mouse to the beginning of the first appearance of the text 
Gain A d j  control, then click and drag the mouse to the beginning of 
the word ~3 (include the space after the word control) and release the 
mouse button. This will highlight the selected part of the message. 

Edit Label Comment - 

Message: 

9. Select Edit, then select Cut. When the dialog box returns, the high- 
lighted text will be deleted. 

10. Point the mouse to the beginning of the word ~ 3 ,  then click and drag 
the mouse to the beginning of the word to (including the space after the 
word control) and release the mouse button. This will highlight the 
selected text. 

- + 
- 

- + 

Set the Gain Adj control R3 Gain Adj control 10 midrange. 

11. Select Edit, then select Clear. When the dialog box returns, the pre- 
viously highlighted text will be deleted. 

Variable: -1 
+ I  1 

12. Point and click on the beginning of the word to, if the cursor is not 
already at that point. Select Edit, then select Paste. When the dialog 
box returns, the text highlighted in Step 8 and cut in Step 9 will appear 
in the message. (This is the case because the Clear in Step 11 did not 
change the contents of the Cu!/Paste/Copy clipboard. 

13. Select the OK pushbutton to change the step and return to the proce- 
dure display. Verify that your display matches the following illustration. 
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Using the Keyboard Keys to Edit a Dialog Box -We will use the 
added PROMPT statement In this demonstration of keyboard key editing in a 
dialog box. To edit the dialog box associated with the added PROMPT state- 
ment, perform the following: 

1. Point and double-click the mouse on the added statement PROMPT Set 
the Gain A d j  control to midrange. After the second click of the 
mouse button, the entire test procedure will be displayed in gray and the 
dialog box used to create the PROMPT step will appear. 

2. Point and click the mouse at the beginning of the word the. This will 
cause a blinking cursor to appear. 

3. Press the DEL key enough times to delete all characters through the 
word control and the space following. Each time you press the DEL 
key, a character or space will be removed from the message text. 

4. Enter R3 and press the SPACE BAR. The word ~3 will now appear 
between the words Set and to. 

5. Select the OK pushbutton. When the procedure display returns, the 
added PROMPT statement will now read PROMPT Set R3 to 
midrange, as shown in the following illustration. 

PROMPT PICTURE TEK~C.BMP - 
REMARK Initialize instruments for tests to follow. 

rranslate F1 =Help 
PROCEDURE EDllTEST [ ] 
REMARK Locate R3 Gain Adj and preset it. 

PROMPT Set R3 Gain Adi to midranae. 

Deleting the Added Steps from the Test Procedure 

- t 
- 

. 

We will now delete all the statements added during the previous editing 
demonstrations. To delete these statements: 

SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SETTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT dmm acvreading:calval 
END-ADJUSTMENT 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT dmm acvreading:calval 

1. Point and click the mouse on the statement PROMPT Set ~3 to 
midrange to highlight it. While holding the CTRL key down, point and 
click the mouse on all other statements that we added. (Besides the 
added PROMPT, There should be one ADJUSTMENT calval LOW 5 

NOMINAL 5 . 6  HIGH 6 ~ ~ ~ ~ ~ W O M E A S U R E M E N T  dmm acvread- 
ing : calval steps to delete.) 
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2. Select Edit from the Main Menu bar. When the Edit Menu appears, 
select Clear. After the procedure display returns, the statements will be 
deleted. 

Editing a Step with an Instrument Front Panel View 

Opening an instrument front panel view for editing is no different from open- 
ing any other step for editing. Simply double-click the mouse on the step 
you wish to edit. When the front panel view appears, it is opened as a win- 
dow rather than a dialog box. Although the down arrow (minimize arrow) in 
the upper right corner of the window is not displayed in gray, it is disabled 
while the front panel view is in the editing mode. (this terminates when a 
Step menu item is selected). The up arrow (maximize arrow) functions - 
normally. 

Adding a Label to a Step 

Labels are required on steps where program flow control is transferred with 
a GOTO or GOSUB step created through the Actions Menu. In this demonstra- 
tion, we will add a label to the ADJUSTMENT step in the original procedure. 
There are two ways to add labels to test steps. 

1. To use the first way to add the label, perform the following: 

a. Point and double-click the mouse on the procedure statement 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4. The 
dialog box used to create the step will appear. 

b. Select label. When the Label dialog box appears, enter adjl in the 
edit control box. 

c. Select the OK pushbutton. When the Adjustment dialog box returns, 
select its OK pushbutton to add the label and return to the proce- 
dure display. Notice that the label was placed in the display above 
the ADJUSTMENT statement, as shown in the following illustration. 

Translate 
PROCEDURE EDITFEST I 1 
REMARK Locate R3 ~ a i n - ~ d j  and preset it. 

PROMPT Set R3 Gain Adj to midrange. 
PROMPT PICTURE TEKPIC.BMP 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 
SElTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 
I 

ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 I- 
ll MEASUREMENT dmm acvreading:calval 

END-ADJUSTMENT 
ADJUSTMENT calval LOW 5 NOMINAL 5.5 HlGH 6 

MEASUREMENT drnm acvreading:calval 
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2. To use the second way to add the label, perform the following: 

a. Select (highlight) the test step you wish to label. 

b. Choose Edit and Add Label from the menu. 

c. The label dialog box appears just as in 1 b above. Continue on with 
Step 1 c. 

Adding a Comment to a Step 

A comment added to a procedure step does not appear on the displayed 
outline. Comments appear only on the printed listing in FULL form. In this 
demonstration, we will add a comment to the ADJUSTMENT step in the 
original procedure. 

To add the comment, perform the following: 

1. Point and double-click the mouse on the procedure statement ADJUST- 
MENT gaincal LOW 3 NOMINAL 3 . 6  HIGH 4. The dialog box used 
to create the step appears. 

2. Select Comment. When the Comment dialog box appears, enter This is 
a comment. in the edit box. 

3. Select the OK pushbutton. When the Adjustment dialog box returns, 
select its pushbutton to add the comment and return to the procedure 
display. Notice that the comment does not appear in the display for the 
ADJUSTMENT statement. 
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Menus 





Menus 

This section contains a complete reference of the IPG menus. It describes 
and illustrates each menu, menu item, and dialog box in IPG. The descrip- 
tions are arranged as follows: 

Menu Map 
Common Dialog Boxes 
Main Menu 
File Menu 
Edit Menu 
Actions Menu 
Operator Menu 
Links Menu 
lnstruments Menu 
Run Menu 
Debug Menu 
Options Menu 
Translate Menu 
Help Menu 
lnstrument Front Panel Menu 
Waveform Menu 

Each menu description progresses completely through the menu items and 
dialog boxes for that menu before the next menu description begins. 

You can access the Instrument Front Panel Menu by selecting Instruments 
from the Main Menu, and then selecting View from the menu list that ap- 
pears. Highlight an instrument name and that front panel will be displayed. 

A waveform display and the Waveform Menu appear when an instrument 
front panel view has the control type Waveform Display and you select its 
icon, or when you run a test procedure containing a waveform display step. 

You can access the Help Menu by pressing the F1 keyboard key when you 
have a dialog box opened from the Actions or Operator Menus. 
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Menu Map 

File 

Save as 
Prlnt 
Exit 

Following is a menu map of IPG. The menu bar is shown highlighted across 
the top of the map. The submenu items are listed vertically below the corre- 
sponding submenu titles. 

f dit 

Remove = 
lnstrument Name = 

I Parameters I 
Transfer Data 
File I10 
On Event 
On Abort 
Delay 
Remark En Include 

L Open ASCII Log File 
Open CSV Log File 
Open Sequential File 
Print ASCII Log File 
Print CSBLoq File Input 
Close I stop test I I I I I nplptp Fib 1 --.-.- . ..- 

1-1 I I I I Rewind File 

I,,, I 1 4 Text 1 
I I I lnstrument Name 

I '  1 Linear I 
User Defined I - 

I TekTMS Procedure 

External Procedure 

4-2 Menus 

I 
I I I I I 

Translate 
Start RTG, 
Start IDG 

o w~ans 
Remarks Only 
Globals 

Operator 
Adjustment 
Dlsplay XY Plot 

tinks I In&uments I Run! I Debug 
Excel I-- Read Select Debug 

Send View Restart 
Dlsplay Waveforms Close Emulate Contlnue 
Dlsplay Data Walt VXI Controller 4 Tektronlx VXI I Step 
Prompt Contlnue 

ExamlnelChange 

Plcture 
Set Breakpolnt 
Remove 
Breakpolnt 
Remove All 
Breakpoints 
Trace Bus 



Common Dialog Box IPG contains common Label and Comment dialog boxes that are accessed 
from more than one menu. These dialog boxes are described here and 
referenced where they appear in the menu descriptions. 

Label Dialog Box 

You can select the Label dialog box from any menu or dialog box where a 
Label menu item appears in the menu bar by pointing and clicking on the - 
menu item with the mouse, or by pressing and holding the ALT keyboard 
key while pressing the L key. The Label dialog box allows you to add a label 
to a highlighted test procedure step. 

Edit - 

I I 

a Edit - You can select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the E key. Edit allows you to edit the dialog box data. Refer to the Edit 
Menu description for further information on the menu and its use. 

This dialog box contains an edit box for data and two pushbuttons: 

a An untitled edit box where you enter up to 32 characters as a label for a 
highlighted test procedure step. 

a OK - Select this pushbutton to complete the Label creation. OK lets 
this label be put in the test procedure step, but it does not have any 
interaction with the step you are labeling. 

a Cancel - Select this pushbutton if you wish to cancel the Label dialog. 
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Comment Dialog Box 

You can select the Comment dialog box from any menu or dialog box where 
Comment appears in the menu bar by pointing and clicking on the com- - 
mand with the mouse, or by pressing and holding the ALT keyboard key 
while pressing the C key. The Comment dialog box allows you to add a 
comment to a highlighted test procedure step. 

Comments do not appear in the test procedure outline display. You can read 
comments on-screen only by double-clicking the mouse on a test procedure 
step that allows comments (such as an ADJUSTMENT step), then selecting 
Comment from the dialog box that will appear. You can also read comments - 
in a Full printout of the test procedure. For further information on a Full 
printout, refer to the description of the Print command in the File Menu 
description. 

Edit - 

rn Edit - You can select this command by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the E key. Edit allows you to edit the dialog box data. Refer to the Edit 
Menu description for further information on the menu and its use. 

This dialog box contains an edit box and two pushbuttons: 

rn An untitled edit box where you enter up to 32,000 characters as a com- 
ment for a highlighted test procedure step. 

rn OK - Select this pushbutton to complete the Comment creation. OK 
allows the comment to be put in the test procedure step, but it does not 
have any interaction with the step you are adding the comment to. 

rn Cancel - Select this pushbutton if you wish to cancel the Comment 
dialog. 
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Main Menu The following Main Menu bar appears whenever you invoke IPG from Win- 
dows. It lists the available IPG menus. You can select any of these menus 
(except the Help Menu), by pointing and clicking with the mouse on the 
desired menu name, or by pressing and holding the ALT keyboard key while 
pressing the key corresponding to the underlined letter in the menu name. 
You can select the Help Menu by pressing the F1 keyboard key whenever 
you have a dialog box opened from the Operator or Actions Menus.) 
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File Menu The following File Menu appears whenever you select File from the Main 
Menu bar by pointing and clicking with the mouse, or by pressing and 
holding the ALT keyboard key while pressing the F key. This menu gives you 
access to the file creation, loading, saving, and exiting facilities of IPG. 

Open ... - 
Save - 
Save as ... 

Print ... - 
Exit - 

New - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the N keyboard key. New deletes all existing step data and instrument 
configuration data, removes the current file name from the title bar and 
replaces it with the message " T ~ ~ T M s  (untitled) ", redisplays the Main 
Menu, and starts a new template for the test procedure file. If choosing New 
will destroy existing data, a message box will appear asking you to verify the 
requested action by selecting one of the following message box items: 

Yes - Select this pushbutton to save the currently displayed test proce- 
dure. If you select this pushbutton when the file has not been previously 
saved, IPG executes a Save as... so that you can name the file. 

No - Select this pushbutton to exit the current procedure without 
saving it (if the procedure had not previously been saved), or to aban- 
don the current editing session (if it was a previously saved procedure) 

Cancel - Select this pushbutton to cancel the action and return to the 
currently displayed procedure. 
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Open - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the 0 keyboard key. Qpen ... allows you to load a different test proce- 
dure file. If you already have a file loaded, and you have changed that file, 
when you select Open ... a message box will appear asking you whether you 
wish to save the file that is currently loaded. 

If there is no Edit or Run password associated with the file that you have 
selected to be opened, the following dialog box will appear (after a currently 
loaded file, if any, has been saved or abandoned). If the file was originally 
saved with an Edit or Run password, you will be prompted for the pass- 
word before Qpen ... loads the file. If you enter an Edit password, you will 
be able to either Edit Or Run the file. If you enter a Run password, you will 
be able to Run the file, but you will not be able to Edit it. For more informa- 
tion about the Edit and Run passwords, refer to the following Save as ... 
description. 

IPG provides the following dialog box items for user interaction: 

A current directory pathname beside a list box containing file names you 
can select, or disk drives and directories you can select to display other 
file names. 

File Name: - An edit box where you either keyboard enter the file 
name desired, or where the file name will appear if you point and click 
with the mouse on a file name listed in the previously described list box. 

Open - Select this pushbutton to complete the Qpen ... action. 

Cancel - Select this pushbutton if you wish to cancel the Open .... 
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Save - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the S keyboard key. Save saves the displayed test procedure in the 
current file. If the file is untitled, a Save As dialog box will appear for user 
interaction. 

Save as 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the A keyboard key. Save as... opens the following dialog box, allowing 
you to save a test procedure file that has not been previously saved, save 
another file version of the current test procedure file (make a copy of the file 
under a different name), and add or change an EDIT Or RUN password for a 
previously saved file. 

Edit Key: 

Run Key: 

1 Cancel  I 

IPG provides the following dialog box items for user interaction: 

m Save File as: -An edit box where you enter the file named under 
which you want the current test procedure to be saved. If the current 
procedure was previously saved, its previous name appears here. 

The current directory pathname (in the upper right hand corner of the 
dialog box). 

Edit Key: - An edit box where you enter an Edit password for a 
specified file. After you have entered this password, a user will be 
prompted to enter that password any time the file is selected to be 
opened. If the file has both Edit and Run passwords, entering the Edit 
password will suffice for both functions. 

Run Key: - An edit box where you enter a Run password for a speci- 
fied file. After you have entered this password, a user will be prompted 
to enter that password any time the file is selected to be opened. Enter- 
ing the Run password will allow the user to Run the file, but not to Edit 
it. 

Save - Select this pushbutton to complete the Save as... action. 

Cancel - Select this pushbutton if you wish to cancel the Save as .... 
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Print - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the P keyboard key. Print ... opens the following dialog box, allowing you 
to select the part of a test procedure you want to print, then sending that 
test procedure to the printer configured for use by Windows. 

Print 

0 Outline 

0 Full  

Print to file 

File: 

I 

IPG provides the following dialog box items for user interaction: 

m Print -The group name for the Outline and Full radiobuttons. 

Outline - Selecting this radiobutton prints the test procedure as it 
appears on the screen. The screen displays up to 75 characters per 
test step, with various rules of truncation. For example, if the display 
is pure text, the screen replaces the last three characters (of the 75) 
with an ellipsis (.  . .). If the display is an expression, the screen 
always prints the variable name and the equal symbol (=), then 
those complete terms or operators up to 72 characters, followed by 
an ellipsis (.  . .). The screen display does not print comments. 

Full - Selecting this radiobutton prints the entire test procedure 
outline as generated by IPG, including full Remarks, Comments, and 
step lines. 

Print to File - Selecting this check box allows the test procedure to be 
printed into an ASCII format file. 

File: - An edit box where you enter the path name for the file you want 
to print to (when using Print to File). The edit box automatically scrolls 
horizontally and accepts up to 128 characters. 

OK - Select this pushbutton to complete the Print ... action. 

Cancel - Select this pushbutton if you wish to cancel the Print ... 

-- 
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Exit 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the X keyboard key. Exit ends the current test procedure generation 
session and closes the IPG window. If the window contains a test procedure 
that was changed since the last Save, a message box will appear asking 
you to verify whether the procedure should be saved or abandoned. The 
message box contains the following choices: 

Yes - Select this pushbutton to save the currently displayed test proce- 
dure. If you select this pushbutton when the file has not been previously 
saved, IPG executes a Save as... . 

= No - Select this pushbutton to exit IPG without saving the current 
procedure (if the procedure had not previously been saved). 

Cancel - Select this pushbutton to abort the Exit action and return to 
the currently displayed procedure. 
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Edit Menu The Edit Menu items appear whenever you point and click the mouse on the 
Edit menu item from the Menu Bar of the Main Menu or from a dialog box. - 

The Edit Menu also will appear if you press and hold the ALT keyboard key 
while pressing the E keyboard key when you are currently in the Main Menu, 
or in a dialog box containing the Edit command. When you select the Edit 
Menu, you gain access to the edit functions of IPG. 

The menu items in the Edit Menu are shown in black when enabled or 
shown in gray when disabled, reflecting the capability of IPG to perform a 
specific edit function. The menu items may display differently for a dialog 
box than for a procedure outline. For example, when IPG displays a dialog 
box, the Paste item is shown in gray if nothing is stored on the clipboard. 
The Cut, Copy, and Clear items are enabled (shown in black) only when 
you have selected a step. Also, IPG may not display a Clear item in the Edit 
Menu for a dialog box. 

The Edit Menu items perform their actions on whatever test procedure steps 
are highlighted. To highlight a single step, point and click the mouse on that 
step. To highlight multiple contiguous steps, press and hold the SHIFT 
keyboard key while pointing and clicking the mouse on the first and last 
steps of the contiguous group that you want to highlight. To highlight multi- 
ple noncontiguous steps, press and hold the CTRL keyboard key while 
pointing and clicking the mouse on each step you want to highlight. 

Undo - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the U keyboard key. Undo reverses the edit action of the most recent 
Edit Menu selection. If you repeatedly select Undo, IPG switches between 
the current edit state and the previous edit state. (For example, if you have 
inserted a word, the first Undo removes it, while the second Undo replaces 
it.) Undo is enabled only when a reversible edit action exists. 

-- -- 

TekTMS Interactive Procedure Generator User Manual 



Cut 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the T keyboard key. Cut copies highlighted text to the clipboard, and 
deletes it from the procedure. When you highlight a single action statement 
of a multiple statement test procedure action (such as one of the IF, THEN, 
or ELSE statements from an IF-THEN-ELSE construct), Cut copies all the 
action statements of the construct to the clipboard, then deletes the state- 
ments from the procedure. However, text added between the action state- 
ments is neither copied nor deleted. If you wish to delete the text, you must 
highlight and delete it separately. 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the C keyboard key. Copy copies highlighted text to the clipboard 
without deleting it from the procedure. When you highlight a single state- 
ment of a multiple statement test procedure action (such as one of the IF, 
THEN, or ELSE statements from an IF-THEN-ELSE construct), Copy copies 
all action statements of the construct to the clipboard. However, text added 
between the action lines is not copied. If you wish to copy the text between 
the action lines, you must highlight and copy it separately. 

Paste - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the P keyboard key. Paste copies the contents of the clipboard to the 
test procedure ahead of the currently highlighted line. 

Clear 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the I keyboard key. Clear deletes a highlighted item, but does change 
the contents of the clipboard. 

Enable Steps - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the E keyboard key. Enable Steps reverses the action of the following 
Disable Steps item. - 

Disable Steps - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the D keyboard key. Disable Steps allows you to leave a step in a 
procedure, but to disable it so that the procedure will not act upon it when 
run. 
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NOTE 

If you use the Enable Selected Steps or Disable Selected Steps 
items on a portion of a control structure (such as an IF-THEN-ELSE, 
or a WHILE-DO), all portions of the control structure are affected 
(such as the END I F  statement). However; any steps that have 
been added within that structure will not be affected. For example, 
if your procedure contains a disabled IF-THEN-ELSE structure with 
CALCULATE steps between the I F  and THEN statements and 
between the THEN and ELSE statements of the control structure, 
the CALCULATE Steps will remain enabled (unless you disable them 
separately. Also, you cannot use the Disable Selected Steps item 
on either the PROCEDURE Or END-PROCEDURE Statements in a test 
procedure. 

Label 

The Label menu item lets you Add a label to the selected test step or R e  
move a label from the selected test step. Label is used with the GOT0 and 
GOSUB test steps. A labeled step that is referenced by a GOT0 or GOSUB 
step, will be the next step to execute when a GOT0 or GOSUB step is 
executed. 

,le Steps 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = date$0tU "ttime$O 
CALCULATE report$ = testdatetime$tchr$(l3)+chr$(lO) 

REMARK Test the frequency response from 10 Hz to 100 kHz. 
FORfreq = 10 TO 1.OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to "freq$". 
P A 1  PI 11 A T C  - o t w @ f + r n m ~  
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Label provides the following choices: 

Add ... - Selecting Add will bring up the Label dialog, as shown below, 
and let you assign a label to the selected test step. Most steps have a 
label menu item in the step dialog. The Label Add menu item uses the 
same dialog as the test step dialog Label menu item. If the step already 
has a label, that label is displayed in the Label dialog edit box and can 
be modified. 

After entering a label, select OK to assign it to the selected test step. If 
the text you entered is not a valid label or is not unique, an error mes- 
sage is displayed and the label is not accepted. If the label is valid, the 
Label dialog closes. Select Cancel to discard any entry and exit the 
Label dialog. 

Edit - 

I I 

Remove - This menu item removes a label from the selected test step. 
If the selected step does not have a label, then there is no change to the 
step. 

Search and Replace scan the current test procedure steps for a given text 
string or instrument name. When searching for a string you may either 
replace it, change it, or search for the next occurrence of the string. When 
searching for an instrument name you may either replace all occurrences or 
search for the next step with a matching instrument name. The replace 
option will check the resulting string for errors before completing a text 
replacement. Search checks for any occurrence of the search string in a 
user defined string in a test procedure step. SearchIReplace provides Text 
and Instrument Name choices: 

Text - The Text option lets you search through test procedure steps for a 
specific text string. Only the user entered text is scanned in each test step. 
Keywords such as Calculate, Remark, For, While, etc., are not part of the 
text search. User defined variable names, string constants, global variables, 
and other user specified strings are scanned for a match. When a match is 
found, the step dialog for the step type where the string was found is se- 
lected and the found string is highlighted. Searching for a string is similar to 
editing (double clicking) a test step in the outline view of the test procedure 
and having the search text highlighted. 
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ONTINUOUS AMPLITUDE OUTPUT 

= testdatetirneStchrS[13]tchr$[10] 

When searching for text, the following dialog is displayed. This dialog gives 
you several options. You may specify the text to search and the text to 
replace. You may select matching on upper and lower case letters in 
searches. You may also select verify for Replace All. The SearchIReplace 
dialog will remain on screen until you close it using the system menu Close 
option, select New from the TekTMSIIPG File menu, or close TekTMSIIPG. 

The SearchIReplace text menu items are as follows: 

Search For edit box is used for entry of the search string. This text 
string can contain any printable ASCll characters. 

Replace With edit box is used for entry of the replacement string. This 
text string can contain any printable ASCll characters. Care should be 
taken when specifying a replacement string. All the new strings created 
with the replacement string will be checked for proper syntax for each 
step type being modified. This edit box is disabled until you have en- 
tered text into the Search For edit box. 

Match Case option will force the search to match the character case of 
the search string. All characters must match in upper and lower case if 
this option is used. This option is disabled until you enter text in the 
Search For edit box. 
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Verify allows you to accept or reject a modified text string before com- 
pleting the text replacement during Replace All. This choice is disabled 
until you enter text into the Replace With edit box. 

rn Find next searches for the text string specified in the Search For edit 
box, starting at the currently selected test step. If a string was last found 
in the current test step then the search starts at the character following 
where the last string was found or just after its replacement string. 

In the following example, the string R3 is entered into the Search For 
edit box and the Find next button is pressed. The test procedure is 
searched, starting at the beginning of the procedure. The first occur- 
rence of the string R3 is found in the text of a Remark step. When the 
string is found, the Remark step dialog becomes active and the found 
text is highlighted. 

To continue searching for the next occurrence of R3 you must close the 
Remark step dialog. The Find next button is disabled while the step 
dialog is active. Once you have found a string, you may modify it and 
save the change or cancel and end the step dialog. 

TekTMSIIPG - DEMOTEST.PRG . A 
File Edit Actions Operator Links instruments Bun! Debug Oetions Iranslate - 

Replace With: R6 

Match case Verify 

Replace lets you replace the selected text with the Replace With text. 
The Replace button is enabled when a text string is found. 

Replace All will bring up the following dialog box. This dialog allows you 
the option of changing all the matching text in the test program, or 
limiting the number of replacements. 
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@ All C$ztzrzsjt:: 

o some T I  

The Replace All dialog selections are as follows: 

8 All is the default option. If you push the OK button now, all user 
entered text in the test procedure that matches the Search For 
string will be replaced with the Replace With string. 

8 Some lets you choose the number of replacements you wish done. 
When Some is chosen, the Change edit box is enabled and you 
can enter the number of replacements. 

8 Change: box is where you enter the number of replacements to 
make when the Replace All button is pressed. 

8 OK closes the dialog box and the requested Replace All actions are 
performed. The Replace All button in the SearchIReplace dialog is 
change to read Cancel Change. If the Cancel Change button is 
pressed, the current Replace All operation is terminated. When the 
Replace All is complete, a message box displays the number of 
replacements made. 

8 Cancel exits the Replace All request without doing a search and 
replace. The Replace All dialog is closed. 

Instrument Name - You may search instrument steps for a selected instru- 
ment name. Only the Setting, Measurement, and Transfer Data steps using 
an instrument are searched. 

to follow. 
ONTINUOUS AMPLITUDE OUTPUT 

Disable Steps 

CALCULATE index& = 0 
CALCULATE testdatetimes = datesot" "+tirneSfl 
CALCULATE reports = testdatetimeS+chrS[13]+chrS[l O] 

REMARK Test the frequency response from 10 Hz to 100 kHz. 
FOR freq = 10 TO l.OEt5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to "IreqS". 
CALCULATE freqS = strS[freq] 
SElTING lg FREQUENCY:freqS 

REMARK Delav for DMM ranae chanae. 

TekTMS Interactive Procedure Generator User Manual 4-1 7 



When you select SearchIReplace lnstrument Name from the menu the 
following dialog box appears. This dialog contains a list of the instruments 
selected for this test procedure. You may select one of these instruments 
and either search for the next instance of the name, or you may replace all 
instances of the name in the test procedure. This Replace All function is 
useful if you are replacing one instrument with another one that is functional- 
ly equivalent. 

Instruments 

This list box shows the instruments selected for the current test procedure. 
When you select one of the listed instruments the selected instrument name 
is placed in the New name edit box and the Replace All and Search but- 
tons are enabled. 

rn New name: edit box contains the new name for the selected instrument 
if a Replace All operation is requested. This name must be a unique 
valid instrument name or you will get an error message and the Replace 
All operation will stop. 

rn Replace All causes all instrument names, in test steps, that match the 
selected instrument name to be replaced with the instrument name in 
the New name edit box. The name in the New name edit box must be a 
unique valid instrument name or you will get an error message and the 
Replace All operation will stop. The Search/Replace lnstrument Name 
dialog is closed when the replacement of instrument names completes. 
The instrument name in the lnstrument Selection and lnstrument View is 
also changed by Replace All. 

Search selects the next step containing an instrument name matching 
the name selected in the Instruments list box. The SearchIReplace 
lnstrument Name dialog is closed when the search completes. 

rn Cancel closes the SearchIReplace lnstrument Name dialog 
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Actions Menu The Actions Menu items appear whenever you select Actions from the Main 
Menu, or when you press and hold the ALT keyboard key while pressing the 
A key while in the Main Menu. Actions allows the user to create action-type 
test procedure steps, which are self-defined by the items in the Actions 
menu. 

Calculate - 

Dim~nsion ... 
Pulse Parameters ... 
Transfer Data b 

File I/O ' 
On Event ... 
On Abort ... 
Delay ... - 
Remark ... 
Include b 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the C keyboard key. Calculate ... opens the following dialog box, allow- 
ing you to define an expression to be calculated, and to specify the variable 
name where you wish the resultant calculation to be stored. 

If Then Else ... 
While Do ... 
- For Next b 
Exit Fo! Next ... 
Call procedure b 
Exit Procedure ... 
- Stop Test ... 
Gosub ... 
Return ... 
Goto ... 

Edit Label Comment - 

Veris ble: Expression: 

I I I== 

NOTE 

If you press F1 while the Calculate dialog box is open, a Help 
message will appear that lists the functions that are available in 
IPG, as well as the types of expressions allowed. Functions and 
Expressions are also defined in Section 2, Getting Started. 

Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 
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Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. label allows you to add labels to a test procedure step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to a test procedure 
step. Refer to the Common Dialog Boxes description (given at the begin- 
ning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Variable: -An edit box where you enter the test procedure variable 
name where you wish the calculation result to be stored. The variable 
data type that you enter must match the data type of the expression, or 
an error message will appear listing the available Data Type Suffixes. 
(Data Type Suffixes are also defined in Section 2, Getting Started.) This 
edit box horizontally scrolls up to 255 characters. 

Expression: - An edit box where you enter the expression to be calcu- 
lated. This edit box horizontally scrolls up to 255 characters. 

OK - Select this pushbutton to complete the Calculate ... creation. 

Cancel -You can select this pushbutton to cancel the Calculate .... 

Dimension 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the E keyboard key. Dimension ... opens the following dialog box, allow- 
ing you to define an array for storing data. A subscripted reference is used 
to designate the array elements. The value of the subscript can be from 0 to 
the number in the DIMENSION step. If the subscript is a floating point num- 
ber, it is truncated before being used as a subscript. For example: 

DIMENSION Testvalue [20 ] 

CALCULATE TestValue[O] = 1.23 
CALCULATE TestValue[4.3] = 100.2 
CALCULATE TestValue[i] = 10.0 

Edit Label Comment - 
Array: 
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H Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

H Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to a test procedure step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

H Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to a test procedure 
step. Refer to the Common Dialog Boxes description (given at the begin- 
ning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

H Array: - An edit box where you enter the array variable name and its 
size in the form variable-name[size]. size is limited only by the amount of 
available memory. 

H OK - Select this pushbutton to complete the Dimension ... creation. 

Cancel - Select this pushbutton to cancel the Dimension .... 

Pulse Parameters 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the L keyboard key. Pulse Parameters ... opens the following dialog box, 
allowing you to select a stored waveform, perform a selected pulse parame- 
ter analysis function on it, and store the result in a variable. 

E d ~ t  babel Comment - 

Input Waveform Vanable: Baseflop Method 

@ Histogram 
Pulse Parameter Program Vanable 

0 Mln-Max n 
K-TO-PEAK 

P C l  
Program Var~able mj 
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Edit - Select this menu item by pointing and clicking with the mouse, - 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

Label - Select this menu item by pointing and clicking with the mouse, - 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to a test procedure step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the - 

mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to a test procedure 
step. Refer to the Common Dialog Boxes description (given at the begin- 
ning of this section) for the menu and information on its use. 

G provides the following dialog box items for user interaction. 

Input Waveform Variable: -An edit box where you enter the variable 
name of the waveform to be analyzed. This variable name must be the 
same as the variable name that was assigned to the Instrument Front 
Panel measurement control in the test procedure step that acquired the 
waveform, or a variable with an ADlF 1 .OO waveform file assigned (using 
the File to Variable ... menu item of the Transfer Data Menu) to it. 

Pulse ParameterIProgram Variable: -This list box provides a listing of 
all available pulse parameter analysis functions with their user-assigned 
Program Variable: names. These assigned variable names appear in 
the list as they are assigned. If you need definitions for the listed func- 
tions, refer to the ANSIIIEEE Std 181-1977, IEEE Standard on Pulse 
Measurement and Analysis by Objective Techniques. 

Program Variable: -An edit box where you enter the variable name to 
be assigned to the result of the analysis performed by the selected 
pulse parameter function. To assign the variable name to the Pulse 
Parameter function result, highlight the Pulse Parameter function name, 
enter the variable in this edit box, and select the Add pushbutton. 

Add - Select this pushbutton to complete the assignment of a Pro- 
gram Variable: to a highlighted Pulse Parameter. After you select Add, 
the variable name appears in the Program Variable list. 

Delete - Select this pushbutton to delete a currently assigned Pro- 
gram Variable: for a highlighted Pulse Parameter. 

Change - Select this pushbutton to complete a change made to a 
previously established Program Variable:. To change a Program Vari- 
able, highlight it (the variable name will appear in the Program Variable: 
edit box) edit it with the keyboard, then select Change. 
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H Base/Top Method - The group name for the Histogram and Min-Max 
radiobuttons. When IPG analyzes an acquired waveform, the method 
used to establish the value of the Top and Base is determined by which 
of these buttons has been selected. The following definitions for Histo- 
gram and Min-Max explain the two methods. 

H Histogram - This radiobutton selects a distribution-density method 
of establishing a single point value for each waveform point. This 
method sets each waveform point to the value where the sample 
values occurred most frequently. In this method, the waveform's 
lowest point value is the Base, and its highest point value is the Top. 

Min-Max - This radiobutton selects a method where two values 
(Minimum and Maximum) are established for each waveform point. 
A minimum and maximum are established from the first set of sam- 
ple points, then each subsequent set of sample points is evaluated 
to establish the minimum and maximum value for that set. These 
values are used to update the previously established minimum and 
maximum. This sequence continues until the entire waveform has 
been evaluated, at which time the minimum value becomes the 
Base and the maximum value becomes the Top. 

H Set Crossing - A pushbutton that opens the following dialog box, 
allowing you to select the crossing levels, starting cycle, and leading 
edge (positive or negative) on a waveform that is to be analyzed. 

Edit - I 
I Crossing levels Starting Cycle: I 

@{percent of BareCTop 

0 Absolute Amplitude 

Distal 

Mesial  
- - 

Praxlmsl - Leading Edge 

Positive 

1 0 Negative I 

H Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

H Crossing Levels -The group name for the Percent of Basepop 
and Absolute Amplitude radiobuttons, and the associated Distal, 
Mesial, and Proximal edit boxes. The radiobuttons select how 
crossing levels are established and the edit boxes allow you to set 
the crossing level values. 

H Percent of Basepop - This radiobutton selects a crossing 
level mode establishing crossing levels as a percentage of the 
waveforms Top and Base values. 

H Absolute Amplitude - This radiobutton selects a crossing level 
mode establishing crossing levels as absolute values. 

H Distal - An edit box where you enter the Distal crossing loca- 
tion as a percentage of Top and Base values (for Percent of 
Basepop mode) or the absolute value (for Absolute Amplitude 
mode). 

H Mesial -An edit box where you enter the Mesial crossing 
location as a percentage of Top and Base values (for Percent of 
Basepop mode) or the absolute value (for Absolute Amplitude 
mode). 

H Proximal -An edit box where you enter the Proximal crossing 
location as a percentage of Top and Base values (for Percent of 
Basepop mode) or the absolute value (for Absolute Amplitude 
mode). 

H Starting Cycle: - An edit box where you enter an integer specify- 
ing which waveform cycle you want the pulse analysis to start on 
(for example, enter 1 for the first cycle, 2 for the second cycle, etc.). 

H Leading Edge - The group name for the Positive and Negative 
radiobuttons. These radiobuttons select the whether the start of the 
pulse analysis will be on the positive-going or negative-going edge 
of the waveform. 

H OK - Select this pushbutton to complete the Set Crossing cre- 
ation. 

Cancel - Select this pushbutton to cancel the Set Crossing. 

H OK - Select this pushbutton to complete the Pulse Parameters ... 
creation. 

H Cancel - Select this pushbutton to cancel the Pulse Parameters .... 
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Transfer Data 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the T keyboard key. Transfer Data ... opens the following menu list, 
allowing you to select a source and destination for data transfers. 

File to Variable.-. 
Vgriable to Instrument.-. 
Instrument to Variable ... 
Instrument to File.-- 

Variable to File ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the V keyboard key. Variable to File ... opens 
the following dialog box, allowing you to select the desired source and 
destination of a transfer. (If you enter LPTI. for the File Name:, the 
contents of the variable are sent to the printer.) 

File Name: Variable: 

I Cancel I 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

m label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

w File Name: - An edit box where enter the file name. 

w Variable: - An edit box where you enter the variable name. 

w A disk drive/directory list box (identified with a directory path above 
the box) containing file names that you can select as the destination, 
or disk drives and/or directories where other file names can be 
found for selection. 

w OK - Select this pushbutton to complete the Variable to File ... 
creation. 

w Cancel - Select this pushbutton to cancel the Variable to File .... 

NOTE 

The format of data files associated with data transfers to and from 
files follows rules similar to BASIC language READS and WRITES. 

On transfers to (WRITE) or from (READ) a file, the file stays open. 
Under this condition any transfer to a file (WRITE) is appended to 
the end of the file, and any transfer from a file (READ) stark at the 
next character following the end of the previously read data. 

The system cannot reposition a file when transferring data to and 
from it. In other words, you cannot transfer to a file and then transfer 
the same data from the file to a test, since there is no way to rewind 
the file. Once a file is opened, it remains open until test execution 
stops. 

w File to Variable ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the F keyboard key. Eile to Variable ... opens 
the following dialog box, allowing you to select the desired source and 
destination for a transfer. 
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Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

File Name: - An edit box where you enter the file name. (This 
should be an ASCII text file.) 

Variable: - An edit box where you enter the variable name. If 
Variable: is a string, the text from the file specified in File Name: 
(from the current location in the file to the next CRLF) is placed into 
the string variable, and the current location in the file is updated. If 
Variable: is a number, a string of characters up to a CRLF is read 
into the variable and an attempt is made to convert them into a 
number. (The type of conversion depends on the type of number 
specified, either integer or floating point.) 

A disk drive/directory list box (identified with a directory path above 
the box) containing file names that you can select as the source, or 
disk drives and/or directories where other file names can be found 
for selection. 

OK - Select this pushbutton to complete the File to Variable ... 
creation. 

Cancel - Select this pushbutton to cancel the file to Variable .... 
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NOTE 

The format of data files associated with data transfers to and from 
files follows rules similar to BASIC language READS and WRITES. 

On transfers to (WRITE) or from (READ) a file, the file stays open. 
Under this condition any transfer to a file (WRITE) is appended to 
the end of the file, and any transfer from a file (READ) starts at the 
next character following the end of the previously read data. 

The system cannot reposition a file when transferring data to and 
from it, In other words, you cannot transfer to a file and then transfer 
the same data from the file to a test, since there is no way to rewind 
the file. Once a file is opened, it remains open until test execution 
stops. 

I Variable to Instrument ... - Select this menu item by pointing and 
clicking with the mouse, or by pressing the A keyboard key. Variable to 
Instrument ... opens the following dialog box, allowing you to select the 
desired source and destination for a transfer. 

Edit Label Comment - 

T M S  Name Driver Port Address 

Variable: 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

A list box from which you select the instrument you want for the 
destination (by pointing and clicking with the mouse). The list shows 
all the instruments currently loaded into IPG. 

Variable: - An edit box where you enter the variable name. If the 
variable type is numeric, it is converted into a string and then sent to 
the instrument without any modification (other than what is required 
for the particular bus communication protocol). 

OK - Select this pushbutton to complete the Variable to Instru- 
ment ... creation. 

Cancel - Select this pushbutton to cancel the Variable to Instru- 
ment .... 

Instrument to Variable - Select this menu item by pointing and click- 
ing with the mouse, or by pressing the I keyboard key. lnstrument to  
Variable ... opens the following dialog box, allowing you to select the 
desired source and destination for a transfer. 

Edit Label Comment - 
TMS Name Driver Port Addrers 

Variable: 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

w A list box from which you select the instrument you want for the 
source (by pointing and clicking with the mouse). The list shows all 
the instruments currently loaded into IPG. 

w Variable: - An edit box where you enter the variable name. A string 
of data is read from the instrument into the variable without any 
modification (other than what is required by the particular bus com- 
munication protocol). If the variable type is numeric, the data is 
converted into either an integer or a floating point number. 

w OK - Select this pushbutton to complete the lnstrument to Vari- 
able ... creation. 

w Cancel - Select this pushbutton to cancel the Instrument to Vari- 
able .... 

w Instrument to File ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the N keyboard key. Instrument to 
File ... opens the following dialog box, allowing you to select the desired 
source and destination for a transfer. (If you enter LPT7 for the File 
Name:, the input is sent to the printer.) 

TMS Name Driver Port  Address 

F i le  Name: 

*.DAT 

G:\ipg 

w Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

w Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

w Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

w A list box from which you select the instrument you want for the 
source (by pointing and clicking with the mouse). The list shows all 
the instruments currently loaded into IPG. 

File Name: -An edit box where you enter the file name. The entire 
data transmission from the instrument is placed into the file without 
modification or translation. 

m A disk driveldirectory list box (identified with a directory path to the 
left of the box) containing file names that you can select as the 
destination, or disk drives and/or directories where other file names 
can be found for selection. 

8 OK - Select this pushbutton to complete the Instrument to File ... 
creation. 

Cancel - Select this pushbutton to cancel the Instrument to File .... 

NOTE 

On transfers to (WRITE) or from (READ) a file, the file is read or 
written from the beginning on each transfer, and is opened and 
closed on each transfer. If the file already exists, it will be ovenurit- 
ten. 

w File to Instrument ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the I keyboard key. File to Instrument ... 
opens the following dialog box, allowing you to select the desired 
source and destination for a transfer. 

TMS Name Driver Port Address 

File Name: 

* .DAT 

c:\ipg 

w Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 
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Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

A list box from which you select the instrument you want for the 
destination (by pointing and clicking with the mouse). The list shows 
all the instruments currently loaded into IPG. 

File Name: - An edit box where you enter the file name. The entire 
contents of the file are sent to the instrument without modification 
(other than what is required by the particular bus communication 
protocol). 

A disk drive/directory list box (identified with a directory path to the 
left of the box) containing file names that can be selected as the 
source, or disk drives and/or directories where other file names can 
be found for selection. 

OK - Select this pushbutton to complete the File to Instrument ... 
creation. 

Cancel - Select this pushbutton to cancel the File to Instrument .... 

NOTE 

On transfers to (WRITE) or from (READ) a file, the file is read or 
written from the beginning on each transfer, and is opened and 
closed on each transfer. 
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File I10 

Select this item pointing to or clicking with the mouse or by pressing the L 
keyboard key. File I10 opens a the following menu list, allowing you to 
select the step to be generated. 

Open CSV Log File ... 
Open Sequential File ... 
Print ASCll Log File ... 
Print CSV Log File ... 
Print Sequential File ... 
Input ... 
Close File ... 
Delete File ... 
Rewind File ... 

Files are identified by a numeric value. The value is associated with a DOS 
file by one of the OPEN steps. Any expression that evaluates to a positive 
non-zero value can be used to identify a file. 

Open ASCll Log File, CSV Log File and Sequential File -The three 
file types use the same dialog boxes for opening the file. 

Edit Label Comment - 

File name: 1-1 
File ID: 

File attributes 

0 Append to existing 0 Read only 

0 Erase existing 0 Write only 

@ Create new @ Read Write 

@ Open existing 
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File name - this edit box is for a string expression, that represents the 
name and path of the file. If no path is specified the current directory is 
used. 

File ID -An edit control where a floating point expression is entered. 
The value of the expression is the ID of the file. The ID is used in the 
PRINT, INPUT and CLOSE steps that deal with the file. 

Mode - The radiobuttons in this group deal with how the file is opened 
and how any existing file with the same name is treated. Only one of the 
radiobuttons in this group may be selected at one time. 

Append to existing - If this button is selected the OPEN step 
expects the file to already exist. If it does not exist an error is dis- 
played and execution terminated. Once the file is opened it is posi- 
tioned at the end. A EOFO check on the file would return true, while 
writing to the file will add the information at the end of the file. 

Erase existing - If this button is selected the OPEN step expects 
the file to already exist. If it does not exist an error is displayed and 
execution is terminated. If the file does exist its contents are deleted. 
Care must be take using this option since the previous contents of 
the file will be lost for ever when the OPEN step is executed. 

Create New - If this button is selected the OPEN step will create 
an empty file. If the file already exists an error is displayed and 
execution is terminated. 

Open existing - If this button is selected the OPEN step expects 
the file to already exist. If it does not exist an error is displayed and 
execution is terminated. The file marker is positioned at its begin- 
ning. The first INPUT from the file will return the first record in the 
file. While a write may write over data that was already in the file, 
Care must be take with this option because any existing data may 
be lost if the file is written to. 

File Attributes - The radiobuttons in this group specify how the file will 
be accessed in this test procedure. Only one of the radiobuttons in this 
group may be selected at one time. 

Read Only - If this button is selected the file will be opened only 
for reading with the INPUT step. Attempts to write to a file opened in 
this manner will result in an error. 

Write Only - If this button is selected the file will be opened only 
for writing to with the PRINT step. Attempts to read from the file will 
result in an error. 

ReadIWrite - If this button is selected the file will be opened for 
use with both the INPUT and PRINT steps. 

Ok - Select this pushbutton to complete the Open dialog. 

Cancel - Select this pushbutton to cancel the Open dialog. 

-- - - - - 
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Print ASCll Log File & Print CSV Log File - Both ASCll and CSV log 
files use the same dialog for building their steps. 

Lower Limit: 7 1  
Actual Value: 

File ID -this is the only required entry and is a numeric expression. 
The value of the File ID field is used to identify the file the log entry is to 
be written to. The Open step is used to associate the file ID with a DOS 
file name. 

High Limit - this is a numeric expression and is an optional field. When 
evaluated at execution its value is the upper limit for passing values. 

Nominal Value -this is a numeric expression and is an optional field. It 
is the expected value for this log entry. 

Lower Limit - this is a numeric expression and is an optional field. It is 
the lowest value that will result in a PASS on the log step. 

Actual Value - this is a numeric expression and is an optional field. It is 
the value that will be used to make the PASS/LOW/HIGH determination. 

Comment -this is a string expression. If present its value is used as 
the comment for the log file entry. 

Ok - Select this pushbutton to complete the Open dialog. 

Cancel - Select this pushbutton to cancel the Open dialog. 
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Print -The print step is used to write data into a sequential file. 

Edit Label Comment - 

File ID: 11 

Print list::] 

rn File ID - is a numeric expression, used as the file ID. When the step is 
executed the ID must match the ID of a currently opened file. 

rn Print List - the print list is a list of one or more expression separated by 
commas or semicolon. The end of the list may also have a comma or 
semicolon. The expression may be either numeric or string expression. 
Waveform variables are not support by the print step. 

The expressions in the print list are evaluated starting at the left most, 
converted to ASCII text strings and written to the file whose ID is in File 
ID. When a comma is encountered in the print list a tab character (ASCII 
code 9) is written out to the file. Nothing is written out to the file when a 
semicolon is encountered. If the print list ends with neither a comma nor 
a semicolon a carriage return, line feed sequence is written to the file to 
mark the end of the record. 

Ok - Select this pushbutton to complete the Open dialog. 

rn Cancel - Select this pushbutton to cancel the Open dialog. 

lnput - The lnput step is used to read data from a sequential file. Each 
time an input step is executed a single record is read, and one or more 
variables step to the read values. A record in a sequential file is delimited by 
a carriage return line feed pair. 
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Edit label Comment - 

File ID: 

11 
Variable List 

a 

w File ID - is a numeric expression, used as the file ID. When the step is 
executed the ID must match the ID of a currently opened file. 

Variable list - is a list of one or more variables, separated by commas. 
The variables maybe integers, floats, or strings. Waveform variables are 
not allowed in an input step. The variable may also be a reference to an 
array such as: 

w Ok - Select this pushbutton to complete the Open dialog. 

w Cancel - Select this pushbutton to cancel the Open dialog. 

When the lnput step is executed a record is read from the file and values 
are assigned to the variables in the input list start from the left. If there are 
more variables in the list then data in the record and error message is gener- 
ated and execution is stopped. While if there is unused data after the last 
variable has been assigned a value it is ignored. Data left over from one 
lnput step is not read by the next input. 

The data is broken into pieces to be assigned to variables by comma's or 
tabs (these are the field delimiters.) Use a comma or tab in data to be read 
into a string variable. Surround the data with semicolons. The following 
examples show the data file record, variable list and the final values of the 
variables. 

Data file: 123, hello out there, 0.3e5 

Variable list: i& , s $  , x# 

Values after input: 
i & is 1 2 3  

s $  is "hello out there" 

x # is 0.3E5 

Data file: "123, hello", 3 .I41 

Variable List: s$  , p i #  
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Values after input: 
s $  is "123,hello" 

p i #  is 3 . 1 4 1  

If the variable type and the type of data in the file are not compatible an error 
message is generated and execution terminated. 

Rewind -The Rewind step is used to reposition a file to its starting point. 
After a Rewind step the next Input will read the first record of the file. 

Edit Label Comment - 

File ID: 

D 

File ID - is a numeric expression. The value of the expression is the ID 
of the file to be rewound. The file must be open when the command is 
executed. 

Ok - Select this pushbutton to complete the Open dialog. 

Cancel - Select this pushbutton to cancel the Open dialog 

Delete -The Delete step is used to delete a file. It is equivalent to the 
DOS DEL command. Care must be used when using this test since the 
information in a deleted file may not be recoverable. No error message is 
generated if the file to be deleted does not exist. 

Edit Label Comment - 

File name: 

1.1 

Menus 



w File Name - is a string expression. The value of the string expression is 
the name of the file to be deleted. If no path or drive is specified the 
current directory is assumed. 

Ok - Select this pushbutton to complete the Open dialog. 

w Cancel - Select this pushbutton to cancel the Open dialog. 

Close - Select this menu item by selecting Close in the File I10 sub 
menu. The Close step is used when a file will no longer be used by the test 
program. Until the Close is executed the file will be unavailable to other 
programs. 

Edit Label Comment - 

File ID: [I 

w File ID - An edit control where a floating point expression is entered. 
The value of the expression is the ID of the file. The ID was associated 
with a file by an OPEN step. 

Ok - Select this pushbutton to complete the Open dialog. 

Cancel - Select this pushbutton to cancel the Open dialog. 
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On Event 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the V keyboard key. On Event ... opens the following dialog box, allowing 
you to select an event handler (test procedure file name) to which program 
control is transferred whenever a selected event occurs. Checking for events 
is done after each test procedure step. 

Test Procedure: Event: 

Parameters: 

m Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key, Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

m Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Test Procedure: - An edit box where you enter the name of a test 
procedure file to which program control will be transferred when the 
event specified by this step occurs. This file name can be a new name 
for a procedure that is to be created later, or a name from the list box of 
test procedure file names. If you use a file from the list box, you can 
enter the name from the keyboard, or select it from the list box by point- 
ing and clicking the mouse. 

A disk drive:\directory\file list box (identified with a disk drive:\directory 
path above the box) containing a list of the available test procedure files 
to which you can transfer program control when specified events occur. 
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H Parameters: -An edit box where you enter the required parameters 
(variable names) that must be passed to the Test Procedure: file. You 
must enter these parameters in the order required by the procedure, 
and you must separate multiple parameters with commas. If the Test 
Procedure: file has already been created, select its name from the list 
box and then select the About pushbutton to list its required pararne- 
ters. 

NOTE 

Only variables can be passed as parameters; passing constants 
will cause an error. 

Event: - The group name for the SRQ, Timeout, and VXI Event check 
boxes. Select these check boxes to cause program execution to transfer 
to a selected Test Procedure: when the event occurs. 

H SRQ -When selected, SRQ causes program execution to transfer 
whenever an IEEE 488 (GPIB) SRQ event occurs. 

w Timeout -When selected, Timeout causes program execution to 
transfer whenever a program timeout event occurs. 

w Enable - Selecting this radiobutton reverses the action of the following 
Disable radiobutton. 

Disable - Selecting this radiobutton will temporarily disable the inter- 
rupt handler selected, but does not delete it. 

H About - If you select this pushbutton, the following dialog box appears 
and lists any comments attached to the selected Test Procedure:, as 
well as the Parameters: necessary for that procedure. (You should 
attach appropriate comments listing the parameters for the test proce- 
dure to the PROCEDURE step.) 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 
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Edit - 

Cornmenl 

Parameters: 

IPG provides the following dialog box items for user interaction: 

w Comment -This box shows any comments that have been added 
to the selected Test Procedure:. 

H Parameters: - This box shows the parameters necessary for 
running the selected Test Procedure:. 

w Done - Select this pushbutton to close the About Procedure 
dialog box and return to the On Event dialog box. 

w OK - Select this pushbutton to complete the On Event ... creation. 

8 Cancel - Select this pushbutton to cancel the On Eyent .... 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the B keyboard key. On Abo rt... opens the following dialog box, allowing 
you to select an interrupt handler (test procedure file name) that program 
control transfers to whenever an ABORT event occurs. An ABORT event 
occurs when you press the CTRL and C keyboard keys simultaneously, or 
when you select Abort in a display step. Checking for an ABORT is done 
after each test procedure step. 

Edit Label  Comment - 
Test Procedure: 

[I 
c;Upg m 

1-1 
@I Enable 

C1 Disable 
Parameters: 

4-42 Menus 



Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

m Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

m Test Procedure: -An edit box where you enter the name of a test 
procedure file to which program control will be transferred when an 
ABORT occurs. This file name can be a new name for a procedure that 
is to be created later, or a name from the list box of test procedure file 
names. If you use a file from the list box, you can be enter the name with 
the keyboard, or select it from the list box by pointing and clicking the 
mouse. 

m A disk drive:\directory\file list box (identified with a disk drive:\directory 
path above the box) containing a list of the available test procedure files 
to which you can transfer program control when an abort occurs. 

Parameters: - An edit box where you enter the required parameters 
(variable names) that must be passed to the Test Procedure: file. You 
must enter these parameters in the order required by the procedure, 
and you must separate multiple parameters with commas. If the Test 
Procedure: file has already been created, select its name from the list 
box and then select the About pushbutton to list its required parame- 
ters. 

Only variables can be passed as parameters; passing constants 
will cause an error. 

Enable - Selecting this radiobutton reverses the action of the following 
Disable radiobutton. 

Disable - Selecting this radiobutton will disable the interrupt handler 
selected, but does not delete it. 
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About - If you select this pushbutton, the following dialog box appears 
and lists any comments attached to the selected Test Procedure:, as 
well as the Parameters: necessary for that procedure. 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Ed il - 

Commenl 

Parameters: 

r 1 

IPG provides the following dialog box items for user interaction: 

Comment - This box shows any comments that have been added 
to the selected Test Procedure: 

Parameters: -This box shows the parameters necessary for 
running the selected Test Procedure:. 

Done - Select this pushbutton to close the About dialog box and 
return to the On Abort dialog box. 

OK - Select this pushbutton to complete the On Abort ... creation. 

Cancel -You can select this pushbutton to cancel the On Abort .... 

Delay 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the D keyboard key. Delay ... opens the following dialog box, allowing 
you to enter a delay period into a test procedure. 

Edi t  Label Comment - 
7 1  Mil l iseconds 
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m Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

= Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Milliseconds: - An edit box where you enter a value representing the 
desired procedure delay in milliseconds. 

OK - Select this pushbutton to complete the Delay ... creation. 

m Cancel - Select this pushbutton to cancel the Delay .... 

Remark 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the M keyboard key. Remark ... opens the following dialog box, allowing 
you to enter remark text to a test procedure step. 

NOTE 

You can view all remarks in a test procedure (without displaying 
other procedure steps), by selecting Options from the Main Menu 
bar, then selecting Remarks Only. 

Edit - 
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M Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

IPG provides the following dialog box items for user interaction: 

An untitled edit box where you enter the remark text to be displayed in 
the test procedure outline. (The remark text is played above the step in 
which you enter it.) 

If the remark text on the display exceeds 75 characters, IPG replaces the 
last three characters (of the 75) and the remaining text with an ellipsis 
(. . .) to indicate that the remark is longer than one line. In order for you 
to read the entire remark, you must double-click on the REMARK step to 
open the dialog box, or print the full procedure by selecting the Full 
radiobutton from the Print dialog box under the File Menu. 

OK - Select this pushbutton to complete the demark ... creation. 

Cancel - Select this pushbutton to cancel the Remark ... 

Include 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the N keyboard key. Include opens the following menu list allowing you 
to enter programming constructs or procedures that are not suited to IPG 
capabilities. Data entered with an INCLUDE step will be converted with the 
test program into the C programming language (using the Translate Menu). 
IPG ignores text or file names entered with Include during normal test 
execution. 

I e  xt... - Select this menu item by pointing and clicking with the mouse, 
or by pressing the T keyboard key. le xt... causes the following dialog 
box to appear, allowing you to enter text that will be used when translat- 
ing the test procedure to the C programming language. 

4-46 Menus 



Text: 

An include step lets you add C specific code to your test procedure and 
now you only maintain one copy of the test. You do not have to modify 
the translated C code. 

IPG provides the following dialog box items for user interaction: 

Text: -An edit box where you enter the desired text. 

OK - Select this pushbutton to complete the Text ... creation. 

Cancel - Select this pushbutton to cancel the I e  xt.... 

File ... - Select this menu item by pointing and clicking with the mouse, 
or by pressing the F keyboard key. File ... causes the following dialog 
box to appear, allowing you to enter a file name that will be used when 
translating the test procedure to the C programming language. A C 
#Include filename step will be generated in the C code. 

Edit Label  Comment - 
Filename: 

I I 
c~i ipg 

[ - - I  
[library] 
I-a-I 
I-c-I 
I-d-I 
I-e-I 
[-f-] 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 
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H Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

H Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

H Filename: -An edit box where you enter the desired file name. You 
can enter the file name using the keyboard keys, or you can point 
and click with the mouse on a file name in the following list box. 

H A disk drive:\directory\file list box (identified with a disk drive:\direc- 
tory path above the box) containing a list of the available test proce- 
dure files to which you can transfer program control when an abort 
occurs. 

H OK - Select this pushbutton to complete the File ... creation. 

H Cancel - Select this pushbutton to cancel the File .... 

I f  Then Else 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the I keyboard key. I f  Then Else ... opens the following dialog box, 
allowing you to create an IF-THEN-ELSE comparison and flow control test 
procedure step. 

An IF-THEN-ELSE construct has a typical form of: 

IF <expression> THEN <statement> ELSE <statement> END-IF 

I f  Then Else ... creates a test procedure step of: 

IF <expression> THEN 
ELSE 
END-IF 

The user must enter the <statement> steps. 

Edit l a b e l  Comment - 

Expression: 

p G Z 1  
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Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

m Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Expression: -An edit box where you enter the comparison expression, 
which must evaluate to zero (false) or non-zero (true). The edit box will 
horizontally scroll up to 255 characters. 

OK - Select this pushbutton to complete the I f  Then Else ... creation. 

Cancel - Select this pushbutton to cancel the I f  Then Else .... 

While Do 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the W keyboard key. While Do ... opens the following dialog box, allow- 
ing you to enter a WHILE-DO construct into a test procedure step. 

A WHILE-DO construct has a typical form of: 

WHILE <expression> DO 
<statement> 
END-WHI LE 

The action of this dialog box creates a test procedure step of: 

WHILE <expression> DO 
END-WHI LE 

The user must enter the <statement> step. 

Expression: 
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m Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Expression: -An edit box where you enter the comparison expression 
that must evaluate to zero (false) or non-zero (true). The edit box will 
horizontally scroll up to 255 characters. 

OK - Select this pushbutton to complete the While Do ... creation. 

Cancel - Select this pushbutton to cancel the While Do .... 

For Next - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the F keyboard key. For Next ... opens the following menu list, allowing 
you to select the type of incrementing sequence to be used when creating a 
program looping test procedure step. 

1 2-5..- 
User defined.- 

Linear. .. - Select this menu item by pointing and clicking with the 
mouse, or by pressing the L keyboard key. Linear ... opens the following 
dialog box, allowing you to set the loop parameters for a linear incre- 
menting sequence. 

A FOR-NEXT linear construct has a typical form of: 

FOR <variable> = <start> TO <end> <SIZE/STEP> 
<increment/steps> <increment type> 
<statement> 
NEXT 
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When you select a linear loop type and enter an increment size, Linear. .. 
creates a test procedure step of: 

FOR < v a r i a b l e >  = < s t a r t >  T O  <end> S I Z E  < incremen t>  
LINEAR 
NEXT 

The user must enter the < s t a t e m e n t >  step. If you change the method 
of incrementing, the test procedure step changes accordingly. For 
example, if you change the method of incrementing to a number of 
steps, the word SIZE changes to STEPS. 

Edit Label  Comment - 

Start Value: End Value: 

/ I  
Number of Steps: 

l l  
Increment Size: 

I: 
Variable: r 

H Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

H label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key, label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

H Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Gomment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Start Value: -An edit box where you enter the starting value of the 
FOR-NEXT loop. 

H End Value: -An edit box where you enter the ending value of the 
FOR-NEXT loop. 

8 Number of Steps: -An edit box where you enter the number of 
steps the FOR-NEXT construct will execute. If you make an entry in 
this box, Increment Size: will be displayed in gray. 
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lncrement Size: - An edit box where you enter the size of the loop 
increment. If you make an entry in this box, Number of Steps: is 
displayed in gray. 

m Variable: - An edit box where you enter the FOR-NEXT variable 
name. 

OK - Select this pushbutton to complete the Linear. .. creation. 

Cancel - Select this pushbutton to cancel the Linear .... 
Lgg ... - Select this menu item by pointing and clicking with the mouse, 
or by pressing the 0 keyboard key. Log ... opens the following dialog 
box, allowing you to set the FOR-NEXT construct parameters for a loop 
having a logarithmic incrementing sequence. 

A FOR-NEXT log construct has a typical form of: 

FOR <var> = < s t a r t >  TO <end> STEP < s t e p s >  
< i n c r e m e n t  t y p e >  
< s t a t e m e n t >  
NEXT 

When you select a logarithmic loop type and set the number of steps, 
Log ... creates a test procedure step of: 

FOR < v a r i a b l e >  = < s t a r t >  T O  <end> S T E P  < s t e p s >  LOG 

NEXT 

The user must enter the < s t a t e m e n t >  step. 

I Edit Label Comment 

1 Start Value: End Value: 

I Number of Steps: Increment Size:  

1 Variable: e 
I Cancel I 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

4-52 Menus 



Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Start Value: -An edit box where you enter the starting value of the 
FOR-NEXT loop. 

m End Value: - An edit box where you enter the ending value of the 
FOR-NEXT loop. 

m Number of Steps: -An edit box where you enter the number of 
steps the FOR-NEXT construct will execute. 

NOTE 

IPG will calculate the appropriate logarithmic step increments for 
executing the FOR-NEXT construct. 

Variable: - An edit box where you enter the FOR-NEXT variable 
name. 

m OK - Select this pushbutton to complete the Log ... creation. 

Cancel - Select this pushbutton to cancel the Log .... 
1-2-5.. - You can select this command by pointing and clicking with 
the mouse, or by pressing the 1 keyboard key. 1-2-5.. opens the 
following dialog box allowing you to set the FOR-NEXT construct param- 
eters for a loop having a 1-2-5 incrementing sequence. 

A FOR-NEXT 1-2-5 construct has a typical form of: 

FOR < v a r i a b l e >  = < s t a r t >  TO <end> < i n c r e m e n t  t y p e r  
< s t a t e m e n t >  
NEXT 

and creates a test procedure step of: 

FOR < v a r i a b l e >  = < s t a r t >  TO <end> 1-2-5 
NEXT 

The user must enter the < s t a t e m e n t >  step. 
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Ed i t  _Label Comment - 

Start Value: End Value: 

Number of Steps: Increment S i z e :  

I S  
f 1- 

Variable:  I 

H Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

H l abe l  - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

H Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

H Start Value: - An edit box where you enter the starting value for the 
FOR-NEXT loop. 

End Value: - An edit box where you enter the ending value for the 
FOR-NEXT loop. 

NOTE 

IPG calculates the appropriate loop step values. 

H Variable: - An edit box where you enter the FOR-NEXT variable 
name. 

OK - Select this pushbutton to complete the 1-2-5 ... creation. 

H Cancel - Select this pushbutton to cancel 1-2-5 .... 
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User Defined ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the U keyboard key. User Defined ... opens 
the following dialog box, allowing you to set the FOR-NEXT construct 
parameters for a loop having a user-defined incrementing sequence. 
This allows you to use a special application of the FOR-NEXT construct 
to build a list whose values are stored in user-defined positions within 
the list. For descriptive purposes, this application is simply defined as: 

For Position 
Variable[Position] = Value 
Next 

where Value is accessible only within the FOR-NEXT loop, and only at 
each iteration. 

When you select a user-defined loop type, User Defined ... creates a test 
procedure step of: 

FOR < v a r i a b l e >  U S E R  DEFINED <value> <value> . . .  
NEXT 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

m Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

Value: - An edit box where you enter the value to be stored in the 
lists Variable [ ~ o s i  t i o n ]  element. Value: can be constants, 
variables, or expressions, but must be numeric. 

Position: -An edit box where you enter the index value of the loop 
position. 

Variable: -An edit box where you enter the FOR-NEXT variable 
name. 

Defined Values: -This list box shows the Value: in the Position: 
order specified when you select the Add pushbutton. 

Add - Select this pushbutton to complete the addition of a new 
Position: and its Value:. 

Change - Select this pushbutton to implement any changes to 
Position: or Value: that you have made by editing with the key- 
board. 

Delete - Select this pushbutton to delete any highlighted Value: 
from the Defined Values: list. 

OK - Select this pushbutton to complete the User Defined ... 
creation. 

Cancel - Select this pushbutton to cancel the User Defined .... 

Exit Foy Next 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the R keyboard key. Exit For Ne xt... allows you to create an EXIT step 
within a FOR-NEXT test procedure loop, so that program control can be 
transferred from the FOR-NEXT loop before normal loop completion. Exit 
For Ne xt... also opens the following dialog box, allowing you to add a label 
or comment to the EXIT step. 

m Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 
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8 comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

8 OK - Select this pushbutton to complete the Exit For Next creation. 

8 Cancel - Select this pushbutton to cancel the Exit For Next. 

Call Procedure 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the P keyboard key. Call Procedure opens the following menu list, 
allowing you to create a test program step that transfers program control to 
another test procedure. 

1 External Procedure--. I 

When calling other procedures into your test procedure, make 
certain that any instrument driver (.lSD) files that are used by the 
other procedure are already loaded by the Main Procedure. 

8 TekTMS Procedure ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the P keyboard key. TekTMS Proce- 
dure ... opens the following dialog box, allowing you to select a TekTMS 
test procedure to which program control will be transferred. 
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Edit Label Comment - 
Test Procedure: I 

I cancel  I 
[ Parameters: 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

w label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

rn Test Procedure: - An edit box where you enter the name of the 
test procedure file that you want program control to be transferred 
to. This name can be for a new file that has not been created, or you 
can select the name from the following list box (by pointing and 
clicking the mouse). 

rn A list box (identified with a disk drive:\directory path above the box) 
containing a disk drive:\directory\file list of test procedure files to 
which you can transfer program control. 

rn Parameters: - An edit box where you enter parameters that must 
be passed to the Test Procedure: file. You must enter these param- 
eters in the order required by the procedure, and you must separate 
multiple parameters with commas. If the procedure has already 
been created, you can select its name from the list box and select 
the About pushbutton to list its required parameters. 
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NOTE 

Only variables may be passed as parameters; constants are not 
allowed. 

8 About - If you select this pushbutton, the following dialog box 
appears and lists any comments attached to the selected Test 
Procedure:, as well as the Parameters: necessary for that proce- 
dure. 

NOTE 

Comments attached to a procedure for viewing with About should 
be attached to the PROCEDURE statement of that procedure. 

Edit - 

Comment 

Parameters: 

8 Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

8 Comment - This box shows any comments that have been 
added to the selected Test Procedure:. 

8 Parameters: - This box shows the parameters necessary for 
running the selected Test Procedure: 

8 Done - Select this pushbutton to close the dialog box and 
return to the On Event dialog box. 

8 OK - Select this pushbutton to complete the TekTMS Procedure ... 
creation. 
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Cancel - Select this pushbutton to cancel the TekTMS Proce- 
dure .... 

External Procedure ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the E key. External Procedure ... opens 
the following dialog box, allowing you to select an external test proce- 
dure to which program control is to be transferred (after the test proce- 
dure is translated into the C programming language). The Run Time 
Generator (RTG) will make all name conversions from IPG variable 
names to C variable names, enabling you to use your variable names in 
the parameter list. The called procedure must know the data types used 
by RTG when it translated the programs to C. Refer to the RTG Program- 
mers Reference Manual for further information. 

Procedure name: 

Parameters: 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Procedure Name: -An edit box where you enter the name of the 
external procedure desired. 

Parameters: - This box shows the parameters necessary for 
running the selected Test Procedure:. 
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... rn OK - Select this pushbutton to complete the External Procedure 
creation. 

rn Cancel - Select this pushbutton to cancel the External Proce- 
dure .... 

Exit Procedure 
Select this menu item by pointing and clicking with the mouse, or by press- 

... ing the X keyboard key. Exit Procedure opens the following dialog box, 
allowing you to create a test procedure step, within the current procedure, 
that will exit the procedure before the end of the procedure is reached. 

Label Comment - 
.......... 
.......... , 

rn l abe l  - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

rn comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

... rn OK - Select this pushbutton to complete the Exit Procedure cre- 
ation. 

rn Cancel - Select this pushbutton to cancel the Exit Procedure .... 

Stop Test - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the S keyboard key. Stop Test ... opens the following dialog box, allow- 
ing you to create a test procedure step that stops the test before its end. 
Once you have stopped a test procedure, you must restart it with a Run 
command from the Main Menu. 
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Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. l abe l  allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

OK - Select this pushbutton to complete the Stop Test ... creation. 

Cancel - Select this pushbutton to cancel the Stop Test .... 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the S keyboard key. Gosub ... opens the following dialog box, allowing 
you to create a test step that transfers program control to a subroutine 
located elsewhere in the test procedure. Program control transfers to a label 
you have assigned to the test step where program flow is to be transferred. 

Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

l abe l  - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. l abe l  allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

8 Label: -An edit box where you assign the name of the test procedure 
step where the subroutine starts. 

8 OK - Select this pushbutton to complete the Gosub ... creation. 

a Cancel - Select this pushbutton to cancel the Gosub .... 

Return 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the U keyboard key. Return ... opens the following dialog box, allowing 
you to create a RETURN step from a subroutine. A RETURN step is required 
at the end of a subroutine to which program control was transferred with a 
GOSUB. A RETURN step returns program flow control to the step immediately 
following the last GOSUB. 

Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

8 Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

8 OK - Select this pushbutton to complete the Return ... creation. 

8 Cancel - Select this pushbutton to cancel the Return .... 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the G keyboard key. Goto ... opens the following dialog box, allowing you 
to create an unconditional program flow control transfer step to some speci- 
fied place (Label) in the procedure. 
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Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Label: -An edit box where you enter the label name of the test proce- 
dure step to where program control is to be transferred. 

OK - Select this pushbutton to complete the Goto ... creation. 

Cancel - Select this pushbutton to cancel the Goto .... 
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Operator Menu The following Operator Menu appears whenever you select the Operator 
menu item from the Main Menu bar by pointing and clicking the mouse, or 
by pressing and holding the ALT keyboard key while pressing the 0 key. 
This menu allows you to create an instrument adjustment test procedure 
step, a test procedure step that displays selected data, and a test procedure 
step that displays a text or picture prompt for the operator. 

Display Wayeforms ... 
Display Data - b 
Prompt - b 

Adjustment 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the A keyboard key. Adjustment ... opens the following dialog box, 
allowing you to enter the data required to establish an instrument ADJUST- 
MENT test procedure step. Any type of operation can be specified in an 
ADJUSTMENT loop. Typically, a value is measured from an instrument and 
returned to be compared to a required value, but any other IPG construct 
can be used in addition to, or in place of, a measured value. A PassIFail 
variable is provided so that you can determine if the ADJUSTMENT com- 
pleted in or out of the specified range. 

An example of an ADJUSTMENT step in the test procedure outline is as 
follows: 

ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 PASS/FAIL 
gainpf 

Adjust R2022 for nominal in the display. 
MEASUREMENT DM5120 Reading gaincal 

END-ADJUSTMENT 

When IPG executes an ADJUSTMENT step, its action generates the following 
sequence of loop actions: 

WHILE <expression> DO <statement> END 

The first action of the sequence assigns <expression> to a temporary 
variable and sets it to = TRUE. While running, the loop continues until you 
select the OK pushbutton on the adjustment display. Selecting OK causes 
the temporary variable to change to FALSE, terminating the ADJUSTMENT 
step. 

<statement> consists of a separately created instrument MEASUREMENT 
step, which must be nested within the ADJUSTMENT construct. 
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Edit l a b e l  Comment - 
Lower Limit: Nominal  Value: Upper Limit: 

[I 
Variable: 7 1  
PasslFeil: 
Message: w 

H Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

H Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

H Lower Limit: - An edit box where you enter the numeric term of the 
lower limit for the adjustment comparison. 

H Nominal Value: -An edit box where you enter the numeric term of the 
nominal value of the adjustment. This is an optional entry. 

H Upper Limit: - An edit box where you enter the numeric term of the 
upper limit for the comparison. 

H Variable: -An edit box where you enter the name of the test variable to 
be compared. 

H PassIFail: - An edit box where you enter the name of a variable to be 
assigned a PassIFail value of 1 (pass) or 0 (fail). (The PassIFail value is 1 
if the final adjustment places the measured value between the limits, or 
is 0 if the final measured value is outside the limits.) 

H Message: - An edit box where you can enter a text message that will 
be displayed for the operator during the ADJUSTMENT step. 

H OK - Select this pushbutton to complete the Adjustment ... creation. 

H Cancel - Select this pushbutton to cancel the Adjustment .... 
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When IPG runs an ADJUSTMENT step it creates a display like that shown in 
the following illustration. 

Low Nornlnal 15 Hlph 

3 Actual  [5.879085665 / 8 

b 4  + 

In Range 

This display includes representative markers (triangles and diamonds) and 
numeric values for the Low limit, High limit, Nominal: value, and Actual: 
value of the ADJUSTMENT step. It also provides an operator prompt mes- 
sage for making the adjustment. If the instruments are on line and fully 
functional, or the procedure is run in the Emulate mode, each time you 
make an adjustment (or send an entry with a Read Emulate box), the repre- 
sentative marker (diamond) and Actual: value for the point being measured 
will change on the display. This adjust, measure, compare, and change 
display sequence continues until you select the OK pushbutton on the 
display. 

NOTE 

The first time the adjustment loop appears, there is no Actual: 
value, thus IPG assumes a Low Limit for placing the diamond 
marker on the display. 

Display XYPlot 

Select this item by pointing and clicking with the mouse or by pressing the X 
keyboard key. Display XYPlot opens the following dialog box, allowing you 
to select array pairs to be displayed. With this step you can display up to ten 
different array pairs on the same graphical display. 

- - - - 
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Edit babel Comment Options - 

Selected Plot Names: X-Array Name: 
, . . . . . . . . . - ~. . . . . . . . . . 

Y-Array Name: 

Plot Name: 

I 
Array Limits 

Start: 

End: 1 7  

Options - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the 0 key. Options opens the following Options menu, allowing you to 
select graphics display enhancements that change the default display 
when the step is run. 

Colors and Styles ... 

Grid - adds vertical and horizontal grids to the graphics display at 
each major vertical and horizontal scale mark. See page 4-1 11 for 
more information. 

Colors and Styles - This menu it allows you to select graphics 
display colors and line styles. See page 4-1 12 for more information. 

Labels -This menu item allows to change the graphics display title 
and the names of the X and Y Axes. See page 4-1 14 for more in- 
formation. 

Selected Plot Names: - This list box provides a list of the plot names 
that have been selected for display. To change or delete a plot name or 
its associated arrays, you double click on the plot name in this list box, 
make your changes if needed, and then click on the appropriate push- 
button to the extreme right of this list box. 

Plot Name - An edit box where you enter the unique name of the array 
pair to be displayed. This Plot name can be any alphanumeric charac- 
ters that you wish to enter. This name is an identifier and is used in the 
default tittle and in the Colors and Styles to identify a specific array pair. 

m OK - Select this pushbutton to complete the Display XYPlot creation. 
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w Cancel - Select this pushbutton to cancel the Display XYPlot. 

w X-Array Name: -An edit box where you enter the numeric array values 
that are the points for the X axis. The array name is given as a whole 
array reference, i.e., a&[], with no specific subscript. 

w Y-Array Name: - An edit box where you enter the numeric array values 
that are the points for the Y axis. The array name is given as a whole 
array reference, i.e., b&[], with no specific subscript. 

w Array -This group gives the starting and ending array subscripts for 
the Display XYPlot to use is determining the points to plot. 

Start: - An edit box where you enter the numeric expression that is 
index into the arrays of the first point to be plotted. This is an option- 
al field and if not given or out of bounds of either array, the default is 
zero (the first point of the array). 

w End - An edit box where you enter the numeric expression that is 
index of the last point to be plotted. This is an optional field and if 
not given or out of bounds of either array, the default is the last point 
of the smaller array. 

w Add - Select this pushbutton to place the plot name listed in the Plot 
Name edit box into the Selected Plot Names list. 

w Delete - Select this pushbutton to delete the plot name highlighted in 
the Selected Plot Names list box. 

w Change - Select this pushbutton to complete a change made to the 
plot name highlighted in the Selected Plot Names list box. 

Set Scaling - A pushbutton that opens the following dialog box, allow- 
ing you to select the axes' limits explicitly or let the display select the 
scaling. 

, .......................................... 
U I ~ u t o ~ c a l e  Axes/ ................................................ 

Horizontal Axis 

w Autoscale Axes - Select this check box to have the graphics 
display automatically calculate the axes scaling so that all graphs 
displayed are fully visible. 
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Horizontal Axis - The group name for the X axis scaling value edit 
boxes. 

m Max X: -An edit box where you enter the numeric expression 
that is the maximum X value that will be displayed without using 
scrolling. 

m Min X: - An edit box where you enter the numeric expression 
that is the minimum X value that will be displayed without using 
scrolling. 

w Vertical Axis -The group name for the Y axis scaling value edit 
boxes. 

Max Y: - An edit box where you enter the numeric expression 
that is the maximum Y value that will be displayed without using 
scrolling. 

OK - Select this pushbutton to complete the Set Scaling specifica- 
tion. 

w Cancel - Select this pushbutton to cancel the Set Scaling. 

Display Waveforms 

Select this item by pointing and clicking with the mouse or by pressing the V 
keyboard key. Display Waveforms opens the following dialog box, allowing 
you to select waveform variables to be displayed. With this step you can 
display up to ten different waveforms on the same graphical display. 

Edit Label Comment Options - 

Selected Waveforms: .............. 

... ;Ad dl 
, Set Scaling ............ E E  

Waveform Variable: 

Options - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the 0 key. Options opens the following Options menu allowing you to 
select waveform display enhancements that change the default display 
when the step is run. 
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Colors and Styles ... 
Labels ... I I 

w Grid - adds vertical and horizontal grids to the waveform display at 
each major vertical and horizontal scale mark. See page 4-1 11 for 
more information. 

Colors and Styles - This menu it allows you to select waveform 
display colors and line styles. See page 4-1 12 for more information. 

Labels -This menu item allows to change the waveform display 
title and the names of the X and Y Axes. See page 4-1 14 for more 
information. 

Selected Waveforms: -This list box provides a list of the waveform 
variables that have been selected for display. To change or delete a 
waveform variable, you double click on the variable name in this list box 
and then click on the appropriate pushbutton to the right of this list box. 

Waveform Variable -An edit box where you enter the variable name of 
the waveform to be displayed. This variable name must be an initialized 
waveform variable. 

Add - Select this pushbutton to place the waveform variable listed in 
the Waveform Variable edit box into the Selected Waveforms list. 

m Delete - Select this pushbutton to delete the waveform variable high- 
lighted in the Selected Waveforms list box. 

8 Change - Select this pushbutton to complete a change made to the 
waveform variable highlighted in the Selected Waveforms list box. 

m Set Scaling - A pushbutton that opens the following dialog box, allow- 
ing you to select the axes' limits explicitly or let the display select the 
scaling. 

Edit - 

, ................................................... 
U I ~ u t o ~ c a l e  % Axes: ............................................... 

Horizontal Axis Vertical Axis 1:: ~71 1 :;:;: 
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Autoscale Axes - Select this check box to have the waveform 
display automatically calculate the axes scaling so that all 
waveforms displayed are fully visible. 

Horizontal Axis -The group name for the X axis scaling value edit 
boxes. 

Max X: -An edit box where you enter the numeric expression 
that is the maximum X value that will be displayed without using 
scrolling. 

Min X: -An edit box where you enter the numeric expression 
that is the minimum X value that will be displayed without using 
scrolling. 

Vertical Axis -The group name for the Y axis scaling value edit 
boxes. 

Max Y: - An edit box where you enter the numeric expression 
that is the maximum Y value that will be displayed without using 
scrolling. 

Min Y: - An edit box where you enter the numeric expression 
that is the minimum Y value that will be displayed without using 
scrolling. 

OK - Select this pushbutton to complete the Set Scaling specifica- 
tion. 

Cancel - Select this pushbutton to cancel the Set Scaling. 

OK - Select this pushbutton to complete the Display Waveforms 
creation. 

m Cancel - Select this pushbutton to cancel the Display Waveforms. 

Display Data - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the D keyboard key. Display Data shows the following menu list, allow- 
ing you to select an item for display, and to add a user-defined caption or 
message to that display. 

I Continue ... I 
Remove - I 
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Wait ... - Select this menu item by pointing and clicking with the mouse, 
or by pressing the W keyboard key. Wait ... opens the following dialog 
box, allowing you to create a test procedure step that will display a 
message box containing a specified result (expression) and a message 
to the operator. Wait ... halts the test procedure until you point and click 
the mouse on either the OK or the Abort pushbuttons that appear in the 
message box. OK will allow the test procedure to continue, Abort will 
abort the test procedure. 

Edit l a b e l  Comment - 

Caption: 

Expression: 

I 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Caption: - An edit box where you enter the comment text that you 
want displayed to the operator. 

Expression: - An edit box where you enter the expression that you 
want displayed. (For example, if you enter a variable that you have 
assigned to a calculation step, the value of that variable at the time 
of the display step would be shown in the message box for the 
operator.) 
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OK - Select this pushbutton to complete the Wait ... creation. 

m Cancel - You can select this pushbutton to cancel the Wait .... 
Gontinue ... - Select this menu item by pointing and clicking with the 
mouse, or by pressing the C keyboard key. Continue ... opens the 
following dialog box, allowing you to create a test procedure step that 
will display a message box containing a specified result (expression) 
and a message to the operator. The test procedure will continue to run 
while the dialog box is displayed, and the specified expression will be 
continuously updated, as necessary. (You insert a Remove command 
into the test procedure to remove the dialog box display.) 

The first time a DISPLAY DATA step of type CONTINUE is executed, the 
data in the step is processed and the resulting information is shown in 
the Display Data execution dialog box. Subsequent DISPLAY DATA 
CONTINUE steps will update the information shown in the Display Data 
dialog box. Only one DISPLAY DATA CONTINUE step is allowed, as it 
will be updated with any new data. You can use a DISPLAY DATA 
WAIT step with the CONTINUE step; the Wait dialog box will cover the 
Continue dialog box. 

Edit Label Comment - 

Caption: 

Expression: 

I I 
Eel Ic.ncelj 

J 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

8 Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

m Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

Caption: - An edit box where you enter the comment text that you 
want displayed to the operator. 

Expression: - An edit box where you enter the expression that you 
want displayed. For example, if you enter a variable that you have 
assigned to a calculation step, the value of that variable is constantly 
updated and shown in the message box for the operator. The excep- 
tion to this is a waveform variable. A waveform variable can not be 
displayed with Continue ..., only with Wait .... 
OK - Select this pushbutton to complete the Continue ... creation. 

Cancel - Select this pushbutton to cancel the Continue .... 
m Remove - Select this menu item by pointing and clicking with the 

mouse, or by pressing the R keyboard key. Remove opens the following 
dialog box, allowing you to create a test procedure step that will remove 
a Continue ... message box from the display. 

Label Comment - 
.....,... . 

.......... 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

OK - Select this pushbutton to complete the Remove creation. 

Cancel - Select this pushbutton to cancel the Remove. 
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Prompt - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the P keyboard key. Prompt ... shows the following menu list, allowing 
you to select the type of prompt display created by this test step. The se- 
lected prompt will be displayed to the operator. 

Text ... - Select this menu item by pointing and clicking with the mouse, 
or by pressing the T keyboard key, Text ... opens the following dialog 
box, allowing you to select text as the Prompt type. 

Edit babel Comment - 
Mestage: 

Variable: j] 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 
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IPG provides the following dialog box items for user interaction: 

m Message: - An edit box where you enter a message for display to 
the operator when the test procedure is run. If the message exceeds 
75 characters on the outline display, the last three characters (of the 
75) and all remaining characters will be replaced with an ellipsis 
( . . . ). When this occurs on the outline display, the only way you can 
read the entire message is to double-click on the outline step to 
open the dialog box with the message in it, or print the procedure 
using the Full setting. 

Variable: - An edit box where you enter the name of a variable for 
storing an operator response. Entering this variable is optional. If 
you enter a variable name, you will have to enter a response in the 
Text Prompt dialog box when you execute the test procedure. If 
Variable: is a number the response must be a number, if a string, 
the response must be a string. If you use a string variable, you can 
enter a multiple line response and then press and hold the SHIFT 
key while pressing the ENTER key to terminate the response. 

OK - Select this pushbutton to complete the Text ... creation. 

Cancel - Select this pushbutton to cancel the l e  xt.... 

Picture ... - Select this menu item by pointing and clicking with the 
mouse, or by pressing the I keyboard key. Picture ... opens the following 
dialog box, allowing you to select a picture as the Prompt type. 

File Edit Label  Comment - 

File - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the F key. File opens the following File Menu, allowing you 
to load a picture file, save a picture file, or exit picture prompt. 

Save and Exit..- I 
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Load ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the L keyboard key. Load ... opens 
the following dialog box, allowing you to select an existing 
picture file (with a .BMP extension) to be loaded. This picture 
must be a bit-mapped picture file that is compatible for reading 
into a Windows environment. (You can use a bit-mapped image 
from the Windows clipboard with PICTURE PROMPT. After 
copying the image to the clipboard, initialize IPG and select 
Operator from the Main Menu bar, then Prompt ..., then Pic- - 

ture.. .. Select Edit from the Picture Prompt dialog box. Select 
Paste and the contents of the Windows clipboard will become 
visible in the dialog box. Select File, then Save and Exit .... Enter 
a name and a .BMP file will be created for the image. 

Picture Name: 

I I l  

1- .I 
[library] 
1- 0-1 
1- El 
1- d -1 
1-e-I 
[-f-] 

IPG provides the following dialog box items for user interaction: 

Picture Name: -An edit box where you enter the name of 
the picture file you want to load. 

The current drive and directory pathname above a list box 
containing file names you can select, or disk drives and 
directories that you can select to display other file names. To 
load a file, enter its name in the Picture Name: edit box and 
select the Load pushbutton, or point and click with the 
mouse on the file name in the list box, then select the Load 
pushbutton. 

Load - Select this pushbutton to load the picture file whose 
name is specified in Picture Name:. 

Cancel - Select this pushbutton to cancel the Load .... 
Save and Exit ... - Select this menu item by pointing and 
clicking with the mouse, or by pressing the S keyboard key. If 
the picture that is currently loaded has not previously been 
named, Save and Exit ... will open the following dialog box, 
allowing you to save the current picture file and exit the Operator 
Menu. If the picture is already named, Save and Exit ... just exits 
the Operator Menu. 
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Link Menu 

Cancel - Select this menu item by pointing and clicking with 
the mouse, or by pressing the C keyboard key to cancel the 
Prompt. - 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit causes a one item menu to appear, contain- 
ing Paste Picture. Select this item by pointing and clicking with the 
mouse, or by pressing the P keyboard key. Paste Picture allows 
you to transfer a picture from the clipboard and convert it to a 
bit-mapped image (.BMP file) for use in IPG. You can use any 
bit-mapped picture that can be copied to the clipboard. 

m Label - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the L key. Label allows you to add labels to this step. Refer 
to the Common Dialog Boxes description (given at the beginning of 
this section) for the menu and information on its use. 

m Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the C key. Comment allows you to add comments to this 
step. Refer to the Common Dialog Boxes description (given at the 
beginning of this section) for the menu and information on its use. 

The following Link Menu appears when you select the Link menu item from 
the Main Menu bar by pointing and clicking the mouse, or by pressing and 
holding the ALT keyboard key while pressing the L key. This menu allows 
you to access the Excel Menu from which you can create Dynamic Data 
Exchange steps between TekTMS and Microsoft Excel 

I Send ... I 
I Close ... I 

TekTMS Interactive Procedure Generator User Manual 4- 79 



Send 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the S keyboard key. Send ... opens the following dialog box, allowing you 
to enter the data required to establish a Dynamic Data Exchange test proce- 
dure step. This step provides the ability to transfer data to a specific Excel 
spreadsheet cell location on an Excel spreadsheet designated in the dialog 
box. Typically one, or more equipment variable values or test result values 
are obtained during preceding test steps. These values may be stored on 
Excel spreadsheets for subsequent manipulation or reuse. 

Edit Label Comment - 

File Name: Macro 

1 I 
Cell Reference: 

I 
Data Value: 

H Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

H Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the, 
menu and information on its use. 

H Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 
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File Name: -This contains the Excel spreadsheet name in the form of 
a string expression. If this spreadsheet already exists then the step will 
instruct Excel to open it. If this spreadsheet does not exist then the step 
will instruct Excel to create a new (empty) spreadsheet and name it 
using this name. Note that all Excel spreadsheet names end with the a 
file extension of "XLS". This extension should not be included in this 
dialog box item. 

Cell Reference: - This contains the Excel data cell location in the form 
of a string expression. The string may identify a specific cell in the format 
expected by Excel. For example if the data is to be positioned in row two 
and column three then this string value would be "$C$2". 

This particular cell location on the Excel spreadsheet could also be 
given an English like name such as "Volts" by customizing the spread- 
sheet in Excel This cell name could then be used in the string entered in 
this dialog box item. 

m Macro File Name - This contains an Excel macro file name in the form 
of a string expression. The macrofile must be created before step execu- 
tion. 

MacroName - This contains an Excel macro name in the form of a 
string expression. The Excel macro must be created and named on the 
macro sheet before step execution. 

D Data Expression - This contains the TekTMS string or arithmetic 
expression from which the test program expects the program to get the 
data to be sent to the Excel cell location. 

8 Macro - This checkbox indicates that an Excel macro is to be 
executed. If this checkbox is checked then the step will be presented 
with Macro File Name and MacroName items. Otherwise the step will 
be presented with File Name and Cell Reference items. 

When running a macro, you can stop the execution of TekTMSIIPG at 
any time by entering Control "C". You can then go to Excel and stop the 
macro if needed by pressing ESC. 
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Edit Label Comment - 

Macro File Name: Macro 

1 
MacroName: 

0 
n332 'v3?ut: 

: 
OK - Select this pushbutton to complete the Send ... creation 

Cancel - Select this pushbutton to cancel the Send .... 

Read 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the R keyboard key. Read ... opens the following dialog box, allowing 
you to enter the data required to establish a Dynamic Data Exchange test 
procedure step. This step provides the ability to transfer data from a specific 
Excel spreadsheet cell location on the Excel spreadsheet designated in the 
dialog box. Typically one, or more equipment variable values or test result 
values are obtained during preceding test steps. These values may be 
obtained from the Excel spreadsheets for subsequent manipulation or reuse 
in the step. 

File Name: 

Cell Reference: 

n 
Data Value: 

v 
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Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

w Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

w Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

w File Name: - This contains the Excel spreadsheet name in the form of 
a string expression. This spreadsheet must exists in order for the step to 
instruct Excel to open it. If this spreadsheet does not exist then the step 
will fail. 

Cell Reference: - This contains the Excel data cell location in the form 
of a string expression. The string may identify a specific cell in the format 
expected by Excel. For example if the data is to be positioned in row two 
and column three then this string value would be "$A$3". 

This particular cell location on the Excel spreadsheet could also be 
given an English like name such as "Volts" by customizing the spread- 
sheet in Excel This cell name could then be used in the string entered in 
this dialog box item. 

w Data Expression -This contains the TekTMS string or arithmetic 
expression into which the test program expects the step to put the data 
read from the Excel cell location. 

w OK - Select this pushbutton to complete the Read ... creation 

w Cancel - Select this pushbutton to cancel the Read .... 

Close 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the C keyboard key. Close ... opens the following dialog box, allowing 
you to enter the data required to establish a Dynamic Data Exchange test 
procedure step. This step provides the ability to close the Excel spreadsheet 
designated in the dialog box. 
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File Name: 

c 
Save As: 

v 
Edit - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the E 
key. Edit allows you to edit the dialog box items. Refer to the Edit Menu 
description (previously given in this section) for the menu and informa- 
tion on its use. 

Label - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the L 
key. Label allows you to add labels to this step. Refer to the Common 
Dialog Boxes description (given at the beginning of this section) for the 
menu and information on its use. 

Comment - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while pressing 
the C key. Comment allows you to add comments to this step. Refer to 
the Common Dialog Boxes description (given at the beginning of this 
section) for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

m File Name: - This contains the Excel spreadsheet name in the form of 
a string expression. This spreadsheet must exists in order for the step to 
instruct Excel to close it. If this spreadsheet does not exist then the step 
will fail. 

Saved As: -This contains the Excel spreadsheet name in the form of a 
string expression. This is the file name to be used by Excel to save this 
particular spreadsheet in the form of a disk data file. 

Save Document - This is a checkbox that, when checked, instructs 
this step to save the spreadsheet as a disk file. 

OK - Select this pushbutton to complete the Read ... creation 

m Cancel - Select this pushbutton to cancel the Read .... 

4-84 Menus 



Instruments Menu The following Instruments Menu appears whenever you select the Instru- 
ments command from the Main Menu bar by pointing and clicking with the 
mouse or by pressing and holding the ALT keyboard key while pressing the 
I key. The lnstruments Menu opens the following menu list, allowing you to 
select instrument drivers from a list of available drivers. These drivers con- 
tain instrument front panel views used by IPG for configuring instruments 
and creating test procedure steps. 

yiew .-- 
Emulate ... - 
mI Controller b 

Select - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the S keyboard key. Select ... opens the following dialog box, allowing 
you to select instruments for a test procedure, edit the current selection list, 
or edit parameters of instruments in the selection list. 

TMS Name Driver Addre sr 

Drivers: TMS Name: 

c:\ipg 
= 

< 

IPG provides the following dialog box items for user interaction: 

A list box identified by the column headers: TMS Name, Drivers, Port, 
and Address. This list box displays the instruments that you have se- 
lected for the test procedure. 

Drivers: -An edit box where the instrument driver file name (with an 
.ISD extension) appears when you select it from the available instru- 
ments list box. To select a driver file, point and double-click the mouse 
on the file name in the list box (or enter the name and press the RE- 
TURN keyboard key). This will cause the file name to appear in the 
Drivers: edit box, and an entry to appear in the Port: edit box. 
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The current drive and directory path and a list box below that show the 
available instrument driver files you can select. The list box also contains 
disk drives and/or directories where other files can be found. 

Port: -An edit box in which appears the communications path for the 
instrument you have selected. (For example, entries in this box may 
include GPIBO, GPIB1, VXI, etc.) 

Address: - An edit box where you enter the address for the selected 
instrument, a Device Name for a VXI instrument, etc. When you select a 
GPlB instrument, you will need to enter the Primary: and Secondary: 
addresses. When you select a VXI instrument, you will need to enter a 
Device Name:. The IPG will provide the correct entry box for the instru- 
ment you have chosen. 

If the ISD file has VXllNTERNAL or MXI as the bustype and the controller 
type is TeMronix VXI, address selection consists of a combination box 
containing a list of instruments found by the VXI resource manager. You 
may either select one of the instruments from the list or you may type in 
a name of your own. Supplying a name of your own is useful if you are 
developing tests off line. If the controller is CDS VXI then the address 
selection consists of a combination box for the ULA (Unique Logical 
Address). The combination box contains a list of all the instruments 
found by the VXI resource manager. This list has the ULA and the instru- 
ment slot number. You may either select an instrument from the list, or 
enter a ULA. The address edit box must contain a number for the se- 
lected instruments ULA. You do not have to add the slot number when 
specifying an instrument not in the list. 

If the ISD file has GPIB or VX5520 as the bustype, address selection 
consists of two edit boxes. One edit box is for the primary GPlB address 
and the other is for the secondary GPlB address. You must give a prima- 
ry address, but you may leave the secondary address edit box empty if 
you are not using secondary GPlB addressing. 

If the ISD file has CDSBUS as the bustype, address selection consists of 
two edit boxes. One edit box is for the cage number and one is for the 
slot number. You must enter values in both edit boxes to specify a 
particular instrument. 

If the ISD file has RS232 as the bustype, no address selection is made. 

NOTE 

Some VXI test systems have controllers or resource managers that 
assign a Device Name: to an instrument at power-up, and make 
provisions for that name to be changed on command. IPG users 
should be aware of the Device Name: assigned to an instrument in 
the particular VXI system being used. 

If a VXI system is configured by a TeMronix VX5520 Slot 0 Resource 
Manager; it assigns a Device Name: of DEVxx, where xx is a 
two-digit numeric value sequentially assigned by the VX5520. The 
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VX5520 also provides you with the capability to query for the name 
assigned by the system, or to change that name to a specific name, 
such as "VX5260". 

If a VXI system is configured by a TeMronix VX453x (or VX553x) 
System Controller, it assigns a Device Name: of V57DEVx, where x 
is a numeric value (may be one or more digits) assigned by the 
VX453x (or VX553x). The VX453x (or VX553x) also have provisions 
for querying for the name and changing it. 

When you use W systems in a test system, it is possible for the 
Device Name: of any particular W instrument to change during 
each system power-up. For example, if you change the instrument 
combination in the system, or an instrument location in a main- 
frame, the configuration that occurs on power-up may change the 
Device Name: of some or all the instruments. I f  this name change 
occurs, you would need to verify those test procedure steps using 
the VXI system contained the correct Device Name:. 

H TMS Name: -An edit box where you enter a name (such as DMM1) 
that is to be assigned to the selected instrument for the current test 
procedure step. This wave must be unique. 

m Add - Select this pushbutton to add a highlighted instrument identified 
in the Drivers:, Port:, Address:, and TMS Name: edit boxes to the 
selected instruments list box. As you Add instruments, they will appear 
in the selected instruments list box. You can Add multiple instruments 
before selecting the OK pushbutton to complete the command. 

m Delete - Select this pushbutton, then select the OK pushbutton, to 
delete a highlighted instrument from the selected instruments list box. 
When you Delete an instrument, it is no longer available to the test 
procedure. 

H Change - Select this pushbutton to implement changes made to the 
Port:, Address:, or TMS Name: parameters of a highlighted instrument 
driver. 

OK - Select this pushbutton to complete the Select .... When you are 
adding instruments to the selected instruments list box, you do not need 
to select the OK pushbutton until you have selected all the instruments 
desired. 

H Cancel - Select this pushbutton to cancel the Select .... 

View 

View displays a list of selected instrument names. Select the instrument you 
wish to see from the list and the front panel for that instrument will appear. 
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Emulate 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the E keyboard key. Emulate ... opens the following dialog box, allowing 
you to select an interactive operational mode where you emulate the test 
instrumentation when a test procedure is run. This allows you to run, test, 
and debug a test procedure without connecting actual test instruments. In 
this mode, you must input simulated instrument responses through a Read 
Emulation dialog box or from a file containing the required input entries. 
(Each Instrument response from a file is limited to 51 0 characters, or is 
delimited by a CRLF.) Use emulation in conjunction with the Trace function 
(from the Debug Menu) to monitor the communications between the test 
procedure and the instrument. 

The entries in this dialog box determine whether the Emulate mode is en- 
abled or disabled, and if enabled, whether you input simulated instrument 
responses through a Read Emulation dialog box (see Section 4, Running a 
Test Procedure), or whether the responses are input automatically from a 
file. 

[7 Read from file 

File: 1 1 

IPG provides the following dialog box items for user interaction: 

Emulation On - Select this check box to enable the Emulation; when 
this box is not selected, Emulation is disabled. If you select this check 
box, then select the OK pushbutton, you will need to supply the input 
will be through a Read Emulation dialog box. 

m Read from file - Select this check box to enable the Read from File 
Emulate mode. When you have selected Read from file, the OK push- 
button is displayed in gray until an entry is made in the File: edit box. 
After you enter a pathname in the File: edit box, then the OK pushbut- 
ton will return to an active state (be displayed in black). You then select 
OK, and IPG will expect inputs from the file you have entered. 

m File: -An edit box where you enter the file path name. This edit box 
automatically scrolls horizontally to accept up to 128 characters. This file 
that you enter must be an ASCll file using CRLF line termination. IPG 
automatically stops reading a response line at 51 0 characters, or at a 
CRLF. If you use MS Windows Write to create the file, you must select 
the file type ASCII Only. 

OK - Select this pushbutton to complete the Emulate action. 
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Cancel - Select this pushbutton to cancel the Emulate. When you 
select Cancel, the Emulate mode reverts to its previous status before the 
dialog box appeared. 

lnstruments Controller Menu 

PC Controller LTLl 

Emulate ... - 

The lnstruments Controller menu provides the following choices of instru- 
ment controller: 

II 

H Tektronix VXI - includes embedded VXlbus controllers such as the 
Tektronix VX4530, VX4535, VX5530, VX5535, and Radisys EPC-2. 

m CDS VXI - includes embedded VXlbus controllers such as the 
CDS 73A- 161 and the TekICDS VX4542 and VX4544. 

H CDS BUS - includes embedded CDSBUS controllers such as the 
53B-ACX and 53B-ACZ. 

PC Controller - includes any PC compatible with a National Instru- 
ments GPlB interface card. 

The combination of controller type and ISD file bus note specifies the type of 
instrument interface used to communicate with connected instruments. For 
example: 

Tektronix WINXIINTERNAL - If Tektronix VXI is selected as the instru- 
ment controller and a VXIINTERNAL bus note is in the ISD file selected 
in the lnstruments Select dialog, then the Radisys Message Delivery 
System is used to perform 110 with VXlbus instruments. 

CDS VXlAlXllNTERNAL - If CDS VXI is selected as the instrument 
controller and a VXllNTERNAL bus note is in the ISD file is selected in 
the lnstruments Select dialog, then the CDS VXlbus 110 routines are 
used to perform 110 with VXlbus instruments. 

CDS BUSICDSBUS - If CDS BUS is selected as the instrument con- 
troller and a CDSBUS bus is not in the ISD file selected in the Instru- 
ments Select dialog, then the CDS BUS I10 routines are used to 
perform I10 with CDSBUS instruments. 
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Any ControllerIGPIB - If any of the controller types is selected and a 
GPIB bus note is in the ISD file selected in the Instruments Select dialog, 
then the National GPlB interface routines are used to perform I10 with 
GPlB instruments. 

The controller type selection is also used by TekTMSIRTG and TekTMSIIDG 
to determine the appropriate instrument I10 functions to call when generat- 
ing C code for PRG and ISD files respectfully. 

If Tektronix VXI is chosen, then the generated I10 calls for ISD files with a 
VXllNTERNAL busnote block will use routine calls with the format TekV- 
Xlfunction. 

If CDS VXI is chosen, then the generated 110 calls for ISD files with a 
VXllNTERNAL busnote block will use routine calls with the format 
TekCDSfunction. 

If CDS BUS is chosen, then the generated I10 calls for ISD files with a 
CDSBUS busnote block will use routine calls with the format TekCDS- 
BUSfunction. 

For ISD files with a GPlB busnote block the generated I10 calls will have 
the format TekGPIBfunction. 

TekTMSIRTG and TekTMSIIDG read a value from the WIN.INI file to deter- 
mine the type of controller selected. In the WIN.INI file selection [TekTMSI 
IPG] and keyword VXI: one of several entries is allowed. These entries are 
TEKTRONIX, CDSVXI, CDSBUS, and PC. 

A test may be developed to run on a specific type of instrument controller on 
any controller type by choosing the desired target controller from the Instru- 
ments Controller menu. The test can be executed by using the Emulation 
option in the Instruments menu to direct instrument responses to come from 
a dialog box on the controller screen or to read instrument responses from a 
data file. 

Run! Menu Run! executes the current test procedure. Other menu choices are disabled 
until the test procedure run is complete. Run clears any variable values and 
initializes the run time stack. If the test procedure has been changed, you 
are asked if you wish to save the change before running the test. 

- 

Debug Menu The Debug menu contains several items useful in debugging test proce- 
dures. These items include control of single step execution, examination of 
variables, breakpoints, and tracing bus communications. The following 
picture shows the Debug menu. In this example, the Debug menu item is 
checked. This means that TekTMSIIPG is in debug mode. When in debug 
mode, TekTMSIIPG disables all other main menu items. This prevents you 
from attempting operations that are not allowed when in debug mode. 

Menus 



3 NOMINAL 3.6 HIGH 4 

The Debug menu contains the following selections: 

Debug 

Debug is either ON (checked) or OFF (not checked). If checked, TekTMSI 
IPG is in debug mode and the other debug menu items are enabled. If 
TekTMSIIPG is not in debug mode (the default) then the Debug menu items 
Restart, Continue, Next, Step, and Examinelchange are not enabled. You 
may trace bus communications or set and remove breakpoints without 
being in debug mode. 

Restart 

Restart the test procedure from the Begin Procedure step. The test proce- 
dure will run until it reaches the end of the test or until a breakpoint is en- 
countered. 

Continue 

Continue execution of the test from the current step. The test procedure will 
run until it reaches the end of the test or until a breakpoint is encountered. If 
no steps have been executed since entering debug mode, this has the 
same effect as Restart. 

Step 

Step single steps the test procedure. If the step to be executed is a Call 
Procedure, the called procedure is shown in the outline view and the Begin 
Procedure step is highlighted. 
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Next 

Next single steps the test procedure. If the step to be executed is a Call 
Procedure, the called procedure is executed without being shown and 
execution is halted when the called procedure returns. 

Examinelchange will bring up another dialog. This dialog shows all the test 
procedure variables that have been created up to current test step. A vari- 
able does not appear in this dialog until it has a value assigned to it. At the 
beginning of a debug session only the default global variable PassFail will be 
displayed. When Examinelchange is selected, the TekTMSIIPG outline view 
window is reduced in size to accommodate this dialog. Usually the screen is 
split vertically with the left half the TekTMSIIPG outline view and the right half 
the Examinelchange dialog. 

New Value: 

Variable I Value: 

freq$ " 10." 
gaincal 4. 
gainpf 1. 
index& 0 
output 77. 
PassFail 1. 

VariableNalue: lists all current test procedure variables. A variable is 
not listed until it has been assigned a value. If one of the variables in the 
list is selected, its value is placed into the New Value edit box. If the 
variable entry is an array, double clicking on the array entry will bring up 
the Examinelchange Array Variable dialog. 

New Value: lets you change the value of the variable selected in the 
VariableNalue list box. The new value will be evaluated and the variable 
updated when the Change button is pressed. 

Change will check the value of the expression in the New Value edit 
box, and if it is compatible with the selected variable type, will update 
the variable with the new value. If the expression is not valid, or the type 
is not correct, then the appropriate error messages are displayed. 
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rn Expressions ... will bring up a dialog like the following one, that shows 
the last three expressions evaluated during debug execution and their 
value. Use this to determine the value of complex expressions or the 
value of IF THEN ELSE and WHILE DO expressions. 

rn Examinelchange Array Variables dialog shows the values of individual 
array elements. This dialog appears when you double click on an array 
entry in the Examinelchange variable list box. 

Variable I Value: Sta 

-Change 71 

VariableNalue is a list of the array entries and their values. Select- 
ing one of the list entries will place the value of that array element 
into the New Value edit box. 

rn New Value lets you change the value of the variable selected in the 
VariableNalue list box. The new value will be evaluated and the 
variable updated when the Change button is pressed. 

Change will check the value of the expression in the New Value edit 
box, and if it is compatible with the selected variable type, will up- 
date the variable with the new value. If the expression is not valid, or 
the type is not correct, then the appropriate error messages are 
displayed. 
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Start allows changing the starting element number of the displayed 
array elements. If the array displayed is large, you may wish to limit 
the amount of data displayed. This can cut down on the time it takes 
to reach a specific array element to display or change that element's 
value. 

End lists the value of the number of the last array element displayed. 

Position will display the array element list VariableiValue starting at 
the array entry shown in the Start edit box. 

OK will close the Examinelchange Array Variables dialog. 

Main Test 

Main Test will bring up the starting main test procedure. If you have traced 
execution into a called procedure, this menu item will reload the main test 
procedure. This is useful if an execution error occurred during execution and 
you want to return to the main test with out having to use the File menu 
Open command. This way of returning to the main test is faster than doing a 
File menu Open. This item can be used even if debug is not on. 

Set Breakpoint 

Set Breakpoint sets the breakpoint symbol (a lower case 'b' by the outline 
view entry for a test step) on all selected test steps. While you are in debug 
mode, a breakpointed step will stop execution. In standard Run mode, 
breakpointed steps do not stop execution. A breakpoint will be saved with 
the step when the test procedure is saved. When you are in debug mode 
and execute a Call Procedure step that has a breakpoint in the called test, 
execution will halt at the breakpointed step. 

Remove Breakpoint 

Remove Breakpoint removes the breakpoint symbol from all selected 
steps. 

Remove All Breakpoints 

Remove All Breakpoints removes the breakpoint symbol from all test steps 
in the current test procedure. 

Trace Bus 

Trace Bus lets you turn ON (checked) or turn OFF (not checked) bus com- 
munications tracing. Bus communication tracing shows all bus dialogs 
(reads and writes with instruments) in a window. 

~p 
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Options Menu The following Options Menu will appear whenever you select the Options 
menu item from the Main Menu, or by pressing and holding the ALT key- 
board key while pressing the P key (while in the Main Menu). This menu 
allows you to select or exit the Remarks Only function: 

Remarks Only 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the M keyboard key. Selecting Remarks Only (which is indicated by a 
check mark (J)  in front of the command), will cause only Remarks steps to 
be displayed. Selecting Remarks Only again (causing the check mark (J)  
to disappear), will cause all test procedure steps to be displayed. 

Globals - 

Selecting this menu item will bring the Global Variables dialog to the top of 
the screen. 

Translate Menu The following Translate Menu will appear whenever you select the Translate 
menu item from the Main Menu, or by pressing and holding the ALT key- 
board key while pressing the T key (while in the Main Menu). The Translate 
Menu allows you to convert test procedures and instrument driver files to the 
C programming language for use with the TekTMS Run Time Generator 
(RTG) package. 

NOTE 

You must have the TekTMS RTG software to use these commands. 
If you attempt to use the commands in this menu without the RTG, 
you will get an error message. 

I Start !DG ... I 
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Start RTG 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the R keyboard key. Use this command to start the RTG application to 
convert program (.PRG) files. 

Start LDG 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing the I keyboard key. Use this command to start the IDG application to 
convert driver (.ISD) files. 

NOTE 

For further information, refer to the Run Time Generator (RTG) 
Users Manual. 

Help Menu You can access the Help Menu by pressing the F1 keyboard key when you 
have a dialog box opened from the Operator or Actions Menus. When you 
select Help, a message box will appear giving information about the dialog 
box you currently have open. 

Instrument Front The contents of the Instrument Front Panel Menu will depend upon the 

Panel Menu instrument front panel view you select. An instrument front panel view with 
an associated lnstrument Front Panel Menu appears whenever you perform 
one of the following sequences: 

Sequence A 

1. You select lnstruments from the Main Menu bar (an lnstruments Menu 
will appear), then: 

2. You select View ... from the lnstruments Menu a list of related instru- 
ments appears. 

3. You highlight an instrument name. 

Sequence B 

You point to and double-click with the mouse on an lnstrument Front Panel 
Driver Icon at the display bottom. 
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Sequence C 

You point to and double-click with the mouse on a test procedure SETTING 
or MEASUREMENT step for the instrument whose front panel you want to 
view. 

What This Menu Does 

An instrument front panel display allows you to select or enter values for 
setting the controls on a specific test instrument. The associated Instrument 
Front Panel Menu allows you to perform the following: 

Select the type of procedure step to create (setting or measurement) 

Select the interaction mode with the instrument: lnteractive (online), 
Setting Only (online), Measurement Only (online), or No Interaction 
(offline) 

Assign program variables to the instrument controls 

Select the instrument front panel view to be displayed 

Select Help 

Select a one-time or automatic mode for updating instrument control 
settings on the view display 

Example 

The following instrument front panel display is representative only, as the 
front panel view for each instrument may be different. Some instruments 
may have a front panel view similar to the instrument front panel physical 
layout, while others may have a functional view, or one instrument may have 
multiple views. 

DM5120 1 C  UOLTMETER 

Measurement 

TekTMS Interactive Procedure Generator User Manual 4-97 



Step - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the S key. Step 
causes the following menu to appear, allowing you to select the type of 
instrument test procedure step (setting, learn, or measurement) you want to 
create for the current instrument selection and setting view. 

Saye Selected Settings... 
Learn Settings ... - 

Saue fi21 Measurements 
Save Selected Measurements... 

Close - 

Save All Settings - Select this menu item by pointing and clicking with 
the mouse, or by pressing the A keyboard key. Save All Settings 
creates a test procedure step that saves the settings of all instrument 
controls as they appear in the current Instrument Front Panel view. 

NOTE 

If any instrument control appears in more than one view, its current 
setting will always be the last setting made in a view where the 
setting for that control name was saved. 

Save Selected Settings ... - Select this menu item by pointing and 
clicking with the mouse, or by pressing the V keyboard key. Save Se- 
lected Settings ... opens the following dialog box, allowing you to select 
the instrument controls that are set by the test procedure step. 

S e l e c t e d  C o n t r o l  

acv th ree  
aovrange 

I- 
( D e l e t e  ) 

C & 
C a n c e l  ) 
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IPG provides the following dialog box items for user interaction: 

Control List - A  list box containing the names of the instrument 
controls that are defined in the Setting View Block of the currently 
selected instrument driver (.ISD) file, and available for you to selec- 
tively save in the test procedure. 

Selected Control - A  list box containing the names of the instru- 
ment controls that the test procedure has selected to be set. The 
order in which the controls are selected determines the order in 
which the settings are sent to the instrument when the procedure 
executes. To select a control, highlight its name in the Control List 
and select the Add pushbutton. (You can also point and 
double-click the mouse on the control name to add it.) 

NOTE 

The order of the controls in the Selected Control list determines the 
order the setting will be made. 

Add - Select this pushbutton to add a highlighted name in the 
Control List to the Selected Control list. 

Add All - Select this pushbutton to automatically add all the names 
in the Control List to the Selected Control list. The names are 
added whether you have highlighted them or not. 

Delete - Select this pushbutton to delete a highlighted name from 
the Selected Control list. 

OK - Select this pushbutton to complete the Save Selected Set- 
tings .... 

Cancel - Select this pushbutton to cancel the Save Selected 
Settings .... 

Learn Settings ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the L keyboard key. learn Settings ... opens 
the following dialog box, allowing you to query the instrument for its 
current settings as defined in the Learn Block in the instrument driver 
(.ISD) file, edit the settings (if desired), and create a test procedure step 
that will set the instrument to the learned settings. 
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Edit - 

Learn S t r i n g s :  

 e earn S e t  t i n s s  

8 Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Learn Strings: -An edit box where the current instrument settings 
(as defined in the Learn block of the instrument driver (.ISD) file) will 
appear when you select the Learn Settings pushbutton and the test 
procedure returns the selected instrument's settings. You can edit 
the settings after they are returned, if they are in ASCII format. 

8 Learn Settings: - Select this pushbutton to query the instrument 
whose front panel is displayed for its front panel settings. When 
queried, the instrument returns its current settings (displayed in the 
Learn Strings: edit box). This control is displayed in gray if the 
instrument driver (.ISD) file does not contain a Learn block. 

8 OK - Select this pushbutton to complete the Learn Settings .... 
8 Cancel - Select this pushbutton to cancel the Learn Settings .... 

8 Save All Measurements - Select this menu item by pointing and 
clicking with the mouse, or by pressing the L keyboard key. Save All 
Measurements creates a test procedure step that queries the instru- 
ment for the current measurement value(s) for controls defined by the 
Measurement blocks in the currently selected instrument front panel 
view. 

8 Save Selected Measurements ... - Select this menu item by pointing 
and clicking with the mouse, or by pressing the C keyboard key. Save 
Selected Measurements ... opens the following dialog box, allowing you 
to selectively save the values returned by the instrument for controls 
defined in the Measurement block of the currently selected instrument 
driver (.ISD) file. 
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The measurement data from the instrument will be placed into an IPG 
variable. IPG can generate the variable automatically, or you can name it 
yourself. If IPG generates the variable, the name will be of the form 
'~TMSname.controlP/PE', where the name starts with the letter 'I' 
followed by the TMS Name of the instrument. Following the period, is the 
name of the selected control, then the type designator, which is either '# '  
(f 1 oa ting p o i n t  number), '&' ( in teger) ,  '$ '  ( s t r i ng ) ,  Or I - '  

(waveform). Use the Variables Menu to assign a name to a control. 

Control L i s t  

acufilt ... 
acurange 

S e l e c t e d  Control 
lacureading 141 

( A d d  A l l  ) 

[ D e l e t e  

1 OK 1 

IPG provides the following dialog box items for user interaction: 

w Control List - A  list box containing the names of instrument con- 
trols (including indicators) that are defined in the Measurements 
block of the currently selected instrument driver (.ISD) file, and 
available for you to selectively save in a test procedure. 

w Selected Control - A  list box containing the names of the instru- 
ment controls you have selected to be saved for the test procedure. 
To select a control, highlight its name in the Control List, then select 
the Add pushbutton. (You can also point and double-click the 
mouse on the control name to add it.) 

NOTE 

The order in which the Control List names are selected determines 
the order in which measurements are made. 

Add - Select this pushbutton to add a highlighted name in the 
Control List to the Selected Control list. 

w Add All - Select this pushbutton to automatically add all control 
names in the Control List to the Selected Control list. These 
names will be added whether you have highlighted them or not. 

w Delete - Select this pushbutton to delete a highlighted name in the 
Selected Control list. 

w OK - Select this pushbutton to complete the Save Selected Mea- 
surements .... 
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Cancel - Select this pushbutton to cancel the Save Selected 
Measurements .... 

Edit - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the E key. Edit allows 
you to edit the dialog box items. Refer to the Edit Menu description (pre- 
viously given in this section) for the menu and information on its use. 

Close 

Select this menu item to close the Step Menu. 

lnteraction 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the I keyboard key. 
lnteraction causes the following lnteraction Menu to appear, allowing you to 
select the type of instrument interaction that will occur when you manipulate 
the front panel controls on the instrument front panel display and create the 
step. 

Monitor O n l y  - 
No Interaction - 

Full lnteraction - Select this menu item by pointing and clicking with 
the mouse, or by pressing the F keyboard key. Full lnteraction places 
the instrument on line and selects a setting and measurement instru- 
ment interaction mode where any changes to the instrument front panel 
view are sent to the instrument (setting mode), and any changes that 
occur at the instrument (measurements), that are represented in the 
front panel view, are returned to update the view display. The controls 
that represent the current instrument settings are highlighted. This mode 
is similar to making hands-on, real-time control settings and measure- 
ments using a nonprogrammable, stand-alone instrument. 

Setting Only - Select this menu item by pointing and clicking with the 
mouse, or by pressing the S keyboard key. Setting Only places the 
instrument on line and selects an instrument setting only mode where 
any changes to the instrument front panel view are sent to the instru- 
ment (setting mode), but the instrument does not return any changes 
(measurements) to update the view display. The controls that represent 
the current instrument settings are highlighted. This is similar to making 
hands-on, real-time control setting on a stand-alone instrument without 
making a measurement. 
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Monitor Only - Select this menu item by pointing and clicking with the 
mouse, or by pressing the M keyboard key. Monitor Only places the 
instrument on line and selects an instrument measurement only mode 
where the instrument is queried for and returns any changes to update 
the instrument controls represented on the view display (measure- 
ments), but changes to the controls on the front panel view are not sent 
to the instrument (settings). This mode is similar to making hands-on, 
real-time measurement using a nonprogrammable, stand-alone instru- 
ment without changing its current settings. 

No lnteraction - Select this menu item by pointing and clicking with 
the mouse, or by pressing the N keyboard key. No lnteraction places 
the instrument off line. This command disables both the setting and/or 
measurement interactive modes with the actual instrument. Control 
setting changes made in this mode change the instrument front panel 
view displays, but do not send any commands to the instrument, and do 
not query the instrument for any changes to its measured values. 

Update! 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the U key. Update! 
queries the instrument in the current instrument front panel view display, and 
uses the returned front panel control values (measurements) to update the 
display. (Refer to the previous lnteraction description for more information 
on when and if the measurements are updated.) 

Variables 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the V keyboard key. 
Variables causes the following Variables Menu to appear, allowing you to 
assign a test procedure variable name to an instrument control on the 
current front panel view display. Once you have assigned a variable to a 
control, information is passed between the test procedure and the instru- 
ment through that variable. For example, during a setting step, the contents 
of the variable are sent to the Setting block in the instrument driver file, 
which sends the command to the instrument to set the control. During a 
measurement step, the value returned from the instrument is stored in the 
variable. 

Current View.. . - 
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Current Control ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the C keyboard key. Current Control ... 
opens the following dialog box, allowing you to assign a test procedure 
variable name to whichever control had the focus in the current instru- 
ment front panel view when you selected this command. The focused 
control selection can be changed before selecting this command by 
pointing and clicking the mouse on another control name, or by press- 
ing the TAB keyboard key to focus on another control name. The control 
name focus changes each time you press the TAB key. To assign vari- 
ables to multiple controls, use Current View .... 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

E d i t  - 
C o n t r o l  I d :  a c u r a n g e  

IPG provides the following dialog box items for user interaction: 

U a r i a b l c :  

Control Id: - A  list box containing the name of the focused control 
that will be assigned a variable name. 

ac,,,,lts 

Variable: - An edit box where you enter the test procedure variable 
name for the control listed in the Control Id: list box. The variable 
name must have the correct data type suffix, or an error message 
specifying the data type required will appear. The first character of 
the variable name must be alphabetic, while the following characters 
can be alphanumeric. The name can have up to 255 characters, 
however, the first 32 characters must be unique. 

OK - Select this pushbutton to complete the Current Control ... 
action. 

Cancel - You can select this pushbutton to cancel the Current 
Control .... 

Current View ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the U keyboard key. Current View ... opens 
the following dialog box, allowing you to assign, delete, or edit test 
procedure variable names for all instrument controls on the current view 
display. 
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Edit - 

ControlId Uariable 

acvreading 
acvthree 

C o n t r o l I d :  U a r i a b l e :  - 
I-j [DK] 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

Control ID-Variable - A  list box containing the names of the instru- 
ment controls and their currently assigned variables. 

B Control id: - A  list box containing the name of the focused control 
to be assigned a variable name. 

Variable: - An edit box where you enter the test procedure variable 
name to be assigned to the control name in the Control id: list box. 
If a variable name was previously assigned to the desired control 
name, it will appear in this box when you select the control name 
from the Control ID-Variable list box. You can edit any name in this 
box with the Edit command, or by editing with the keyboard, then 
selecting the Change pushbutton. Any new or changed variable 
must have the correct data type suffix, or an error message will 
appear indicating the correct data type required. 

The variable name must appear in the right hand column of the list 
box before IPG can use it. (If it does not appear there, make certain 
that you have the correct entries in the Control Id: and Variable: 
edit boxes, then select Change.) 

Change - Select this pushbutton to complete keyboard editing of a 
variable in the Variable: list box, or the addition of a variable to a 
control name. 

OK - Select this pushbutton to complete the Current View ... ac- 
tion. 

B Cancel - Select this pushbutton to cancel the Current View .... 
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Help - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the U keyboard key. 
Help causes the Instrument Front Panel Help Menu for the displayed instru- - 
ment to appear. The commands contained in this menu depend upon the 
contents of the .HLP file created for the instrument. The following menu is 
only representative of a Help Menu: The types of help messages, displays, 
additional menus, dialog boxes, etc., that appear after selecting a Help 
Menu command are dependent upon the instruments .ISD and .HLP files. 

I Control I 

Views 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the W key. Views 
causes a menu similar to the following to appear, allowing you to select the 
displayed view of the currently displayed instrument. 

This following menu is only representative, as the quantity and type of views 
available for each instrument is determined by the instrument driver (.ISD) 
file. Some instruments may have a front panel view similar to its physical 
layout, while others may have a functional view, or a single instrument may 
have multiple views. 

Since each instrument view is unique to the instrument, the Views Menu 
may contain the name of one or more views that you can select for display. If 
there is only one view, that view is selected (highlighted) whenever the menu 
is open. If there is more than one view, the view currently displayed is high- 
lighted when the menu is open, and it also has a check mark (J) in front of 
its name. To select a new view, point and click the mouse on the new view 
name in the menu. 

When you have Full lnteraction mode enabled (from the lnteraction Menu), 
and you select a different view, all measurement (or query) blocks for the 
new view are executed to put the front panel in the same state as the instru- 
ment. If you do not want all query blocks to execute when you change 
views, first select the No lnteraction mode (from the lnteraction Menu), then 
change the view. If you then need to control the instrument, reselect the Full 
lnteraction mode. 
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M isc - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the M key. Misc opens 
the following Miscellaneous Menu, allowing you to select the rate at which 
an instrument front panel view display is updated (by querying the instru- 
ment for its current measurements) and acting on the responses. This menu 
also allows you to send messages to a selected instrument and view the 
responses. 

w Refresh Rate ... - Select this menu item by pointing and clicking with 
the mouse, or by pressing the R keyboard key. Refresh Rate ... opens 
the following dialog box, allowing you to enable the Refresh Rate func- 
tion and to set the rate (in seconds) at which an instrument is queried 
for updating the instrument front panel view display. 

Edit - 
i .i-i.. "" ........................ 

e f r e s h  .................................. ... ... > 

Refresh  R a t e :  7 1  seconds 

Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

w Refresh On: - Selecting this a check box enables or disables the 
Refresh Rate function. When the box contains an X, the Refresh 
Rate function is enabled; when the box does not contain an X, it is 
disabled. 

w Refresh Rate: -An edit box where you set the number of seconds 
that will elapse before an on line instrument is queried for its current 
measurements and the instrument front panel view is updated. 

w OK - Select this pushbutton to complete the Refresh Rate ... 
action. 

8 Cancel - Select this pushbutton to cancel the Refresh Rate .... 
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H IalkIListen ... - Select this menu item by pointing and clicking with the 
mouse, or by pressing the T keyboard key. TalklListen ... opens the 
following dialog box, allowing you to communicate directly with the 
instrument whose front panel view is selected. This communication must 
use the instrument's command set. The Title Bar in the dialog box 
displays the IPG name assigned and the .ISD file name for the selected 
instrument. 

R e c e i v e :  

H Edit - Select this menu item by pointing and clicking with the 
mouse, or by pressing and holding the ALT keyboard key while 
pressing the E key. Edit allows you to edit the dialog box items. 
Refer to the Edit Menu description (previously given in this section) 
for the menu and information on its use. 

IPG provides the following dialog box items for user interaction: 

H Send: - An edit box where you enter the message to be sent to the 
instrument. 

w Receive: - A message box where the response from the instru- 
ment appears. 

Send - Select this pushbutton to send the message in the Send: 
edit box to the instrument 

H Receive - Select this pushbutton to query the instrument for its 
response to the message sent using Send. The response will be 
returned in the Receive: list box. 

H Done - Select this pushbutton to close the dialog box. 
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Waveform Menu A waveform display window and an associated menu similar to the one 
following will appear when an instrument front panel view (.ED file) has a 
control type called Waveform Display and you select its icon, or when IPG 
executes a test procedure containing a waveform display step. 

When an instrument front panel view has a Waveform Display control type, 
and you display the view or reduce it to an icon, another icon (it looks like a 
miniature waveform) will be displayed at the bottom of the screen. This icon 
represents the waveform display and menu, and you can display it by 
double-clicking with the mouse, or clicking with the mouse and then select- 
ing the Restore command from the Control Menu that appears. 

When IPG executes a test procedure containing a waveform display step, a 
waveform display and menu appears when that step executes. 

For more information and a tutorial with illustrations on using the Waveform 
Menu, see Waveform Displays in Section 5, Advanced Applications. 

Ok - Select this menu item by pointing and clicking with the mouse, or 
by pressing and holding the ALT keyboard key while pressing the 0 key. 
Qk terminates the waveform display and returns to the Main Menu. 

View - Select this menu item by pointing and clicking with the mouse, 
or by pressing and holding the ALT keyboard key while pressing the V 
key. View opens the following View Menu, allowing you to select a 
waveform display Zoom (expansion) or Full View (reduction) mode. 

Zoom - Select this menu item by pointing and clicking with the mouse, 
or by pressing the Z keyboard key. Zoom enters a waveform display 
expansion mode, where an enclosing rectangle is used to select a 
region on the waveform display that will be expanded in the display 
area. 
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When you select Zoom, the normal cursor changes to a Left Corner 
graphic symbol ( ). To select the region you want to expand, move the 
cursor (do not click the mouse) to a position on the display where you 
want the upper left corner of the enclosing rectangle to start. Then press 
and hold the left mouse button while moving the cursor to the position 
where you want the lower right corner of the enclosing rectangle to be. 
This will create an enclosing rectangle. Release the left mouse button. 

Zooming is a repeatable action that you can perform on each new 
display, until Zooming reaches a waveform display of only two points. 
You can not Zoom further than a two-point display. 

Full View - Select this menu item by pointing and clicking with the 
mouse, or by pressing the F keyboard key. Full View returns a zoomed 
display to a display of the entire waveform. 

Options - 

Select this menu item by pointing and clicking with the mouse, or by press- 
ing and holding the ALT keyboard key while pressing the 0 key. Options 
opens the following Options Menu, allowing you to select waveform display 
enhancements. 

Grid - 

D i s p l a y  Cursor - 
W a v e f o r m  Cursor - 
A m p l i t u d e  C u r s o r s  - 
T i m e  C U Y S O Y S  - 

I C o l o r s  and S t y l e s .  .. I 

Scroll Bars - Select this menu item by pointing and clicking with the 
mouse, or by pressing the S keyboard key. Scroll Bars adds vertical 
and horizontal scroll bars to the waveform display. After selecting this 
command, when you select the Options Menu again, Scroll Bars will 
have a check mark (J) to its left indicate that it is selected. Selecting it 
again will disable the feature. 

You can also scroll the waveform display in two other ways, as follows: 

By using the directional arrow keys on the numeric keypad or on a 
separate arrow keypad (some keyboards have both) 
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w By moving the mouse cursor just off the waveform display and 
slightly to the left or below the scales. When you do this, the cursor 
changes to a double-ended arrow cursor. When this cursor is to the 
left of the vertical scale, clicking the left or right mouse button moves 
the display vertically. When this cursor is below the horizontal scale, 
clicking the left or right mouse button moves the display horizontally. 

w Grid - Select this menu item by pointing and clicking with the mouse, 
or by pressing the G keyboard key. Grid adds vertical and horizontal 
grids to the waveform display at each major vertical and horizontal scale 
mark. After selecting this command, when you select the Options Menu 
again, Grid will have a check mark (J) to its left. Selecting it again will 
disable the feature. 

The following four cursor features are mutually exclusive selections. 
When you select one of them, any other one that is already selected 
will be disabled. 

Display Cursor - Select this menu item by pointing and clicking with 
the mouse, or by pressing the D keyboard key. Display Cursor adds a 
vertical and horizontal display cursor to the waveform display. You can 
control each cursor independently by the direction you move the mouse. 
You do not need to click the mouse to move the cursors. Each cursor 
has a current value associated with it that is displayed in the lower left 
corner of the display. The x: value is the current time value of the hori- 
zontal scale, and the Y: value is the current amplitude value of the 
vertical scale. After selecting this command, when you select the Op- 
tions Menu again, Display Cursor will have a check mark (J) to its left. 
Selecting it again or selecting another cursor will disable the feature. 

I Waveform Cursor - Select this menu item by pointing and clicking 
with the mouse, or by pressing the W keyboard key. Waveform Cursor 
adds a vertical and horizontal waveform cursor to the waveform display. 
Left and right movement of the mouse controls the vertical cursor. As the 
vertical cursor moves, the horizontal cursor moves to track the vertical 
cursor. Each cursor has a current value associated with it that is dis- 
played in the lower left corner of the display. The x : value is the current 
time value of the cursor position on the waveform, and the Y: value is 
the current amplitude value of the cursor position on the waveform. After 
selecting this command, when you select the Options Menu again, 
Waveform Cursor will have a check mark (J) to its left. Selecting it - 
again or selecting another cursor will disable the feature. 

Waveform cursors can only be manipulated with the mouse: there is 
no keyboard interface. 
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Amplitude Cursors - Select this menu item by pointing and clicking 
with the mouse, or by pressing the A keyboard key. Amplitude Cursors 
adds two horizontal cursors to the waveform display (identified with a 
boxed number 1 and 2 at the left of the display). You can independently 
move each cursor by clicking the mouse on the cursor and dragging it 
to the desired location. Each cursor has a current amplitude value 
associated with it that is displayed in the lower left corner of the display 
and identified with a 1 : and 2 : . The same value display also includes 
the Delta value between the cursors, which is identified with a D: . After 
selecting this command, when you select the Options Menu again, 
Amplitude Cursors will have a check mark (J)  to its left. Selecting it - 

again or selecting another cursor will disable the feature. 

I ime Cursors - Select this menu item by pointing and clicking with the 
mouse, or by pressing the T keyboard key. I ime Cursors adds two 
vertical cursors to the waveform display (identified with a boxed number 
1 and 2 at the top of the display. You can independently move each 
cursor by clicking the mouse on the cursor and dragging it to the de- 
sired location. Each cursor has a current time value associated with it 
that is displayed in the lower left corner of the display and identified with 
a 1 : and 2 : . The same value display also includes the Delta value 
between the cursors, which is identified with a D:  . After selecting this 
command, when you select the Options Menu again, Lime Cursors will 
have a check mark (J) to its left. Selecting it again or selecting another 
cursor will disable the feature. 

Colors and Styles ... - Select this menu item by pointing and clicking 
with the mouse, or by pressing the C keyboard key. Colors and 
Styles ... opens the following dialog box, allowing you to select 
waveform display colors and line styles. 
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Colors and Styles 
Points Only 

Selections 

et Graph Background 

-Sample 
Colors 

r - 

Sec 

IPG provides the following dialog box items for user interaction: 

H Selections - A  list box containing a listing of the items whose 
colors and line styles you can change, as follows: 

Waveform Variable names or plotnames 
Set Grid and Axes 
Set Background 
Set Graph Background 
Set Labels 

H Sample - A  display representing the waveform display whose 
features will change color and line style based on the selections you 
make in the Selections list box. 

H Points Only - Selecting this check box causes the selected graph 
to be plotted with points only instead of lines from point to point. 

H Line Styles - A  list box containing the different line styles you can 
select, as follows: 

Solid 
Long Dash 
Short Dash 
Long Dash with Single Dot 
Long Dash with Double Dot 

Colors - A  list box containing the different colors you can select. 
The available colors are Black, Red, Green, Blue, Yellow, Purple, 
White, Light Purple, Light Blue, Light Yellow, and Light Green. 
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Labels ... - Select this menu item by pointing and clicking with the 
mouse, or by pressing the A keyboard key. Labels ... opens the follow- 
ing dialog box, allowing you to change the waveform display title and 
the names of the X and Y Axes. 

I X Axis: [point- I I 

I (7- (Cancel) I 
IPG provides the following dialog box commands for user interaction. 

Title: - An edit box where you enter a title for the waveform display. 

X Axis: - An edit box where you enter a name for the horizontal 
scale. 

Y Axis: - An edit box where you enter the name of the vertical 
scale. 

OK - Select this pushbutton to complete the Labels ... action. 

Cancel -You can select this pushbutton to cancel the Labels .... 

4-1 14 Menus 



Section 5 
Advanced Applications 





Advanced Applications 

This section contains detailed information and application tutorials for the 
advanced features of IPG. 

Creating a 
Procedure 

Test In this example, we will create a more complex test procedure than was 
given in Section 3, Creating and Editing a Test Procedure. The test proce- 
dure we will create is identical to the DEMOTEST.PRG procedure supplied 
on the IPG program disks and listed in Appendix B, DEMOTESIPRG Pro- 
gram. We will create this program step-by-step, explaining the creation and 
purpose of each step as we go. 

You can compare your on-screen test procedure with the OUTLINE printout 
in Appendix B. The only difference in our procedure and the DEMOTEST 
procedure will be the name; we will name our procedure MYTEST. (Both the 
OUTLINE and FULL printouts in Appendix B have reference numbers on the 
left margin of the page. These reference numbers correspond to the number 
of the tutorial description where that step was created. For example, if the 
boxed number 1 on the printout is what you want to reference, it refers to 1. 
Selecting the Instruments .) . 

Test Procedure 
Overview Assumptions 

If you intend to create the following test procedure, it is assumed that the 
instrumentation in the following Required Hardware description (or the 
equivalent) is available, and that you know how to set up and operate that 
instrumentation. It is also assumed that the proper files from the IPG pro- 
gram disks (listed in the following Software description) have been copied 
from the disk into the directory where the completed test procedure will be 
stored. 

NOTE 

If possible, create the following procedure in one session. (It will 
take you about an hour.) If you do stop in the middle of the proce- 
dure and exit, be sure to save your work. When you reopen the 
procedure, refer to the manual illustration of the last completed 
step and notice which step in the procedure was highlighted. You 
will need to highlight this step before continuing, so that the steps 
will be in the proper order when you complete the procedure. Also, 
after reopening the file, you may need to open the Instrument Front 
Panel views by using the Instruments Menu, rather than by using 
the icons at the bottom of the screen display. 
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Required Hardware 

The following instrumentation is used in this test procedure: 

A Tektronix DM51 20 Programmable Digital Multimeter (GPIB controlled) 

A Tektronix FG5010 20 MHz Function Generator (GPIB controlled) 

A Tektronix PS503 Power Supply (User controlled - used to provide 
power to the unit under test (UUT)) 

A Tektronix TM5006 Mainframe (required for the DM5010, FG5010, and 
PS503) 

A controller capable of GPIB communications with the instruments 

If you choose to use equivalent instrumentation, you will need to provide the 
proper instrument driver files to replace those supplied on the IPG program 
disks. If the necessary drivers are not included in the Tektronix lnstrument 
Front Panel Libraries, you will need to write your own drivers. Refer to the 
Instrument Front Panel Developer's Manual for further information. 

Software 

The following instrument drivers and bit-mapped picture files are necessary 
for the creation of the test procedure. These files are included on the IPG 
program disks. You will need to verify that these files have been copied from 
the disk, and that they reside in the directory where the test procedure will 
be stored. 
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Test Procedure Overview 

DEMOTESTPRG, the test procedure you will create in this section, tests an 
amplifier with an amplitude control. The test has the operator adjust the 
control for a particular voltage at a base frequency. It then varies the fre- 
quency from 10- 100 kHz in 21 logarithmic steps, measuring the voltage at 
each frequency. Finally, the test procedure reports the results on the screen 
and logs them into a file named DEMOTESTDAT 

1. Selecting the lnstruments 

You can select the instruments at any time during the creation of the 
procedure, as long as the selection occurs before the instrument views 
are used. However, since instrument selection should be part of the test 
procedure planning process, we will begin with the selection in creating 
the procedure. This ensures that the instrument drivers will be available 
for the test procedure when they are needed. You will notice on the test 
procedure printouts that a list of the selected instruments is printed 
before the first procedure step. 

The instrument primary GPlB addresses given in these procedures 
are the factory defaults. If you have changed these addresses, you 
will need to enter the correct address during the procedures, rather 
than the default given. 

Begin the instrument selection by selecting lnstruments from the Main 
Menu bar. When the lnstruments Menu appears, select Select .... After 
the lnstruments Select dialog box appears, perform the following steps: 

a. Select the TDM512 O.ISD file by pointing and double-clicking the 
mouse on it in the drive/directory/file list box. When the file name 
appears in the Drivers: edit box, ensure that GPIBO is selected in 
the Port: edit box. If GPIBO is not selected, point and click the 
mouse on it. Then enter the factory default GPlB address of 1 6  in 
the Primary: edit box and dmm in the TMS Name: edit box. Do not 
make any entry in the Secondary: address box (this is used only 
when the instrument has a secondary GPlB address). If any errors 
occur during the loading of the instrument driver, appropriate error 
messages will be displayed. Before continuing to the next step, 
make certain that you screen display matches the following illustra- 
tion. 
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Drlve IS- 

ldm5120 tsd 

= \lPg 

Secondary 

b. Select the Add pushbutton. 

c. Next, select the TEKFG.ISD file by pointing and double-clicking the 
mouse on the name in the drive/directory/file list box. When the file 
name appears in the Drivers: edit box, ensure that GPIBO is se- 
lected in the Port: edit box. If GPIBO is not selected, point and click 
the mouse on it. Then enter the factory default GPlB address of 2 4  
in the Primary: edit box and fg in the TMS Name: edit box. Select 
the Add pushbutton and verify that the display matches the follow- 
ing illustration. 

TMS Name Dr~ver Po rt Address 
drnm tdm5120 ~ t d  GPlBO PRI 16 

I I T-- .. 2 

Dnverr. TMS Name 
l t e ~ g  isd Ifg I GPlBl 
=\lPg 

OK 

d. Select the OK pushbutton to complete the instrument driver selec- 
tion process and return to the Main Menu. To confirm that the instru- 
ment selection has taken place, select Instruments, then select 
View. Your display should match the following illustration. After 
verifying your selections, select Cancel. 

Instruments Front Panel 
TMS Name Drlver Port Address 
dmm tdm5120 lrd CPlBO PRI  16 
f Q tewu ~ s d  GPlBO PRI  24 
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2. Entering the First Remark 

Perform the following to create the first test procedure step REMARK: 

a. Select Actions from the Main Menu bar. 

b. When the Actions Menu appears, select Remark .... 

c. After the Remark dialog box appears, perform the following: 

Enter the words ~ocate Gain Adj R3 and preset it. in 
the edit box. Your display should match the following illustration 

Edit - 

Select the OK pushbutton to create the step and return to the 
Main Menu. The REMARK Step will appear in the display. Since 
this is the first test procedure step to appear on the display, a 
PROCEDURE (Untitled) ( ) line will appear at the beginning of 
the procedure and an END-PROCEDURE line will appear after the 
REMARK. Verify that your display matches the following illustra- 
tion. 

Translate F1 =Help 
PROCEDURE luntitledl l 1 
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3. Naming the Procedure 

So far, we have not saved the procedure, so the procedure statement 
shows PROCEDURE (untitled) ( ) , and the window Title Bar at the 
top of the display shows TekTMS - (untitled) , indicating that no file 
name has been assigned. 

A test procedure is named when you save it, which can be done any 
time after you have created at least one step. The file name assigned to 
it becomes the name of the test procedure. 

NOTE 

When using a GPlB Interface Card in a Personal Computer or 
Workstation to control GPlB instrumentation, users need to be 
aware of certain filenames that should not be used for Test Proce- 
dures (files with . PRG extensions), or for Instrument Front Panel 
drivers (files with .ISD extensions). For additional information see 
the File Names topic in Section 2, Getting Started. 

Perform the following steps to name the test procedure: 

a. Select File from the Main Menu bar. 

b. When the File Menu appears, select the Save as... menu item, 
causing the Save As dialog box to appear. Then enter MYTEST in the 
Save file as: edit box (you do not need to enter a file extension, 
since IPG automatically adds a .PRG extension). Your display should 
match the following illustration. 

Save file as: c:U p g 

MYTEST 

Edit Key: 

7 1-1 
I> ky: 

c. Select the Save pushbutton to create the step and return to the 
Main Menu. The file name will appear as the title in the previously 
(untitled) window Title Bar at the top of the display, and in the pre- 
viously (untitled) PROCEDURE statement in the display. Verify that 
your display matches the following illustration. 
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,PROEDJRE MYTEST I 1 .... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
.~~.M.~RK.~~cate..Gain.Arl i  ~ 3 a n o p r e ~ e t i t  ...... . . . .  . . . .. ...... .. ... ..... ... ..... .. . .. ... .. .... . ... .. . . .... ... . ... . . ......... 
END-PROCEDURE 

4. Adding Operator Prompts 

A Picture Prompt - You can enter an operator prompt step in the 
form of a picture anywhere in the procedure. This picture must have 
been created, scanned, or captured in a bit-mapped format that can be 
read into a Windows environment. 

Perform the following to create a Picture Prompt step in your test 
procedure: 

a. Select Qperator from the Main Menu bar. When the Operator Menu 
appears, select the Prompt menu item. After the Prompt menu list 
appears, select Picture 

b. After the Picture Prompt dialog box appears, select Eile. When the 
File menu appears, select the Load ... menu item. 

c. When the Picture File Selection dialog box appears, enter TEK- 
PIC.BMP in the Picture Name: edit box. TEKPIC.BMP is the name of 
the sample file provided with the IPG containing the picture to be 
loaded. Verify that your display matches the following illustration, 
then select the Load pushbutton. 
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Picture Name: 

tekpic-bmp 

c l ip  g 

d. When the picture shown in the following illustration appears in the 
Picture Prompt dialog box, select Eile. 

File Edit Label Comment - 

Y 
R 1  + T I -  

I R 4  - 1L 
COM - 1 5 V  

NOTE 

Refer to Section 5, Menus, Operator Menu, Prompt, Picture ... for 
more information about using . BMP files. 

e. After the File menu appears, select the Save and Exit ... menu item 
to create the step and return to the Main Menu. Your display should 
now match the following illustration. 
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Text Prompt -You can enter an operator prompt step in the form of 
text anywhere in the procedure. 

Perform the following to create a Text Prompt Step in our test proce- 
dure: 

f. Select Operator from the Main Menu bar. When the Operator Menu 
appears, select the Prompt menu item. After the Prompt menu list 
appears, select Text. 

g. When the Text Prompt dialog box appears, enter Set R3 Gain 
A d j  to midrange. in the Message: edit box. Leave the Variable: 
edit box blank. Verify that your display matches the illustration 
below, then select the OK pushbutton to create the step and return 
to the Main Menu. 

Edit Label Comment - 
Massage: 

Variable: -1 

h. Verify that your display matches the illustration below. 
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I lF i le  Edit Actions Operator Links lnstruments Bun! Debug Options )I 
Translate F1 =Help 

PROCEDURE M M E S T  [ ] 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 

5. Entering the Second Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
I n i t i a l i z e  ins t ruments  f o r  t e s t s  t o  f o l l o w . f ~ ~ t h e ~ ~ M A ~ ~  
text. When you have completed entering the REMARK, selected the OK 
pushbutton, and returned to the Main Menu, your display should match 
the following illustration. 

m l e  Edit Actions Qperator Links lnstruments Bun! Debug Options 1 1  
Translate F1 =Help 

PROCEDURE M M E S T  [ ] 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
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6. Setting the Instruments 

To create SETTING steps, the instrument drivers (files with an .ISD 
extension) for the specific instruments must be available in the directory 
where the procedure is to be saved. 

Setting the Function Generator - Perform the following to create a 
SETTING step for the Function Generator (FG5010): 

a. Open the function generator (TEKFG.ISD) Instrument Front Panel 
view by selecting Instruments from the Main Menu bar. When the 
lnstruments Menu appears, select the View ... menu item. After the 
lnstruments Front Panel dialog box appears, select the TEKFG.ISD 
(fg) instrument from the list box, then select the OK pushbutton. 

NOTE 

You may need to resize the window to see the entire instrument 
front panel view. 

b. Select the SlNE WAVE radiobutton; select the OUTPUT check box; 
enter 1000 in the FREQUENCY edit box; select the CONTINUOUS 
check box; and select 1 in the AMPLITUDE list box. Verify that your 
display matches the following illustration. 

@ SlNE WAVE 
[XI CONTINUOUS 0 TRIANGLE WAVE 

AMPLITUDE 

c. Select Step. When the Step Menu appears, select Saye Selected 
Settings .... After the Selected Settings dialog appears, select the 
following Control List names, in order, and select the Add pushbut- 
ton after each Control List item. The order of the controls in the 
Selected Control edit box is the order in which they will be ex- 
ecuted, beginning at the top of the list. This will place the selected 
Control List names in the Selected Control edit box. 

SINEWAVE 
FREQUENCY 
CONTINUOUS 
AMPLITUDE 
OUTPUT 
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d. Verify that your display matches the following illustration, then select 
the OK pushbutton. 

I Control List Selected Control 
SINEWAVE 
FREQUENCY 
CONTINUOUS 
AMPLITUDE 
OUTPUT 

I A d d  All I 

I Cancel I 

e. When the front panel view reappears, minimize it by selecting the 
down-arrow ( 4 ) in the upper right corner of the window. This will 
keep the front panel opened, but reduce it to an active icon at the 
bottom of the display. It also will return to the test procedure outline 
display and the Main Menu. Your display should now match the 
following illustration. 

Translate F1 =Help 
PROCEDURE MYTEST ] 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3  Gain Adj to midrange. 

REMARK initialize instruments for tests to follow. 

Setting the Digital Multimeter - The SETTING step for the Digital 
Multimeter (DM51 20) is created in exactly the same manner as the 
SETTING step for the Function Generator. 

Perform the same actions you used to create the SETTING step for the 
Function Generator, with the following exceptions: 

f. After the Instruments Front Panel dialog box appears, select the 
TDM5120.ISD (dmm) instrument from the list box, then select the 
OK pushbutton. 

5-12 Advanced Applications 



NOTE 

You may need to resize the window to see the entire instrument 
front panel view. 

g. After the Instrument Front Panel view and menu appear, select the 
3 Digits radiobutton from the ACCURACY group box, then select 
30 V from the RANGE list box. Verify that your display matches the 
following illustration. 

h. Select Step. When the Step Menu appears, select Save Selected 
Settings .... After the Selected Settings dialog box appears, select 
each of the following Control List names (in the order shown), and 
select the Add pushbutton after each Control List item. This will 
place the selected Control List names in the Selected Control edit 
box. 

acvthree 
acvrange 

i. Verify that your display matches the following illustration, then select 
the OK pushbutton. 

Control List 

a d i v c  

Selected Control 

acvrange 

I Add All I 

1 Cancel 1 

TekTMS Interactive Procedure Generator User Manual 



j. When the front panel view reappears, minimize it by selecting the 
down-arrow ( 4 ) in the upper right corner of the window. This will 
keep the front panel opened, but reduce it to an active icon at the 
bottom of the display. It also will return to the test procedure outline 
display and the Main Menu. Your display should now match the 
following illustration. 

File Edit Actions Qperator Links lnstruments Bun! Debug Oetions 11 - 
Translate F1 =Help 

PROCEDURE MMEST [ 1 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SETTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 

7. Entering the Third Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Adjust R3 Gain Adj to its nominal value. for the REMARK 
text. When you have completed entering the REMARK, selected the OK 
pushbutton, and returned to the Main Menu, your display should match 
the following illustration. 

r f i l e  ~ d i t ~ A c t i o n s  Qperator Links lnstruments Bun! Debug Oetions 1) 
Translate F1 =Help 

PROCEDURE MYTEST [ ] 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SE'ITING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SE'ITING dmm acvrange acvthree 
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8. Adding an Adjustment Step 

An ADJUSTMENT step creates an adjust-measure-display interactive 
loop step starting at an ADJUSTMENT statement and ending at an 
END-ADJUSTMENT statement. Perform the following to create an AD- 
JUSTMENT step: 

a. Select Qperator from the Main Menu bar. When the Operator Menu 
appears, select the Adjustment ... menu item. After the Adjustment 
dialog box appears, enter 3 in the Lower Limit: edit box, 3.6 in the 
Nominal Value: edit box, and 4 in the Upper Limit: edit box. 

b. Enter gaincal in the Variable: edit box. This is the variable name 
where the value measured at the output of the Gain Amplifier is 
stored. Next, click the mouse on the Message: edit box and enter 
Adjust R3 to its nominal value. This message will appear 
on-screen for the operator during procedure runtime. Verify that your 
display matches the following illustration. 

c. Select the OK pushbutton to create the step and return to the Main 
Menu. Your display should now match the following illustration. 

Edit Label  Comment - 
Lower Limit: Nominal Value: Upper Limit: 

Translate F1 =Hell 
PROCEDURE M M E S T  ( ] 
REMARK Locate Gain Adj R3  and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3  Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SETTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SElTING dmm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

3 

TekTMS Interactive Procedure Generator User Manual 5-15 

4 
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Message-  - 



9. Taking Measurements 

MEASUREMENT steps, like SETTING steps, require the instrument driv- 
ers (files with an .ISD extension) for the specific instruments to be avail- 
able in the directory where the procedure is to be saved. 

This measurement step must be part of the ADJUSTMENT/END-AD- 
JUSTMENT construct; however, the current display cursor location is at 
the highlighted END-PROCEDURE statement. Since steps are entered 
immediately above a highlighted step, you must point and click the 
mouse on the END-ADJUSTMENT statement. This changes the location 
at which the next step will be inserted. 

Perform the f0 l l0~ ing to add the MEASUREMENT Step: 

a. Point and double-click the mouse on the dmm icon at the bottom of 
the display. (If you have saved and exited the procedure since 
creating the SETTING steps, the icon will not be available. In this 
case, select Instruments from the Main Menu. When the Instru- 
ments Menu appears, select the View ... menu item. After the Instru- 
ments Front Panel dialog box appears, highlight the TDM5120.ISD 
instrument in the list box and select OK.) 

b. When the front panel view and menu appears, click on the Mea- 
surement edit box. This will make Measurement the currently 
selected control, and will place a blinking cursor in the edit box, as 
shown in the following illustration. 

I DM6110 AC VOLTMETER I 

Blinking Cursor 

c. Select Variables from the front panel menu. When the Variables 
Menu appears, select the Current Control ... menu item. After the 
Variable dialog box appears, enter gaincal in the Variable: edit 
box. 
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NOTE 

It is important that the variable name (in this case, gaincal) 
associated with the selected instrument control be the same as the 
name of the ADJUSTMENT loop. If the names are not the same, the 
ADJUSTMENT loop will not have a value. If you do not perform steps 
9c. and 9d. correctly, you may have a different name for the vari- 
able. If you do not assign a variable name, IPG will create its own 
name of the form 'I TMSname. controlP/PE', where the name starts 
with 'I  ', followed by the TMS name of the instrument, then a period, 
then the control name, followed by the variable type (string, float, 
etc.) The assignment of variable names to front panel controls is 
how IPG is able to return a measurement for a specified control. 
Refer to the illustration in Step e. to see where the variable and loop 
names appear in the program. 

Verify that your display matches the following illustration. 

Edit - 
Control Id: acvreading 

Variable: gaincal 

d. Select the OK pushbutton to assign the variable and return to the 
front panel view. After the front panel view returns, select Step. 
When the Step Menu appears, select the Save Selecled Measure- 
ments ... menu item. After the Selected Measurements dialog box 
appears, select acvreading from the Control List list box, then the 
Add pushbutton. Verify that your display matches the following 
illustration. 

Contro l  List Selected Control 

acvfour 
a cvfiie 
acvsiw 
acvtilt ... 
acvrangc 

acvreadinq 

El I Add All I 

I Cancel / 
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e. Select the OK pushbutton to create the step and return to the front 
panel view. When the front panel view reappears, minimize it by 
selecting the down-arrow ( 4 ) in the upper right corner of the win- 
dow. Point and click the mouse on the END-PROCEDURE step to 
highlight it. Your display should now match the following illustration. 

Eile Edit Actions Operator Links Instruments Run! Debug Oetions 
Translate F1 =Help 

PROCEDURE M M E S T  ( 1 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 

These names F. 
must match 

10. Entering the Fourth Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Initialize test procedure variables. forthe REMARK text. 
When you have completed entering the REMARK, selected the OK push- 
button, and returned to the Main Menu, your display should match the 
following illustration. 

Translate - F1 =Help 
PROCEDURE MMEST I 1 
REMARK Locate Gain A b j ~ 3  and preset it. 

PROMm PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SElTING dmm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 
MEASUREMENT dmm acvreading:gaincal 

END ADJUSTMENT 

Advanced Applications 



11. Assign and Initialize the Test Variables 

The next three steps in our test procedure use the Calculate menu item 
from the Actions Menu to assign names to test procedure variables and 
initialize those variables. 

Perform the following to create a CALCULATE step: 

a. Select Actions from the Main Menu bar. When the Actions Menu 
appears, select the Calculate ... menu item. 

b. After the Calculate dialog box appears, click the mouse on the 
Variable: edit box and enter index&. (The last character in the 
name (&) indicates an integer variable type.) Click the mouse on the 
Expression: edit box and enter 0. This sets the initial value of the 
variable index&. Verify that your display matches the following 
illustration. 

Edit Labe l  Comment 

Variable: Expression: 

c. Select the OK pushbutton to create the step, assign and initialize 
the variable, and return to the Main Menu. Verify that your display 
matches the following illustration. 

Lranslate F1 =Help 
PROCEDURE MMEST [ 1 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SETTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SETTING dmm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 
MEASUREMENT dmm acvreading:gaincal 

END-ADJUSTMENT 
REMARK Initialize test procedure variables. 

CALCULATE index& = 0 
w g ~ u a m  1 

d. Repeat Steps a and b, but enter tes tda te t imes  in the Variable: 
edit box. (The last character in the name ($) indicates a string vari- 
able type.) Enter da te$  ( ) + "  "+ t ime$ ( ) in the Expression: edit 
box. This sets the initial value of the variable tes tda te t ime$.  Verify 
that your display matches the following illustration. 

TekTMS Interactive Procedure Generator User Manual 5-19 



NOTE 

time$(), date$(), and chr#() are built in IPG functions. 

Edit Label Comment - 
Varia blc: Expression: 

testdatet imes / - l d a t e $ ~ + "  "+times0 

e. Select the OK pushbutton to create the step, assign and initialize 
the variable, and return to the Main Menu. Verify that your display 
matches the following illustration. 

Translate F1 =Help 
PROCEDURE MYTEST ] 
REMARK Locate Gain Adj R3 and preset it. 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SElTING dmm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index8 = 0 

f. Repeat Steps a and b, but enter r e p o r t $  in the Variable: edit box. 
(The last character in the name ($) indicates a string variable type.) 
Enter t es tda te t ime$+ch r$  (13) +chr$  ( 1 0 )  in the Expression: 
edit box. This sets the initial value of the variable report$. Verify that 
your display matches the following illustration. 

Edit _Label Comment - 

Variable: Expression: 

( repor ts  I = testdatetimeS+chrS[l3)+chrS[lO) 

[Cancell 
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g. Select the OK pushbutton to create the step, assign and initialize 
the variable, and return to the Main Menu. Verify that your display 
matches the following illustration. 

PROMPT Set R3 Gain A 
REMARK initialize instru for tests to follow. 

END-ADJUSTMENT 
REMARK lnitialize test procedure variables. 

CALCULATE index& = 0 
CALCULATE testdatetimes = dateSO+timeSO 

- + 

12. Entering the Fifth Remark 

The procedure for entering this REMARK is,identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Initialize test procedure variables. for the REMARK text. 
When you have completed entering the REMARK, selected the OK push- 
button, and returned to the Main Menu, your display should match the 
following illustration. 

11 ~ i l e - - ~ d i t  Actions Operator Links instruments Bun! Debug Ogtions 11 
11  Translate F1 = H e b  11 - 

PROMPT PICTURE tekpic.bmp 
PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 
SElTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SElTING dmm acvrange acvthree 

REMARK Adjust R3 Gain to i ts nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK lnitialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSOttimeS0 
CALCULATE reoortS = testdatetimeS+chrSI13l+chrSI101 
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13. Creating a FOR-NEXT Loop 

When you create a basic FOR-NEXT loop step, an opening FOR state- 
ment and an ending NEXT statement are displayed in the procedure. 
You must create any test procedure steps that need to execute within 
the FOR-NEXT loop between these two statements. Our test procedure 
will contain two REMARK steps, two Calculate steps, one SETTING 
Step, One DELAY Step, and One MEASUREMENT Step within the 
FOR-NEXT loop. 

Perform the following to create the basic FOR-NEXT loop step: 

a. Select Bctions from the Main Menu bar. When the Actions Menu 
appears, select the For Next menu item. After the For Next Menu 
appears, select the Log menu item. 

b. When the For Next Log dialog box appears: click the mouse on the 
Variable: edit box and enter f req; click the mouse on the Start 
Value: edit box and enter 10; click on the End Value: edit box and 
enter 1. OE+5; and click on the Number of Steps: edit box and 
enter 21.  Verify that your display matches the following illustration. 

Edit Label Comment - 
Start Value: End Value: 

10  11 .OE+5 

Number of Steps: $ n 5 : . $ 5 2 ~ 7 3 5 . 5 > > $  2 ; k ~ t : .  

/ 21 

Variable: freq 
I- 

c. Select the OK pushbutton to create the basic FOR-NEXT loop and 
return to the Main Menu. Click the mouse on the NEXT statement to 
highlight it. Before proceeding to the next step, verify that your 
display matches the following illustration. 
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Translate 
REMARK Initialize instruments for tests to follow. 

SETTING fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE 
SETTING drnm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HlGH 4 

MEASUREMENT drnm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSOttimeS0 
CALCULATE reports = testdatetimeS+chrS(l3)+chrS(lO] 

REMARK Test the frequency response from 10Hz to 10OkHz. 
FOR frea = 10 TO 1 .OE+5 STEPS 21 LOG 

14. Entering the Sixth Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Initialize test procedure variables. for the REMARK text. 
When you have completed entering the REMARK, selected the OK push- 
button, and returned to the Main: Menu, your display should match the 
following illustration. (You may need to scroll the display for all the steps 
shown in the illustration to be visible.) 

11 Translate F1 =Helo 11 
1) >E;,& fg SINEWAVE FREQUENCY OUTPUT CONTINUOUS AMPLITUDE Id 1 

SETTING drnm acvrange acvthree 
REMARK Adjust R3 Gain to i ts nominal value. 

ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HlGH 4 
MEASUREMENT drnm acvreading:gaincal 

END-ADJUSTMENT 
REMARK Initialize test procedure variables. 

CALCULATE index& = 0 
CALCULATE testdatetimes = dateSO+timeSO 
CALCULATE reports = testdatetirneS+chrS(13)+chrS(lO) 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR frea = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK 'Set the Function Generator frequency to freqS 
I . END-PROCEDURE 

TekTMS Interactive Procedure Generator User Manual 5-23 



15. Defining a Test Variable within the Loop 

Create this step using the same procedure that you used in Step 17 ,  
Assigning and Initializing Test Variables, parts a. and b. Enter f req$ in 
the Variable: edit box, and str$ ( freq) in the Expression: edit box. 
(str$ ( ) is a built-in IPG function.) Verify that your display matches the 
following illustration. 

Edit l a b e l  Comment - 

Variable: Expression: 

Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. (You 
may need to scroll the display for all the steps shown in the illustration to 
be visible.) 

File Edit Actions Operator Links Instruments Bun! Debug Oetions - I I 
Translate F1 = H e l ~  - 
SETTING drnm acvrange acvthree 

REMARK Adjust R3 Gain to its nominal value. 
ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSOttimeS0 
CALCULATE reports = testdatetimeS+chrS(13]+chrS(10) 

REMARK Test the frequency response from 1 OHz to 100kHz. 
FOR frea = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK 'Set the Function Generator freauencv to freaS I 11 . - 

END-PROCEDURE - 
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16. Setting an Instrument within the Loop 

Blinking Cursor / 

This step is created in the same manner as Step 6, Setting the Instru- 
ments. 

Perform the following to create this SETTING step for the Function 
Generator (fg): 

a. Point and double-click the mouse on the fg icon at the bottom of the 
display, or click on the icon and select Restore from the Control 
Menu that will appear. When the front panel view and menu ap- 
pears, select the FREQUENCY edit box to assign it as the currently 
selected control (this action will also place a blinking cursor in the 
edit control box). Verify that your display matches the following 
illustration. 

Step Edit !ntersction update! Variables Help Views M i r c  - F1 =Help 

FREQUENCY 

CONTINUOUS 

AMPLITUDE 

.2 

.5 

b. Select Variables. When the Variables Menu appears, select the 
Current Control ... menu item. After the Variable dialog box appears, 
enter f req$ in the Variable: edit box. 

NOTE 

I t  is important that the control variable name matches the string 
representation of the FOR-NEXT variable, since this is how values 
from the test procedure are transferred to the front panel controls 
the CALCULATE Step (created in 15. Defining a Test Variable within 
the Loop) is necessary because the front panel control expects 
data that is a string representation of a number. 

Verify that your display matches the following illustration. 

Edit - 
Control Id: FREQUENCY 

Variable: freqS 
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c. Select the OK pushbutton to assign the variable and return to the 
front panel view. Select Step. When the Step Menu appears, select 
the Save Selected Settings ... menu item. After the Selected Set- 
tings dialog box appears, select FREQUENCY from the Control List 
list box and select the Add pushbutton. FREQUENCY will appear in 
the Selected Control list box, as shown in the following illustration. 

Control  List 

S Q U A R E W A V E  
SIN EWAVE 
T R l A N  GLEWAVE 
0 UTPUT 

AMPLITUDE 

S e l e c t e d  Contro l  

/ A d d  All  1 

d. Select the OK pushbutton to create the step and return to the front 
panel view. Minimize the front panel view, which will also return you 
to the Main Menu. Verify that your display matches the following 
illustration. (You may need to scroll the display for all the steps 
shown in the illustration to be visible.) 

Iranslate F1 =Help 
REMARK Adjust R3 Gain to its nominal value. + 

ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 
MEASUREMENT dmm acvreading:gaincal 

END-ADJUSTMENT 
REMARK Initialize test procedure variables. 

CALCULATE index& = 0 
CALCULATE testdatetimes = dateSO+timeSO 
CALCULATE reports = testdatetimeS+chrS[13]+chrS[10] 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq] 

. END-PROCEDURE - 
1 
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17. Entering the Seventh Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Delay f o r  DMM range  change. for the REMARK text. When you have 
completed entering the REMARK, selected the OK pushbutton, and 
returned to the Main Menu, your display should match the following 
illustration. (You may need to scroll the display for all the steps shown in 
the illustration to be visible.) 

. END-PROCEDURE - 

lranslate F1 =Help 

18. Creating a Program Delay within the Loop 

ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 
MEASUREMENT dmm acvreading:gaincal 

END-ADJUSTMENT 
REMARK Initialize test procedure variables. 

CALCULATE index& = 0 
CALCULATE testdatetimes = dateSOttimeS0 
CALCULATE reports = testdatetimeS+chrS[13]+chr$[10) 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq) 
SElTING fg FREQUENCY:freqS 

A DELAY step momentarily delays the program for some minimum time 
during runtime. 

- 4 

Perform the following to create a DELAY step: 

a. Select Actions from the Main Menu bar. When the Actions Menu 
appears, select the Delay ... menu item. After the Delay dialog box 
appears, enter 3 00 in the edit control box (this number represents 
the number of milliseconds of delay) and verify that your display 
matches the following illustration. 

Edit Label Comment - 
300 Milliseconds 

1 - 7 7 ]  
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b. Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. 

11 f i le Edit Actions Operator Links instruments Bun! Debug Oetions I I 
11 Translate F1 =Helo 11 - 

MEASUREMENT dmm acvreading:gaincal 
END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSo+timeSfl 
CALCULATE reports = testdatetirneS+chrS[13]+chrS[l O] 

REMARK Test the frequency response from 10Hz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strSIfreq) 
SETING fg FREQUENCY:freqS 

REMARK Delav for DMM ranae chanae. 
DELAY 300 MILLISECOND~ 

- 
. END-PROCEDURE - 

19. Entering the Eighth Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Measure the  UUT outpu t .  for the REMARK text. When you have 
completed entering the REMARK, selected the OK pushbutton, and 
returned to the Main Menu, your display should match the following 
illustration. (You may need to scroll the display for all the steps shown in 
the illustration to be visible.) 
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END-ADJUSTMENT 

REMARK Initialize test procedure variables. 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSO+tirneSO 
CALCULATE reports = testdatetimeS+chrS[13]+chrS(l O] 

REMARK Test the frequency response from 10Hz to 100kHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strSIfreq] 
SElTlNG fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

- + 



20. Measurement Within the Loop 

Blinking Cursor / 

This step is created in an identical manner to Step 9, Taking Measure- 
ments. 

Perform the following to create this MEASUREMENT step: 

a. Open the dmm Instrument Front Panel view by double-clicking the 
mouse on the dmm icon at the bottom of the screen, or by clicking 
on the icon and selecting Restore from the menu that will appear. 
When the front panel view and menu appears, click the mouse on 
the Measurement edit box to assign Measurement as the currently 
selected control and to place a blinking cursor in the edit box. Verify 
that your display matches the following illustration. 

b. Select Variables. When the Variables Menu appears, select the 
Current Control ... menu item. After the Variable dialog box appears, 
change the name gaincal in the Variable: edit box to output by 
clicking the mouse on the edit box, deleting the existing text by 
pressing the BACKSPACE or DEL keyboard key, and entering the 
new variable name. Verify that your display matches the following 
illustration. 

Edit - 
Control Id: acvreading 
Variable: output 
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c. Select the OK pushbutton to assign the variable and return to the 
front panel view. Select Step. When the Step Menu appears, select 
the Save Selected Measurements ... menu item. After the Selected 
Measurements dialog box appears, select acvreading from the 
Control List list box, then the Add pushbutton. Verify that your 
display matches the following illustration. 

I Cantrol L ist  Selected Control I 
acvfise 
acfsix 
acvfill ... 
aclnange 

acvreading 

El 
d. Select the OK pushbutton to create the step and return to the front 

panel view. Minimize the front panel view, which will also return you 
to the test procedure outline display and the Main Menu. Verify that 
your display matches the following illustration. (You may need to 
scroll the display for all the steps shown in the illustration to be 
visible.) 

CALCULATE index& = 0 
CALCULATE testdatetimes = dateSOttimeS0 
CALCULATE reports = testdatetimeS+chrS(l3]+chrS[l O] 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq] 
SElTING fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
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21. Entering the Ninth Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Build formatted report string. for the REMARK text. When YOU 

have completed entering the REMARK, selected the OK pushbutton, and 
returned to the Main Menu, your display should match the following 
illustration. (You may need to scroll the display for all the steps shown in 
the illustration to be visible.) 

11 Eile Edit Adions Operator Links instruments Run! Debug Options 
Iranslate 
CALCULATE index& = 0 
CALCULATE testdatetimes = dateSO+timeSO 
CALCULATE reports = testdatetimeS+chrS[13]+chrS[lO) 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

3EMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq] 
SETTING fg FREQUENCY:freqS 

3EMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

3EMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output . . 

. END-PROCEDURE - 
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22. lncrementing a Variable Within the Loop 

This step is created in the same manner as Step I I ,  Assigning and 
Initializing Test Variables. 

Perform the following to create this step. 

a. Select Actions from the Main Menu bar. When the Actions Menu 
appears, select the Calculate ... menu item. After the Calculate 
dialog box appears, enter index& in the Variable: edit box, then 
click on the Expression: edit box and enter index&+l. Verify that 
your display matches the following illustration. 

Edit L a b e l  Comment  - 

Variable: Expression; 
i ndexe = index&+l 1 

b. Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. (You 
may need to scroll the display for all the steps shown in the illustra- 
tion to be visible.) 

CALCULATE index& = indkx& + 1 
- 

. END-PROCEDURE - 
a 

Translate F1 =Help 
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CALCULATE testdatetimes = dateSO+timeSO 
CALCULATE reports = testdatetimeS+chrS(13]+chrS[lO) 

REMARK Test the frequency response from 10Hz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq] 
SElTING fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 

- + 



23. Defining a Report Format within the Loop 

This step is created in the same manner as Step 11, Assigning and 
Initializing Test Variables. 

Perform the following to create this step. 

a. Select Actions from the Main Menu bar. When the Actions Menu 
appears, select the Calculate ... menu item. After the Calculate 
dialog box appears, enter report$ in the Variable: edit box, then 
click on the Expression: edit box and enter report$ + "Test " 

+ str$(index&) + " Stimulus " + freq$ + " Hz " + 
str$(output) + " ACV RMS " + chrS(13) + chrS(10). 
Verify that your display matches the following illustration. (Notice that 
IPG has scrolled the entry for the Expression:.) 

Edit _Label Comment - 
Variable: Expression: 

1 reports I = jut] + " ACV RMS " + chrS(13) + chr$(10] 

b. Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. 
(Notice that IPG has truncated the entry for the Expression:. The 
ellipsis shows that there was more data than would fit on the screen 
in the Outline view.) 

11 Translate F1 =Helo 

. END-PROCEDURE - 

- 
CALCULATE reports = testdatetimeS+chrS(13]+chrS[10] 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq] 
SElTING fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 
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24. Entering the Tenth Remark 

Highlight the END-PROCEDURE statement at the end of the procedure by 
clicking the mouse on it. (We are now finished entering steps within the 
FOR-NEXT loop.) 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Power down and rest instruments. for the REMARK text. When 
you have completed entering the REMARK, selected the OK pushbutton, 
and returned to the Main Menu, your display should match the following 
illustration. (You may need to scroll the display for all the steps shown in 
the illustration to be visible.) 

REMARK  el& for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 

Translate F1 =Help 

CALCULATE reports = reportS+'7est"+strS~index&]+"Simulus "+freqS+" ... 11 NEXT 

REMARK Test the frequency response from 1 OHz to 1 OOkHz. 
FOR freq = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to freqS 
CALCULATE freqS = strSIfreq] 
SElTING fa FREQUENCY:freaS 

25. Prompting the Operator 

- + 

This step is created in the same manner as Step 4, Adding Operator 
Prompts. 

Perform the following to create this step. 

a. Select Qperator from the Main Menu bar. When the Operator Menu 
appears, select the Prompt ... menu item. After the Prompt menu 
appears, select Text. When the Text Prompt dialog box appears, 
enter Turn off the power supply to the UUT in the Mes- 
sage: edit box. Select the OK pushbutton to create the step and 
return to the Main Menu. Verify that your display matches the follow- 
ing illustration. (You may need to scroll the display for all the steps 
shown in the illustration to be visible.) 
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Translate F1 =Hf 
FOR frea = 10 TO 1 .OE+5 STEPS 21 LOG 

REMARK se t  the Function Generator frequency to freqS 
CALCULATE freqS = strS[freq) 
SElTING fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'7est"+strS[index&j+"Simulus "+freqS+" ... 

NEXT 
REMARK Power down and rest instruments. 

26. Setting the Instruments 

These SETTING steps are created in the same manner as Step 6, Set- 
ting the Instruments. 

Perform the following to create the SETTING Step for the Function Gen- 
erator (fg). 

a. Open the fg Instrument Front Panel view. If necessary, click the 
mouse on the OUTPUT check box to turn it OFF (no "X" in the box). 
Verify that your display matches the following illustration. 

Step Edit lnteract~on Update1 Yarlables Help Vlegs MISC - F1 =Help 

FREQUENCY 

@ SQUARE WAVf  7 1  
13 SINE WAVE 

CONTINUOUS 0 TRIANGLE WAVE 

OUTPUT AMPLITUDE 
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b. Select Mep. When the Step Menu appears, select Save Selected 
Settings .... After the Selected Settings dialog box appears, select 
OUTPUT from the Control List list box, then select the Add push- 
button. Verify that your display matches the following illustration. 

Control  List Se lec ted  Control  

SOUAREWAVE O U T P U T  
S INEWAVE 
TR IANGLE WAVE 
~ S @ l I J  ai 
C O N T I N U O U S  
A M P L I T U D E  

c. Select the OK pushbutton to create the step and return to the front 
panel view. Minimize this view to return to the Main Menu. Verify that 
your display matches the following illustration. (You may need to 
scroll the display for all the steps shown in the illustration to be 
visible.) 

Translate F1 =He1 
REMARK Set the Function Generator freauencv to freaS 

CALCULATE freqS = strS[freq] 
SElTING fg FREQUENCY:freqS 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'Test"+strS[index&]+"Simulus "+freqS+" ... 

NEXT 1 
 REMARK Power down and rest instruments. I 11 
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Perform the following to create the SETTING step for the DMM (dmm). 

d. Open the dmm Instrument Front Panel view. Select AUTO from the 
RANGE list box. Verify that your display matches the following 
illustration. 

e. Select Step. When the Step Menu appears, select Save Selected 
Settings .... After the Selected Settings dialog box appears, select 
acvrange from the Control List list box, then select the Add push- 
button. Verify that your display matches the following illustration. 

Control L ~ r t  Selected Control 

~~] 
11 
l z 2 c l  

f. Select the OK pushbutton to create the step and return to the front 
panel view. Minimize the front panel view to return to the Main Menu. 
Verify that your display matches the following illustration. (You may 
need to scroll the display for all the steps shown in the illustration to 
be visible.) 
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Translate F1 =Help 
CALCULATE freqs = strSIfreq] i 

SETTING fg F R E Q U E N C Y : ~ ~ ~ ~ ~  
REMARK Delay for DMM range change. 

DELAY 300 MILLISECONDS 
REMARK Measure the UUT output 

MEASUREMENT drnrn acvreading:output 
REMARK Build formatted report string. 

CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'Test"+strS(index&]+"Simulus "+freqS+" ... 

NEXT 
REMARK Power down and rest instruments. 

PROMPT Turn off the power supply to the UUT. 
SETTING fa OUTPUT 

27. Entering the Eleventh Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
Log report string to disk file. for the REMARK text. When you 
have completed entering the REMARK, selected the OK pushbutton, and 
returned to the Main Menu, your display should match the following 
illustration. (You may need to scroll the display for all the steps shown in 
the illustration to be visible.) 

1 1  File Edit Actions Operator Links instruments Bun! Debug Oetions 11 
Translate F1 =Help 11 SETTING fg FREQUENCY:heqS i 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmrn acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'7est"+strS[index&]+"Simulus "+freqS+" ... 

NEXT 
REMARK Power down and rest instruments. 

PROMPT Turn off the power supply to the UUT. 
SETTING fg OUTPUT 
SETTING drnm acvranae 
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28. Transferring Collected Data to a File 

This TRANSFER step transfers the data collected by the test procedure 
to a file named DEMOTEST.DAT. 

Perform the following to create the TRANSFER step. 

a. Select Actions from the Main Menu bar. When the Actions Menu 
appears, select the Transfer Data menu item. After the Transfer 
Data Menu appears, select Yariable to File .... When the Transfer 
Variable To File dialog box appears, enter MYTEST in the File Name: 
edit box (an extension is not required as IPG automatically adds a 
.DAT extension) and enter report$ in the Variable: edit box. Verify 
that your display matches the following illustration. 

b. Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. (You 
may need to scroll the display for all the steps shown in the illustra- 
tion to be visible.) 

11 File Edit Actions Operator Links instruments Bun! Debug Oet ions 11 
Translate F1 =Help 

REMARK Delay for DMM range change. 
DELAY 300 MILLISECONDS 

REMARK Measure the UUT output 
MEASUREMENT dmm acvreading:output 

REMARK Build formatted report string. 
CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'7est"+str$(index&)+"Simulus "+freqS+" ... 

NEXT 
REMARK Power down and rest instruments. 

PROMPT Turn off the power supply to the UUT 
SElTING fg OUTPUT 
SElTING drnm acvranae 

((REMARK Loa report s t r i a  to disk file. I 11 
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29. Entering the Final Remark 

The procedure for entering this REMARK is identical to that used in Step 
2, Entering the First Remark. The only difference is that you will enter 
D i s p l a y  repor t .  for the REMARK text. When you have completed 
entering the REMARK, selected the OK pushbutton, and returned to the 
Main Menu, your display should match the following illustration. (You 
may need to scroll the display for all the steps shown in the illustration to 
be visible.) 

Iranslate 
REMARK Measure the UUT output 

MEASUREMENT dmm awreading:output 
REMARK Build formatted report string. 

CALCULATE index& = index& + 1 
CALCULATE reports = reportS+'7est"+str~[index&j+"Simulus "+freqS+" I NEXT 

REMARK Power down and rest instruments. 
PROMPT Turn off the power supply to the UUT. 
SElTING fg OUTPUT 
SElTING dmm awrange 

REMARK Log report string to disk file. 
TRANSFER reports -> mytest.DAT 

REMARK D i s ~ l a v  reDort. 

30. Displaying the Data 

This procedure creates a DISPLAY step to display the data collected 
during the test, and adds a user-defined title to the display. 

Perform the following to create a DISPLAY step: 

a. Select Operator from the Main Menu bar. When the Operator Menu 
appears, select the Display Data menu item. After the Display Data 
Menu appears, select Wait .... When the Display Data Wait dialog 
box appears, click on the Caption: edit box and enter Frequency 
vs Gain Data f o r  MYTEST. PRG, then click on the Expression: 
edit box and enter r e p o r t $ .  Verify that your display matches the 
following illustration. 
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Edit Label Comment - 

Expression: 

[reports 

b. Select the OK pushbutton to create the step and return to the Main 
Menu. Verify that your display matches the following illustration. (You 
may need to scroll the display for all the steps shown in the illustra- 
tion to be visible.) 

c. Select File from the Main Menu bar. When the File Menu appears, 
select the Save menu item. This completes the test procedure. 

If you have the instrumentation and want to run the procedure, refer to 
the Run Menu description in Section 4, Menus for further information. 
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Waveform Displays A waveform display window and an associated menu will appear when an 
instrument front panel view (.ISD file) has a control type called Waveform 
Display and you select its icon, or when you run a test procedure containing 
a DISPLAY DATA step of a waveform variable. In this manual, the asso- 
ciated menu is referred to as the Waveform Menu. An illustration of the 
waveform display and Waveform Menu is shown later under the topic Using 
the Waveform Menu. For additional information about the Waveform Menu, 
refer to Section 5, Menus. 

The remainder of this discussion of waveform displays is in the form of a 
waveform display tutorial. We will use the Waveform Menu while running a 
user created test procedure having a DISPLAY DATA step of a waveform 
variable. 

Overview 

In the following waveform display tutorial, you will first create a two-step 
waveform display test procedure and name it TEKWAVE.PRG. (If you 
created the tutorial program TEST2.PRG in Section 3, you can use it. If you 
have that program, load it now and proceed to Using the Waveform Menu). 

The first step of this procedure transfers a waveform data file named TEK- 
WAVE.WFD to a waveform variable named wfml " .  The second step dis- 
plays the waveform variable. The waveform data file, TEKWAVE.WFD, is 
provided on the IPG program disk, and should already be stored on the 
your machine with the other program files. 

Once you have created the procedure, you will run it and exercise the 
Waveform Menu selections to demonstrate the action they have on the 
display. The Waveform Menu selections are described under the Using the 
Waveform Menu topic following. 

Creating a Waveform Display Procedure 

Perform the following steps to create a waveform display procedure: 

1. Select File from the Main Menu bar. When the File menu appears, select 
the New menu item. When the Main Menu returns, select Actions. 
When the Actions Menu appears, select the Transfer Data menu item. 
After the Transfer Data menu appears, select File to Variable ..., then 
select the OK pushbutton. When the Transfer File To Variable dialog box 
appears, enter tekwave .wfd. in the File Name: edit box and wfml- 
in the Variable: edit box. Select the OK pushbutton. 

2. Select Operator from the Main Menu bar. When the Operator Menu 
appears, select the Display Data menu item. After the Display Data 
Menu appears, select Wait .... When the Display Data Wait dialog box 
appears, enter wfml- in the Expression: edit box. Put one line of text of 
less than 32 characters in the caption if you wish text in the title bar of 
the waveform display. Select the OK pushbutton. 

- - 
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3. Select File from the Main Menu bar. When the File menu appears, select 
the Save as ... menu item. After the Save As dialog box appears, enter 
tekwave in the Save file as: edit box (you do not have to enter a file 
extension, since IPG will automatically add a .PRG). Select the Save 
pushbutton. Verify that your display matches the following illustration. 

Using the Waveform Menu 

Perform the following to display the waveform and the Waveform Menu: 

1. Select Run from the Main Menu bar. When the Run Menu appears, 
select the All menu item. The following waveform display and its 
Waveform Menu will appear. 

NOTE 

If you are using a monochrome display, the waveform will not be 
visible when it first appears. To correct this, select Qptions from 
the Waveform Menu. When the Options Menu appears, select 
Colors and Styles .... After the Colors and Styles dialog box ap- - 
pears (refer to Step H, further in this procedure for further informa- 
tion), click on Set Graph Background in the Selections list box, 
then click on the white square in the Colors list box. Select OK to 
return to the waveform display The waveform should now be 
visible. 
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0 20 40 60 80 100 120 140 160 180 200 220 240 260 
Points 

2. Select View from the Waveform Menu. When the View Menu appears, 
select the Zoom menu item. The cursor will change to a left corner 
graphic symbol ( r ) as shown in the following display. 

Ok View O ~ t i o n s  

Cursor 

- 
I ' " ' , " " I " " , " " 1 " " I " " , ' " ' , " " , " " /  1 ' ' ' 1 ' ' ~ ' 1 ' " ' 1 ' ' " 1 ' '  

0 20 40 60 80 100 120 140 160 180 200 220 240 260 
Points 

3. We will now create an enclosing rectangle around the top peaks of the 
three highest waveforms (the highest peak and the ones on each side of 
it). To do that, move the cursor (do not click) to a position where you 
want the upper left corner of the rectangle to be. Then click and hold the 
left mouse button and drag the cursor down and to the right until the 
resulting enclosing rectangle includes the three highest peaks. Release 
the mouse button. When the display returns, it should look similar to the 
following illustration. 
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4. Select View. When the View Menu appears, select the Full View menu 
item. After the display returns, the entire waveform should be visible as it 
was before it was zoomed. 

5. Select Qptions. When the Options Menu appears, select the Scroll 
Bars menu item. After the display returns, scroll bars will be present, as 
in the following illustration. 

- 
0k View Oetions - 

- 
, " " 1 " " 1 " " 1 " " 1 " " 1 ' " ' 1 " " 1 " " ~ " " ~ ' " ' ~ " " ~ ' " ' ~ '  I 

0 20 40 60 80 100 120  140 160 180  200 220 240 260 
Points 

6. Select Qptions. When the Options Menu appears, note that the Scroll 
Bars menu item has a check mark in front of it, indicating that it is 
enabled. Select the Grid menu item. When the display returns, vertical 
and horizontal grid will be present, as in the following illustration. 
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Points 

7 .  At this point, we will demonstrate some of the ways to move the 
waveform display within the window. As you perform each of the follow- 
ing actions, notice how the waveform display moves. 

D Place the cursor at various places on the scroll bar and click the 
mouse. Place the cursor on the scroll boxes, then click and drag the 
boxes to various points on the scroll bars. Place the mouse cursor 
on the scroll bar arrows and click the mouse. 

Press the arrow directional keys on the numeric keypad, or press 
the arrow directional keys on the directional arrow keypad (if your 
keyboard is so equipped). 

Alternately move the cursor off the display just to the left or below 
the waveform work area (in the scale area). A double-ended arrow 
cursor will appear in each of the axes. A vertical double-arrow will 
appear on the Y axis (shown in the illustration below), and a horizon- 
tal double-arrow will appear on the X axis. While the double-arrow is 
visible, alternately click the left and right mouse buttons and notice 
which direction the display moves. 

Double Arrow 

: m 
-1 ~ ~ ~ ~ I ~ ~ ~ ~ i ~ ~ " " ' I ~ ~ ' I ' " ' I " '  

0 2 0  40 60  80 1 0 0  1 2 0  140  1 6 0  180 200  220  240  260 
Points 
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8. Select Qptions. When the Options Menu appears, select the Display 
Cursor menu item. After the display returns, it will have a vertical and 
horizontal display cursor, as shown in the following illustration. 

Q k  View Ontioris 

29.7143C 0 20 40 60 80 100 120 140  160 180 200 220 240 260 Y: 3.4632 
Points 

9. Move the mouse left and right and up and down (do not click). Note the 
following: 

The cursors move independently depending on which direction the 
mouse moves. 

The cursors can be moved off the waveform in each direction. 

The cursor values are given in x: and Y :  in the lower left corner of 
the display. 

10. Select Options. When the Options Menu appears, select Waveform 
Cursor. After the display returns, the cursor will have changed to a 
vertical and horizontal waveform cursor, as shown in the following illus- 
tration. 

Y: -3.7969 
Points 
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11. Observe the cursors while moving the mouse left, right, up, and down. 
Notice the following: 

w The vertical (time) cursor follows the mouse movement, but the 
horizontal cursor (amplitude) does not. (The horizontal cursor may 
move slightly when the mouse is moved up and down, but that is 
because there is usually also some slight left and right movement.) 

w Both cursors disappear when you attempt to move the vertical 
cursor off the waveform. Thus, you cannot move either cursor off the 
waveform. 

w The horizontal cursor tracks the amplitude of the same waveform 
point that the vertical cursor is on. Because of this, the horizontal 
cursor never goes above or below the waveform point. 

The cursor values are shown in x: and Y : in the lower left corner of 
the display. 

NOTE 

Waveform cursors can only be manipulated with the mouse: there is 
no keyboard interface. 

12. Select Options. When the Options Menu appears, select the Amplitude 
Cursors menu item. After the display returns, the cursors will have 
changed to two horizontal amplitude cursors, as shown in the following 
illustration. (The cursors are identified with a small boxed 1 and 2 in the 
vertical scale area.) 

0k View Ootions 

Cursor Numbers 

13. Alternately drag the cursors up or down by clicking the mouse on that 
cursor (notice that the cursor arrow changes to a hand) and holding the 
mouse button while you move the mouse. As the cursors move, note the 
cursor values in 1 : and 2 : , and the delta difference value in D: , in the 
lower left corner of the display. 
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14. Select Options. When the Options Menu appears, select the l ime 
Cursors menu item. After the display returns, the cursors will have 
changed to two Time Cursors as shown in the following illustration. (The 
cursors are identified with a small boxed 1 and 2 in the top scroll bar 
area.) 

Cursor Numbers 

15. Alternately click and drag the cursors left and right. As the cursors 
move, notice the cursor values in 1 : and 2 : , and the delta difference 
value in D :  , in the lower left corner of the display. 

NOTE 

If you are viewing this waveform on a monochrome display, the 
following procedure will produce results (in some of the options) 
that will not allow a visible waveform. 

16. Select Qptions. When the Options Menu appears, select the Colors 
and Styles ... menu item. The following Colors and Styles dialog box will 
appear. 
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17. Alternately select items from the Selections list box. Then select differ- 
ent line styles and colors from the Line Styles and Colors list boxes. 
Note the changes that occur on the Sample display. Occasionally, select 
the OK pushbutton to return to the waveform display so you can ob- 
serve the changes. 

Colors 

m m n m  

18. Select Options. When the Options Menu appears, select the Labels 
menu item. The following Label Options dialog box will appear. 

1 Title: [marl 
I x ~ x i s :  Points 

Vo I ts 

19. You can use the Label Options dialog box to change the title and scale 
labels on the waveform display. To demonstrate this, click on the entry in 
one of the edit boxes. Use the BACKSPACE or DEL keyboard keys to 
remove the entry, then make a new entry. Repeat this for the other two 
edit boxes, then select the OK pushbutton. When the display returns 
note the changes for the labels that you edited. 
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Application Hints 
Sending Output to a Printer 

To send IPG output to a standard DOS compatible printer, first create a 
variable containing the string of text to be printed, including any control 
codes. Then create a TRANSFER step to transfer the variable to a file using 
LPTI., LPT2., or PRN. as the File Name: entry (the periods following the 
printer names are required). This is a DOS feature that allows the printer to 
be treated as a file. However, if there is another Windows application trying 
to use the printer at the same time, there may be a printing conflict that 
mixes the printer inputs together. 

Printing a Waveform or IPG Display 

To print a waveform display or an IPG display screen, press the PRINT 
SCREEN keyboard key (On older, non-enhanced keyboards, you may need 
to press the ALT and PRINT SCREEN keys or the SHIFT and PRINT 
SCREEN keys simultaneously). This transfers the contents of the display 
screen to the Windows clipboard. 

Next, minimize the IPG window and open the Windows clipboard. Save the 
clipboard contents into a file. You may then print this file through PC Paint- 
brush or other graphics editors. 

Windows Maximize Function Carryover on View Change 

When an instrument front panel view is maximized and you open a new 
view, the new view will also be maximized and its borders will not be acces- 
sible to change the size. To correct this problem, move the mouse cursor to 
the Title Bar, then click and hold the left mouse button while dragging the 
view down and to the left. The top and right border of the window will be- 
come visible, allowing you to resize the window. 

Displaying Multiple Lines of Text in a Display Step 

To display multiple lines of text in a display step, separate the lines with a 
CRLF (<carriage return> cline feed>) sequence, such as: 

CALCULATE crlf$ = chr$(13)+chr$(10) 
CALCULATE a$ = "Line one"+crlf$+"Line two" 
Display a$ 

NOTE 

A LFCR (cline feed > <carriage return >) sequence will not pro- 
duce the same result as the CRLF sequence. 
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Communicating with an lnstrument without an ISD Driver 
File 

If an instrument does not have an lnstrument Front Panel driver (.ISD file), 
you can build a simple generic driver to communicate with that instrument. 
The contents of the generic driver consist of the following: 

SCRIPT "Generic" 
<bus note> 
END 

E N D  

where <bus  note> = GPIB, RS232, VX5520, or WINTERNAL, depending 
upon the type of bus used for communications between the controller and 
the instrument. 

Each of these bus types has default parameters set by IPG, which are listed 
under the Bus Note Block topic in Section 2, lnstrument Script Language 
Descriptions in the lnstrument Front Panel Developers Manual. If these 
default parameters are not adequate for communications to the instrument, 
then you need to expand the driver to include the settings for the correct 
parameters. 

After you have built the generic driver, you can communicate with the instru- 
ment using the Transfer Data ... menu item from the Actions Menu. By 
designating a variable for transmitted data, you can use the Variable to 
Instrument ... and Instrument to Variable ... menu items to create steps that 
will transfer data to and from the instrument. 

Information Exchange Between a Test Program and an Event 
Handler or an Abort Handler 

If you wish to send data to, or return data from, an event handler or abort 
handle, you must specify some parameters in the declaration of the handler. 
The test program that is the handler must be created with parameters and 
the ON EVENT or ON ABORT action must specify the main program variables 
to send to the handler. An integer specifying RUN/STOP and a string to 
contain a status message are usually sufficient. The main test program will 
initialize these variables and if the handler is invoked, it may change the 
values of these variables. The main test can check the value of the RUN/ 
STOP integer for TRUE or FALSE at any time in the test. If FALSE, the con- 
tents of the string variable can be displayed and/or logged to a data file to 
show the reason the test stopped. 

If you have a main test and called subtests, you can still use the handler 
parameters, but make certain that you pass the handler variables to the 
called subtest. Be sure to give the formal parameter declaration in the called 
subtest the same name as the parameters listed in the handler declaration. 
If the names are the same, when the handler is invoked, the correct values 
will be sent to the handler. If you do not use the same names, then you will 
Cause an 'Uninitialized variable' error. 
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Masking Timeout Errors 

You may mask instrument timeout errors in a test program by setting up an 
ON EVENT handler that does nothing for timeouts. IPG will not report a 
timeout if a timeout handler is enabled. Also, it will not report any errors that 
may be the result of the timeout. For example, if you ask for a voltage read- 
ing from an instrument and no reading is taken, the instrument read will 
timeout and no data will be returned. The next access to the voltage reading 
would generate an error. This error will not be reported and the test program 
will continue. Of course, you may want to do some error processing when 
the timeout occurs. 

A handler that does nothing is simply a test program with only a BEGIN 
PROCEDURE and END-PROCEDURE Steps. YOU Can Create such a test pro- 
gram by building a single CALCULATE step test program and then deleting 
the CALCULATE step. 

Converting Between Binary Strings and Numbers 

The following test procedure illustrates how to convert a string of characters 
into their binary number representation. This is useful for extracting data 
from an instrument if it returns binary data rather than ASCll data. The 
procedure will translate the first two characters of a string into their binary 
numeric value. 

PROCEDURE RAWNUM ( ) 

PROMPT Enter a two character string 
CALCULATE first$ = mid$(a$,l,l) 
CALCULATE msd& = asc(first$) 
CALCULATE second$ = mid$(a$,2,1) 
CALCULATE lsd& = asc(second$) 
CALCULATE value& = (msd& * 256) + lsd& 
DISPLAY " MSD " + str$(msd&) + " LSD " + str$(lsd&) + 

" VALUE " + str$ (value&) 
END-PROCEDURE 

The following test procedure illustrates how to convert a number to a string 
of characters representing the binary number. This is useful for sending data 
to an instrument if it accepts only binary data rather than ASCll data. 

The procedure translates a 16 bit integer into a string of two characters. The 
left most character of the resulting string 'the~esult$' will be the most 
significant byte while the next character will be the least significant byte. 
After translation the two bytes are displayed as hexadecimal values. 

- 
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PROCEDURE NUMRAWCH ( ) 

REMARK Ask for a number to convert and place it in value& 
PROMPT Enter a value between 0 and 65535 
CALCULATE msd& = value&/256 
CALCULATE lsd& = mod(value&,256) 
CALCULATE value$ = chr$(msd&) + chr$(lsd&) 
DISPLAY " MSD " + str$(msd&) + " LSD " + str$(lsd&) + 

" VALUE: " + value$ 
CALCULATE msd& = int(value&/256) 
CALCULATE lsd& = value& - (256*msd&) 

REMARK The resulting string with the most significant 
byte first is 

REMARK stored in string 'theResultS1. 
CALCULATE theResult$ = chr$(msd&)+chr$(lsd&) 
DISPLAY hex$(asc(mid$(theResult$,l,l))) 

+hex$(asc(mid$(theResult$,2,1))) 
END-PROCEDURE 

Returning Status Information from a .ISD File 

Status data may be returned from an instrument driver during program 
execution, or interactive use, by using a status control. This control is not 
associated with any instrument function, but is used by other controls to 
relay additional information to the test program. The status control works 
only with MEASUREMENT steps, since SETTING Steps only send data to the 
instrument. The status control must come before any controls that use it. 

The following is an example of a simple instrument driver that implements 
the status control. 

Script "EXSTATUS" 
GPIB 
End 
View "Main" 
ControlGroup 
Control Status:int CheckBox @ 50,2 
String "Status OK" ; 
State On; 
End 

Query 
Rem You must do something in a Query block 

Status = Status; 
End 
End 
ControlGroup 
Control Vo1ts:float EditBox @2,4 
String"l.0"; 
ControlTitle "Volts"; 
UpdateList Status; 

End 
Setting 
cont-"Volts: ",volts; 
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End 

Query 
cont- "Volts?" ; 
inst- "VOLTS:",volts; 
if (volts >300) then 
status = 0; 
else 
status = 1; 
endi f 
End 
End 
ControlGroup 
Control Amps:float EditBox @20,4 
String "0.1"; 
ControlTitle "Amps"; 
UpdateList Status; 

End 

Setting 
cont- "Amps : " , amps; 
End 

Query 
cont- "Amps?" ; 
ins t - "AMPS : " , amps ; 
if (amps >30) then 
status = 0; 
else 
status = 1; 
endi f 
End 
End 
End 

End 

The following is an example of a simple test program that uses the status 
control to determine if the value returned is valid. Notice that the status is 
returned with a MEASUREMENT step, and that it is the last thing measured. 

PROCEDURE (untitled) ( ) 

MEASUREMENT InstA Vo1ts:volts Status:status& 
IF status& <>I THEN 
STOP TEST 
ELSE 
END-IF 
MEASUREMENT InstA Amps:amps Status:status& 
IF status& 1 THEN 
STOP TEST 
ELSE 
END-IF 

END-PROCEDURE 
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Using I 
Server 

PG as a DDE DDE (Dynamic Data Exchange) is a protocol for communications between 
MS Windows applications. To use DDE you must write a MS Windows 
program, using languages such as Visual Basic or ToolBook. You can also 
use DDE from applications such as Word for Windows and Excel. In the 
DDE protocol the program providing a service, such as executing TekTMS 
programs, is called the 'server' while the program requesting the service is 
called the 'client'. 

TekTMSIIPG can be used as a DDE server to run tests, to display a test for 
editing, or to abort a running test. The DDE client can also query the value 
of the PassFail variable at the completion of a test. 

The details of DDE programs vary with the language the client is written in. 
This manual does not attempt to explain how to write DDE clients. See the 
"Microsoft Window Software Development Kit" manuals for the details of 
writing DDE clients. 

TEKTMS.EXE understands the following DDE messages. TekTMSIIPG does 
not support hot links. For all the DDE messages, TEKTMS.EXE must be 
loaded. 

WM - DDE - INITIATE 

This message is sent to "TEKTMS.EXEV to establish a DDE session. The 
server name specified in the message must be "TEKTMS" and the only 
supported topic is "RUN-IT". 

WM - DDE - EXECUTE 

[RUNTEST ( t e s t  n a m e )  1 

This DDE message causes "TEKTMS.EXE" to load and run the PRG file 
named " t e s t  name." The result of the execution can be queried with the 
WM-DDE-REQUEST message. The main TEKTMS window is not displayed 
while the test is running. 

[EDITTEST ( tes t  n a m e )  1 

This DDE message causes "TEKTMS.EXEn to load the PRG file named 
" t e s t  name." 

[ABORT] 

This DDE message causes TEKTMS to abort (stop) the execution of a 
program started with a " [RUNTEST. . . I " message. 

WM-DDE-REQUEST 

STATUS 

This DDE message is used to determine the status of a running TekTMS 
program. TEKTMS responds with a WM-DDE-ACK indicating "BUSY" if the 
testing is still running. If the test has completed it returns "PASS" if the 

- 
5-56 Advanced Applications 



PassFail global variable is TRUE, "FAIL if it is FALSE and "INCOMPLETE" if 
the test was aborted. The status is passed as a zero terminated string in 
global DDE shared memory, with its handle as the low order word of the 
long word parameter of the message. 

WM - DDE - TERMINATE 

When TEKTMS receives this message it closes the DDE session. If a pro- 
gram is currently running it is not stopped. 
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Appendix A: 
Editing Menu Items 

This section provides a reference list of all editing menu items, and a de- 
scription of the actions they perform. 

Undo - reverses the edit action of the most recent Edit Menu command. If - 
you repeatedly select the Undo command, IPG switches between the cur- 
rent edit state and the previous edit state. (For example, if you have inserted 
a word, the first Undo command removes it, while the second Undo re- 
places it.) Undo is enabled only when an edit action that can be reversed 
exists. 

Cut - copies highlighted text to the clipboard, and deletes it from the - 
procedure. When you highlight a single action statement of a multiple state- 
ment test procedure action (such as one of the IF, THEN, or ELSE state- 
ments from an IF-THEN-ELSE construct), Cut copies all of the action 
statements of the construct to the clipboard, then deletes the statements 
from the procedure. However, text added between the action statements is 
neither copied nor deleted. If you wish to delete the text, you must highlight 
and delete it separately. 

Copy - copies highlighted text to the clipboard without deleting it from the - 
procedure. When you highlight a single statement of a multiple statement 
test procedure action (such as one of the IF, THEN, or ELSE statements 
from an IF-THEN-ELSE construct), Copy copies all action statements of the 
construct to the clipboard. However, text added between the action lines is 
not copied. If you wish to copy the text, you must highlight and copy it 
separately. 

Paste - copies the contents of the clipboard to the test procedure ahead - 
of the currently highlighted line. 

Clear - deletes a highlighted item, but does change the contents of the 
clipboard. 

Enable Selected Steps - reverses the action of the following Disable - 

Selected Steps command. 

Disable Selected Steps - allows you to leave a step in a procedure, but - 
to disable it so that the procedure will not act upon it when run. 
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Appendix B: 
DEMOTEST.PRG Program 

This appendix contains a copy of the OUTLINE and FULL listings for DE- 
MOTESTPRG, which is an executable IPG test procedure contained on the 
IPG Program Disk(s). Also, it the same test procedure described in Section 
6, Advanced Applications. When the test system and unit under test (UUT) 
described in Section 6 are available, this program can be loaded and run. 

The numbers on the listings are keyed to the tutorial step numbers in Sec- 
tion 6 that explain how to create each test procedure step. These numbers 
also correlate between the OUTLINE and FULL listings. 

These listings were retyped into this manual and vary slightly from those that 
were printed on the test system where the procedure was generated. The 
differences are: 

In the FULL listing, the page break occurred at a different place in the 
program listing. 

The following line in the program went to a new line at a different place: 

CALCULATE report$ = report$+"Test "+str$(index&)+ 
" Stimulus "+freq$+" Hz "+str$(output)+" ACV RMS" 
+chr$ (13) chr$ (10) 
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Appendix B: DEMOTEST.PRG Program 

DEMOTEST.PRG Outline Form 

1 TekTMs DEMOTEST 
dmm TDM5120.ISD GPIBO 

fg TEKFG . ISD GPIBO 

PRI 16 
PRI 24 

Page 1 

3 PROCEDURE DEMOTEST ( )  

2 REMARK Locate R3 Gain Adj and preset it. 

4 PROMPT PICTURE TEKPIC.BMP 

PROMPT Set R3 Gain Adj to midrange. 

REMARK Initialize instruments for tests to follow. 

SETTING fg SINEWAVE FREQUENCY CONTINUOUS AMPLITUDE OUTPUT 

SETTING dmm acvthree acvrange 

REMARK Adjust R3 Gain Adj to its nominal value. 

ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 

MEASUREMENT dmm acvreading:gaincal 

END-ADJUSTMENT 

REMARK Initialize test procedure variables. 

CALCULATE index& = 0 

CALCULATE testdatetimes = date$()+" "+time$() 

CALCULATE report$ = testdatetime$+chr$(13)+chr$(lO) 

REMARK Test the frequency response from 10 Hz to 100 kHz. 

FOR freq = 10 to 1.OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to "freq$". 

CALCULATE freq$ = str$(freq) 

SETTING fg FREQUENCY:freq$ 

REMARK Delay for DMM range change. 

DELAY 300 MILLISECONDS 

19 REMARK Measure the UUT output 

2 0 MEASUREMENT dmm acvreading:output 

21 REMARK Build formatted report string. 

2 2 CALCULATE index& = index&+l 

2 3 CALCULATE report$ = report$+"Test "+str$(index&)+" Stimulus "+freq$... 

NEXT 

REMARK Power down and reset instruments. 

PROMPT Turn off the power supply to the UUT. 

SETTING fg OUTPUT 

SETTING drrun acvrange 

REMARK Log report string to disk file. 

TRANSFER report$ - >  demotest.DAT 

REMARK Display report. 

DISPLAY report$ 

END-PROCEDURE 
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Appendix B: DEMOTEST.PRG Program 

DEMOTEST.PRG Full Form 
1 dmm TDM5120.ISD GPIB 

f g TEKFG . I SD GPIB 

3 PROCEDURE DEMOTEST ( )  

PRI 16 
PRI 24 

2 REMARK Locate R3 Gain Adj and preset it 

4 PROMPT PICTURE TEKPIC.BMP 

PROMPT Set R3 Gain Adj to midrange. 

5 REMARK Initialize instruments for tests to follow. 

6 SETTING fg 

SINEWAVE "FUNC SINE;" 

FREQUENCY "1000" 

CONTINUOUS 1 

AMPLITUDE " 1.0" 

OUTPUT "OUT ON:" 

SETTING dmm 

acvthree 1 

acvrange "3" 

7 REMARK Adjust R3 Gain Adj to its nomin a1 value. 

8 ADJUSTMENT gaincal LOW 3 NOMINAL 3.6 HIGH 4 gainpf 

Adjust R3 to its nominal value. 

9 MEASUREMENT dmm 

acvreading gaincal 

END-ADJUSTMENT 

REMARK Initialize test procedure variables. 

CALCULATE index& = 0 

CALCULATE testdatetimes = date$()+" "+time$() 

CALCULATE report$ = testdatetime$+chr(l3)+chr$(lO) 

REMARK Test the frequency response from 10 Hz to 100 kHz. 

FOR freq = 10 TO 1.OE+5 STEPS 21 LOG 

REMARK Set the Function Generator frequency to "freq$". 

CALCULATE freq$ = str$(freq) 

SETTING fg 

FREQUENCY freq$ 

REMARK Delay for DMM range change. 

LAY 300 MILLISECONDS 

REMARK Measure the UUT output. 

MEASUREMENT dmm 

acvreading output 

21 REMARK Build formatted report string 

2 2 CALCULATE index& = index&+l 

2 3 CALCULATE report$ = report$+"Test "+str$(index&)+" Stimulus " 

+freq$+" Hz "+str$(output)+" ACV RMS"+chr$(l3)+chr$(lO) 
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NEXT 

REMARK Power down and reset instruments. 

PROMPT Turn off the power supply to the UUT. 

SETTING fg 

OUTPUT "OUT OFF;" 

SETTING dmm 

acvrange "AUTO" 

REMARK Log report string to disk file. 

TRANSFER report$ ->  demotest.DAT 

REMARK Display report. 

DISPLAY report$ 

Frequency vs Gain Data for MYTEST.PRG. 

END-PROCEDURE 
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Appendix C: 
Software Performance Report 

This Software Performance Report is for your use in reporting any problems 
you experience when using TekTMSIIPG. It provides us with a way to track 
problems with a particular system and it ensures that we provide you and 
other customers with a prompt solution to the problem. Please supply the 
following information: 

Customer (Company Name): 

User (Person making report): 

Address: 

City: State: Zip: 

Country: Telephone: 

System Description (Product Name, SIW Version, Serial Number): 

Product Name: PC ModelIMake: 

Version: DOS Version: 

Serial No: Windows Version: 

Other Software (TSR's, ...) 

Problem Description: 

(If possible, include exact steps to recreate the problem.) 

Itemize attached documentation (i.e., listings, diskettes, ...) 

Mail the report to: 

Tektronix, Inc. 
Instrument Controllers and Software Marketing Dept. 
MS 47-665 
PO. Box 500 
Beaverton, OR 97075-9965 

Or FAX to: 

Marked for ICS Marketing, 47-665 
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Cancel Push Button, Description, 4-3, 
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Display Data Message Box, Using, 
3-10 

Display Data Wait Dialog Box 
Description, 4-73 
Using, 3-8 

Displaying Data, 5-40 

Displaying Multiple Lines of Text, 5-51 

Distal Edit Control Box, Description, 
4-24 

Division, 2-1 1 

Done Push Button, Description, 4-42, 
4- 108 

Driver, how to select, 3-24 

Drivers: Edit Control Box 
Description, 4-85 
Using, 3-22, 5-3 

Edit Control Box 
Address:, 3-22, 4-86 
Array:, 4-21 
Caption:, 3-8, 4-74, 4-75 
Control Id:, 3-30 
Defined Values:, 4-56 
Definition, 2-19 
Distal, 4-24 
Drivers:, 3-22, 4-85, 5-3 
Edit Key:, 4-8 
Edit Password:, 3-9 
End Value:, 4-51, 4-53, 4-54 
Enter Response:, 3- 10 
Expression:, 3-6, 3-8, 3-13, 4-20 
File, 4-9, 4-88 
File Name, 3-12, 4-7 
Increment Size:, 4-52 
Input Waveform Variable ..., 4-22 
Label:, 4-63,4-64 
Learn Strings:, 4-100 
Lower Limit:, 3-18, 4-66 
Mesial, 4-24 
Message, 3-5, 4-66 
Message:, 4-77 
Milliseconds, 4-45 
Nominal Limit:, 4-66 
Nominal Value:, 3-18 
Number of Steps:, 4-51,4-53 

Parameters:, 4-41, 4-43 
PassIFail:, 4-66 
Picture Name, 3-16 
Picture Name:, 4-78 
Port:, 3-22, 4-86, 5-3 
Position:, 4-56 
Primary:, 3-22, 5-3 
Program Variable:, 4-22 
Proximal, 4-24 
Run Key:, 4-8 
Run Password:, 3-9 
Save File as:, 3-9, 3-13 
Save file as:, 4-8 
Secondary:, 5-3 
Send:, 4-108 
Start Value:, 4-51, 4-53, 4-54 
Starting Cycle:, 4-24 
Test Procedure:, 4-40, 4-43 
Text:, 4-47 
Title:, 4-1 14 
TMS Name:, 3-22, 4-87, 5-3 
Upper Limit:, 3-18, 4-66 
Value:, 4-56 
Variable, 3-5, 3-6, 4-20 
X Axis:, 4-1 14 
Y Axis:, 4-1 14 

Edit Key: Edit Control Box, Descrip- 
tion, 4-8 

Edit Menu 
Description, 4-1 1 
Using, 3-36 

Edit Menu ltem 
Description, 4-1 1, 4-102 
Using, 3-36 

Edit Password 
Description, 4-8 
use in Tutorial, 3-9 
Using, 4-7 

Editing a Dialog Box Using the Key- 
board Keys, 3-43 

Editing a Test Procedure, 3-33 

Editing an Instrument Front Panel 
View, 3-44 

Editing Items in a Dialog Box, 3-41 

Editing Overview, 3-33 

EDITTEST.PRG File, Using, 3-34 

Emulate Mode, Description, 4-88 

Emulate Options Dialog Box 
Description, 4-88 
Using, 3-26 

Emulate ... Menu ltem 
Description, 4-88 
Using, 3-26 

Emulation On Check Box, Descrip- 
tion, 4-88 

Emulation On Menu Item, Using, 3-26 

Enable Radio Button, Description, 
4-4 1,4-43 

Enable Selected Steps Menu ltem 
Description, A-1 
Using, 4-13 

Enable Steps Menu Item, Description, 
4-12 

End Value: Edit Control Box, Descrip- 
tion, 4-51, 4-53,4-54 

End-Procedure line, 5-5 

Enter Response: Edit Control Box, 
Using, 3-10 

Equal, 2-12 

.ERR Files, Description, 2-2 

Event, Description, 4-41 

.EXE Files, Description, 2-2 

Exit For Next Dialog Box, Description, 
4-56 

Exit For Ne xt... Menu Item, Descrip- 
tion, 4-56 

Exit Menu Item, Description, 4-10 

Exit Procedure Dialog Box, Descrip- 
tion, 4-61 

Exit Procedure ... Menu Item, Descrip- 
tion, 4-61 

EXP(n), Definition, 2-7 

Exponentiation, 2-1 1 

Expression: Edit Control Box 
Description, 4-20 
Using, 3-6, 3-8, 3-13 

Expressions, Definition, 2-5 

External Procedure ... Menu Item, 
Description, 4-60 

File Edit Control Box, Description, 4-9, 
4-88 
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File extension, automatically added, 
5-6 

File Menu 
Description, 4-6, 4-77 
Using, 3-3,3-9 

File Menu ltem 
Description, 4-6, 4-47, 4-77 
Using, 3-3, 3-9 

File Name Extensions, Description, 2-2 

File Name: Edit Control Box 
Description, 4-7 
Using, 3-12 

File Names, 2-2 

File to Instrument ... Menu Item, 
Description, 4-3 1 

File to Variable Dialog Box, Using, 
3-11 

File to Variable ... Menu ltem 
Description, 4-26 
Using, 3-1 1 

FIX(n), Definition, 2-8 

Float Data, Definition, 2-13 

fmtexp$, Definition, 2-9 

fmtfix$, Definition, 2-9 

fmtflt$, Definition, 2-10 

frntint$, Definition, 2-10 

fmtstrS, Definition, 2-1 1 

Focus, Definition, 2-4 

Focused, Definition, 2-4 

For Next 1-2-5 Dialog Box, Defined, 
4-53 

For Next Linear Dialog Box, Descrip- 
tion, 4-50 

For Next Log Dialog Box, Description, 
4-52 

For Next Menu List, Description, 4-50 

For Next User Defined Dialog Box, 
Description, 4-55 

FOR-NEXT Log Construct, Defined, 
4-52 

FORNEXT 1-2-5 Construct, Defined, 
4-53 

FORNEXT Linear Construct, Defined, 
4-50 

Frequency Text Box, Using, 3-28 

Full Format, Description, 4-9 

Full Interaction Menu Item, Descrip- 
tion, 4-102 

Full Listing, Example, A-5 

Full Radio Button, Description, 4-9 

Full View Menu ltem 
Description, 4-1 10 
Using, 5-45 

Functions 
Description, 2-7 
RND(n), 3-19 

Global Variables 
Add, 2-20 
Change, 2-21 
Clear All, 2-20 
Definition, 2-20-2-22 
Delete, 2-20 

Glossaly of Terms, 2-4 

Gosub Dialog Box, Description, 4-62 

Gosub ... Menu Item, Description, 4-62 

Goto ... Menu Item, Description, 4-63 

GPlB Interface Card File Name Con- 
flicts, 2-2 

Greater than, 2-12 

Greater than or equal, 2-12 

Grid Menu ltem 
Description, 4-1 11 
Using, 5-45 

Help Menu, Description, 4-96 

Help Menu Item, Description, 4-106 

HEX$(n), Definition, 2-8 

Histogram Radio Button, Description, 
4-23 

.HLP Files, Description, 2-2 

How IPG Communicates with the 
Operator, 3-3 

How to Acquire Waveforms, 3-27 

How to Display a Picture, 3-14 

How to Make Measurements, 3-27 

How to Select and Configure an 
Instrument, 3-22 

How to select Driver Name, 3-24 

How to set up Controls on an Instru- 
ment, 3-22 

How to use an lnstrument Front Panel 
Driver, 3-22 

IBCONEEXE File, Using, 2-2 

If Then Else End-If Dialog Box, De- 
scription, 4-48 

IF-THEN-ELSE Construct, Defined, 
4-48 

In Range, 3-21 

lnclude File Dialog Box, Description, 
4-4 7 

lnclude Menu Item, Description, 4-46 

lnclude Menu List, Description, 4-46 

lnclude Text Dialog Box, Description, 
4-4 7 

Increment Size: Edit Control Box, 
Description, 4-52 

lncrementing a Variable within a Loop, 
5-32 

lnformation Exchange with an Abort 
Handler, 5-52 

Information Exchange with an Event 
Handler, 5-52 

Initializing Test Variables, 5-19 

Input Waveform Variable ... Edit 
Control Box, Description, 4-22 

Inserting Text for Translation to C 
Language, 4-47 

INSTALL.EXE, 2-1 

Installation, running INSTALL, 2-1 

Installing IPG, 2-1 

lnstrument 
How to select and configure, 3-22 
How to set up Controls, 3-22 

lnstrument Front Panel Display, De- 
scription, 4-97 

lnstrument Front Panel Driver, How to 
use, 3-22 

lnstrument Front Panel Help Menu, 
Description, 4-106 

lnstrument Front Panel Menu, Descrip- 
tion, 4-96 

Index 



lnstrument Name Menu Item, 4-17 

lnstrument Select Dialog Box, Descrip- 
tion, 4-85 

lnstrument to File ... Menu Item, 
Description, 4-30 

lnstrument to Variable ... Menu Item, 
Description, 4-29 

lnstruments Front Panel Dialog Box 
Description, 4-87 
Using, 3-23 

lnstruments Menu 
Description, 4-85 
selecting instruments, 5-1 1 
Using, 3-22 

lnstruments Menu ltem 
Description, 4-85 
Using, 3-22 

lnstruments Menu List, Description, 
4-85 

INT(n), Definition, 2-8 

Integer Data, Definition, 2-13 

lnteraction Menu, Description, 4-102 

lnteraction Menu Item, Description, 
4-102 

IPG Dialog Box, Definition, 2-18-2-22 

IPG Display Familiarization, 2-17 

IPG Global Variables, Definition, 
2-20-2-22 

IPG Main Menu, 2-17 

.ISB Files, Description, 2-3 

.ISD Files, Description, 2-3 

Item, Definition, 2-4 

Items Displayed in Gray, Description, 
4-11 

Label Dialog Box 
Description, 4-3 
Using, 3-44 

Label Menu ltem 
Add selection, 4-14 
Description, 4-3, 4-13 
Remove selection, 4-14 
Using, 3-44 

Label Options Dialog Box, Description, 
4-1 14 

Label: Edit Control Box, Description, 
4-63, 4-64 

Labelling a Step, 3-44 

Labels Menu Item, Description, 4-114 

LCASE$(s$), Definition, 2-8 

Leading Edge, Description, 4-24 

Learn Block, 4-99 

Learn Settings ... Menu Item, Descrip- 
tion, 4-99 

Learn Settings: Push Button, Descrip- 
tion, 4-100 

Learn Strings: Edit Control Box, 
Description, 4- 100 

LEFT$(s$,n), Definition, 2-8 

LEN(s$), Definition, 2-8 

Less than, 2-12 

Less than or equal, 2-12 

Line Styles List Box, Description, 
4-1 13 

Linear ... Menu Item, Description, 4-50 

List Box 
Colors, 4-1 13 
Control Id:, 4-104, 4-105 
Control ID-Variable, 4-105 
Control List, 4-99, 4-101 
Definition, 2-19 
Line Styles, 4-1 13 
Parameters:, 4-42 
Pulse ParameterIProgram Variable:, 

4-22 
Selected Control, 3-30, 4-99, 4-101 
Selections, 4-1 13 

Load Dialog Box, Description, 4-78 

Load File Dialog Box, Using, 3-16 

Load Menu Item, Using, 3-16 

Load PushButton 
Description, 4-78 
Using, 3-16 

Load ... Menu Item, Description, 4-78 

Loading software, 2-1 

Log ... Menu Item, Description, 4-52 

LOG(n), Definition, 2-8 

Logical Operators, Defined, 2-12 

Lower Limit: Edit Control Box 
Description, 4-66 
Using, 3-18 

LPTl., Using, 5-51 

LTRIM$(s$), Definition, 2-8 

Main Menu 
Description, 4-5 
Using, 3-3 

Main Menu Bar, Description, 4-5 

Masking Timeout Errors, 5-53 

.ME Files, Description, 2-3 

Measurement Block, 4-100 

Measurement Edit Control Box, Using, 
3-36 

Measurement within a Loop, 5-29 

Menu Bar, Definition, 2-18 

Menu ltem 
1-2-5 ..., 4-53 
AcquireIMeasure, 3-28 
Actions, 3-6, 4-19 
Adjustment ..., 3- 17, 4-65 
Amplitude Cursors, 4-1 12, 5-48 
Calculate ..., 3-6, 3-18, 4-19 
Call Procedure, 4-57 
Clear, 3-39, 4-12, A-1 
Close, 4-102 
Colors and Styles, 4-1 12, 5-49 
Comment, 3-45, 4-4 
Continue ..., 4-74 
Copy, 3-36, 3-37, 4-12, A-1 
Current Control, 3-29 
Current Control ..., 4-104 
Current View ..., 3-31, 4-104 
Cut, 3-37, 4-12, A-1 
Definition, 2-18 
Delay ..., 3-19, 4-44 
Dimension ..., 4-20 
Disable Selected Steps, A-1 
Disable Steps, 4-12 
Display Cursor, 4-1 11, 5-47 
Display Data, 3-7, 3-12, 4-73 
Edit, 3-36, 4-1 1, 4-102 
Emulate ..., 3-26, 4-88 
Emulation On, 3-26 
Enable Selected Steps, A-I 
Enable Steps, 4-12 
Exit, 4-10 
Exit For Next ..., 4-56 
Exit Procedure ..., 4-61 
External Procedure ..., 4-60 
File, 3-3, 3-9, 4-6, 4-77 
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File to Instrument ..., 4-31 
File to Variable ..., 3-1 1, 4-26 
For Next ..., 4-50 
Full Interaction, 4-102 
Full View, 4-1 10, 5-45 
Gosub ..., 4-62 
Goto ..., 4-63 
Grid, 4-1 11, 5-45 
Help, 4-106 
If Then Else ..., 4-48 
Include, 4-46 
Instrument to File ..., 4-30 
Instrument to Variable ..., 4-29 
Instruments, 3-22, 4-85 
Interaction, 4- 102 
Label, 3-44, 4-3, 4-13 
Labels, 4-1 14 
Learn Settings ..., 4-99 
Linear.. ., 4-50 
Load, 3-16 
Load ..., 4-78 
LO g..., 4-52 
Misc, 4-107 
Monitor Only, 4-103 
New, 3-3, 4-6 
No Interaction, 4-103 
OK, 3-21 
Ok, 4-109 
On Abo rt..., 4-42 
On Event ..., 4-40 
Open ..., 4-7 
Operator, 3-4, 3-7, 3-12, 4-65 
Options, 4-95, 4-1 10, 5-45 
Paste, 3-36, 4-12, A-1 
Picture, 3-15 
Picture ..., 4-77 
Print, 4-9 
Prompt, 3-4 
Prompt ..., 4-76 
Pulse Parameters ..., 4-21 
Refresh Rate ..., 4-107 
Remark ..., 4-45 
Remarks Only, 4-95 
Remove, 4-75 
Return ..., 4-63 
Run, 3-10 
Run!, 4-90 
Save, 4-8 
Save All Measurements, 4-100 
Save All Settings, 3-25, 4-98 
Save and Edit ..., 3-17 
Save and Exit ..., 4-79 
Save as ..., 3-9, 3-13,4-8 
Save Selected Measurements ..., 

3-30, 4-100 
Save Selected Settings ..., 4-98 
Scroll Bars, 4-1 10, 5-45 

SearchIReplace, 4- 14 
Select, 3-27 
Select ..., 3-22, 4-85 
Setting Only, 4-102 
Start IDG ..., 4-96 
Start RTG ..., 4-96 
Step, 3-24, 4-98 
Stop Test ..., 4-61 
TalkIListen ..., 4-108 
TekTMS Procedure ..., 4-57 
Text ..., 3-5, 4-46, 4-47, 4-76 
Time Cursors, 4-1 12, 5-49 
Trace Bus, 3-25 
Transfer Data, 3-1 1, 4-25 
Translate, 4-95 
Undo, 3-37, 4-1 1, A-1 
Update!, 4-103 
User Defined ..., 4-55 
Variable to File ..., 4-25 
Variable to Instrument ..., 4-28 
Variables, 3-29, 4-103 
View, 3-23, 4-109 
View ..., 4-87, 4-96 
Views, 4-106 
Wait ..., 3-8, 3-12, 4-73 
Waveform Cursor, 4-1 11, 5-47 
While Do ..., 4-49 
Zoom, 4-109, 5-44 

Menu ltem Arrow, Definition, 2-18 

Menu ltem Ellipsis, Definition, 2-18 

Menu Map, 4-2 

Mesial Edit Control Box, Description, 
4-24 

Message Box 
Actual:, 4-67 
Receive:, 4- 108 

Message: Edit Control Box 
Description, 4-66, 4-77 
Using, 3-5 

MID$(s$,n,m), Definition, 2-8 

Milliseconds Edit Control Box, De- 
scription, 4-45 

Min-Max Radio Button, Description, 
4-23 

Misc Menu Item, Description, 4-107 

Miscellaneous Menu, Description, 
4-107 

MOD(n,m), Definition, 2-8 

Monitor Only Menu Item, Description, 
4-103 

Multiple Statement Editing, 3-33 

Multiple Step Highlighting, 3-34 

Multiplication, 2-1 1 

Naming a Procedure, 5-6 

Negative Radio Button, Description, 
4-24 

New Menu ltem 
Description, 4-6 
Using, 3-3 

No Interaction Menu Item, Descrip- 
tion, 4-103 

No PushButton, Description, 4-6,4-10 

Nominal Limit: Edit Control Box, 
Description, 4-66 

Nominal Value: Edit Control Box, 
Using, 3-18 

NOT, 2-12 

Not equal, 2-12 

Number Conversion, 4-27 

Number of Steps: Edit Control Box, 
Description, 4-51, 4-53 

Numeric Constants, Definition, 2-5 

Numeric Term, Defined, 2-14 

OCT$(n), Definition, 2-8 

OK Menu Item, Using, 3-21 

Ok Menu Item, Description, 4-109 

OK PushButton 
Description, 4-9 
Using, 3-7, 3-8 

On Abort, 5-52 

On Abort Dialog Box, Description, 
4-42 

On Abort ... Menu Item, Description. 
4-42 

On Event, 5-52 

On Event Dialog Box, Description, 
4-40 
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On Event ... Menu Item, Description, Picture ... Menu Item, Description, 
4-40 4-77 

Open Push Button, Description, 4-7 Port: Edit Control Box 

Open ... Menu Item, Description, 4-7 

Operator Menu 
Description, 4-65 
Using, 3-4, 3-7 

Operator Menu ltem 
Description, 4-65 
Using, 3-4, 3-7, 3-12 

Operators. See Arithmetic Operators; 
Logical Operators; Relational 
Operators; String Operators 

Options Menu, Description, 4-95, 
4-110 

Options Menu ltem 
Description, 4-95,4-110 
Using, 5-45 

OR, 2-12 

Outline Format, Description, 4-9 

Outline Listing;Example, Example, A-4 

Outline Radio Button, Description, 4-9 

Parameters: Edit Control Box, De- 
scription, 4-41,4-43 

Parameters: List Box, Description, 
4-42 

PassIFail: Edit Control Box, Descrip- 
tion, 4-66 

Password, 4-8 

Paste Menu Item 
Description, 4-12, A-1 
Using, 3-36 

Percent to Baserrop Radio Button, 
Description, 4-24 

Picture Menu Item, Using, 3-15 

Picture Name:, 5-7 

Picture Name: Edit Control Box 
Description, 4-78 
Using, 3-16 

Picture Prompt, creating, 5-7 

Picture Prompt Dialog Box 
Description, 4-77 
Using, 3-15 

Picture Prompt File Menu, Using, 3-15 

Description, 4-86 
Using, 3-22, 5-3 

Position: Edit Control Box, Descrip- 
tion, 4-56 

Positive Radio Button, Description, 
4-24 

.PRG Files, Description, 2-3 

Primary address, setting, 5-4 

Primary: Edit Control Box, Using, 
3-22, 5-3 

Print Dialog Box, Description, 4-9 

Print Menu Item, Description, 4-9 

PRINT SCREEN Key, Using, 5-51 

Print to File Check Box, Description, 
4-9 

Printing a Variable, 4-25 

Printing a Waveform, 5-51 

Printing an IPG Display, 5-51 

Printing Input from an Instrument, 4-30 

PRN., Using, 5-51 

Procedure, Naming, 5-6 

Procedure line, 5-5 

Program Variable ... Edit Control Box, 
Description, 4-22 

Prompt 
Plcture prompt creation, 5-7 
Text prompt creation, 5-9 

Prompt Menu, Using, 3-4 

Prompt Menu Item, Using, 3-4 

Prompt Menu List, Description, 4-76 

Prompt ... Menu Item, Description, 
4-76 

Prompting the Operator, 5-34 

Proximal Edit Control Box, Descrip- 
tion, 4-24 

Pulse ParameterIProgram Variable: 
List Box, Description, 4-22 

Pulse Parameters Dialog Box, Descrip- 
tion, 4-21 

Pulse Parameters ... Menu Item, 
Description, 4-21 

Push Button 
About, 4-4 1, 4-44 
Add, 3-23, 4-22, 4-87 

Add All, 4-99,4-101 
Cancel, 4-3, 4-6 
Change, 4-22,4-56, 4-87 
Definition, 2-19 
Delete, 4-22, 4-87 
Done, 4-42, 4-108 
Learn Settings:, 4-100 
Load, 3-16, 4-78 
NO, 4-6, 4-10 
OK, 3-7, 3-8, 4-9 
Open, 4-7 
Receive, 4-108 
Save, 3-9, 4-8 
Send, 4-108 
Set Crossing, 4-23 
Yes, 4-6, 4-10 

Radio Button 
Absolute Amplitude, 4-24 
Definition, 2-19 
Disable, 4-41, 4-43 
Enable, 4-4 1, 4-43 
Full, 4-9 
Histogram, 4-23 
Min-Max, 4-23 
Negative, 4-24 
Outline, 4-9 
Percent to BaselTop, 4-24 
Positive, 4-24 

Read Emulation Dialog Box, Descrip- 
tion, 4-88 

Read from file Check Box, Descrip- 
tion, 4-88 

READ. 100, 2-1 

READ.lOO File, Description, 2-3 

Receive Push Button, Description, 
4- 108 

Receive: Message Box, Description, 
4- 108 

Refresh On: Check Box, Description, 
4-107 

Refresh Rate Dialog Box, Description, 
4-107 

Refresh Rate ... Menu Item, Descrip- 
tion, 4-107 

Refresh Rate: Check Box, Descrip- 
tion, 4-107 
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Relational Operators, Defined, 2-12 

Remark, adding, 5-5 

Remark Dialog Box, Description, 4-45 

Remark ... Menu Item, Description, 
4-45 

Remarks Only Menu Item, Descrip- 
tion, 4-95 

Remove Display Dialog Box, Descrip- 
tion, 4-75 

Remove Menu Item, Description, 4-75 

Return Dialog Box, Description, 4-63 

Return ... Menu Item, Description, 4-63 

Returning Status Data, 5-54 

Returning Status Information from a 
.ISD File, 5-54 

RIGHT$(s$,n), Definition, 2-8 

RND(n), Using, 3-19 

RND(n), Definition, 2-8 

RTRIM$(s$), Definition, 2-8 

Run Key: Edit Control Box, Descrip- 
tion, 4-8 

Run Menu, Using, 3-10 

Run Menu Item, Using, 3-10 

Run Password 
Description, 4-8 
Using, 4-7 

Run Password:, 3-9 

Run! Menu, Description, 4-90 

Run! Menu Item, Description, 4-90 

Same File as, 5-6 

Sample Display, Description, 4-1 13 

Save All Measurements Menu Item, 
Description, 4-1 00 

Save All Settings Menu ltem 
Description, 4-98 
Using, 3-25 

Save and Edit ... Menu Item, Using, 
3-17 

Save and Exit Dialog Box, Description, 
4- 79 

Save and Exit ... Menu Item, Descrip- 
tion, 4-79 

Save as. .. Menu ltem 
Description, 4-8 
Using, 3-9, 3-13 

Save File As Dialog Box, Using, 3-9 

Save File as: Edit Control Box, Using, 
3-9, 3- 13 

Save file as: Edit Control Box, De- 
scription, 4-8 

Save Learn Settings Dialog Box, 
Description, 4-99 

Save Menu Item, Description, 4-8 

Save Push Button, Description, 4-8 

Save PushButton, Using, 3-9 

Save Selected Measurements ... 
Menu ltem 

Description, 4-100 
Using, 3-30 

Save Selected Settings ... Menu 
Item, Description, 4-98 

SCPI, Definition, 2-4 

Scroll Bars Menu ltem 
Description, 4-1 10 
Using, 5-45 

SearchIReplace Menu ltem 
Description, 4-14 
lnstrument Name selection, 4-17 
Text selection, 4-14 

Secondary: Edit Control Box, Using, 
5-3 

Select, Driver name, 3-24 

Select Dialog Box, Using, 3-22 

Select ... Menu ltem 
Description, 4-85 
Using, 3-22, 3-27 

Selected Control List Box 
Description, 4-99, 4-101 
Using, 3-30 

Selected lnstrument Drivers, Defini- 
tion, 2-4 

Selected Measurements Dialog Box, 
Description, 4-100 

Selected Settings Dialog Box, Descrip- 
tion, 4-98 

Selections List Box, Description, 
4-1 13 

Send Push Button, Description, 4-108 

Send: Edit Control Box, Description, 
4- 108 

Sending Output to a Printer, 5-51 

Set Crossing Push Button, Descrip- 
tion, 4-23 

Setting an lnstrument within a Loop, 
5-25 

Setting Instruments, 5-1 1 

Setting Only Menu Item, Description, 
4-102 

Setting the Instruments, 5-35 

SGN(n), Definition, 2-8 

SHIFTPRINT SCREEN Keys, Using, 
5-5 1 

SIN(n), Definition, 2-8 

Software Performance Report, A-7 

Software Problems, A-7 

SPACE$(n), Definition, 2-8 

SQR(n), Definition, 2-8 

SRQ Check Box, Description, 4-41 

Start IDG ... Menu Item, Description, 
4-96 

Start RTG ... Menu Item, Description, 
4-96 

Start Value: Edit Control Box, De- 
scription, 4-51, 4-53, 4-54 

Starting Cycle: Edit Control Box, 
Description, 4-24 

Status Data, 5-54 

Step Menu 
Description, 4-98 
Using, 3-24 

Step Menu ltem 
Description, 4-98 
Using, 3-24 

Stop Test Dialog Box, Description, 
4-61 

Stop Test ... Menu Item, Description, 
4-61 

STR$(n), Definition, 2-8 

String Constants, Definition, 2-6 

String Conversion, 4-27 

String Data, Definition, 2-13 
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String Operators, Defined, 2-12 Using, 3-5 

STRING$(n,m), Definition, 2-8 

Subtraction, 2-1 1 

System Requirements, 1-3 

Taking Measurements, 5-16 

TalkIListen Dialog Box, Description, 
4- 108 

TalkIListen ... Menu Item, Description, 
4- 108 

TAN(n), Definition, 2-8 

TDM5120.HLP File, Using, 5-2 

TDM5120.ISD File, Using, 5-2 

TEKFG.HLP File, Using, 5-2 

TEKFG.ISD, GPlB settings, 5-4 

TEKFG.ISD File, Using, 5-2 

TEKPIC.BMP 5-7 

TEKPIC.BMP File, Using, 3-16, 5-2 

TekTMS Procedure ... Menu Item, 
Description, 4-57 

TEMP Environmental Variable, 2-3 

Temporary Files, 2-3 

Test Procedure, Definition, 2-4 

Test Procedure Number 1, 3-3 

Test Procedure Number 2, 3-1 1 

Test Procedure Number 3, 3-14 
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